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Hardware Warranty

Tektronix warrants that the products that it manufactures and sells will be free from defects in materials and
workmanship for a period of one (1) year from the date of shipment. If a product proves defective during this
warranty period, Tektronix, at its option, either will repair the defective product without charge for parts and labor,
or will provide a replacement in exchange for the defective product.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration
of the warranty period and make suitable arrangements for the performance of service. Customer shall be
responsible for packaging and shipping the defective product to the service center designated by Tektronix, with
shipping charges prepaid. Tektronix shall pay for the return of the product to Customer if the shipment is to a
location within the country in which the Tektronix service center is located. Customer shall be responsible for
paying all shipping charges, duties, taxes, and any other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate
maintenance and care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage
resulting from attempts by personnel other than Tektronix representatives to install, repair or service the product;
b) to repair damage resulting from improper use or connection to incompatible equipment; c) to repair any
damage or malfunction caused by the use of non-Tektronix supplies; or d) to service a product that has been
modified or integrated with other products when the effect of such modification or integration increases the time
or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX IN LIEU OF ANY OTHER WARRANTIES, EXPRESS
OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX’
RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE AND
EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY.
TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR
THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.



Software Warranty

Tektronix warrants that the media on which this software product is furnished and the encoding of the programs on
the media will be free from defects in materials and workmanship for a period of three (3) months from the date of
shipment. If a medium or encoding proves defective during the warranty period, Tektronix will provide a
replacement in exchange for the defective medium. Except as to the media on which this software product is
furnished, this software product is provided “as is” without warranty of any kind, either express or implied.
Tektronix does not warrant that the functions contained in this software product will meet Customer’s
requirements or that the operation of the programs will be uninterrupted or error-free.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration
of the warranty period. If Tektronix is unable to provide a replacement that is free from defects in materials and
workmanship within a reasonable time thereafter, Customer may terminate the license for this software product
and return this software product and any associated materials for credit or refund.

THIS WARRANTY IS GIVEN BY TEKTRONIX IN LIEU OF ANY OTHER WARRANTIES, EXPRESS
OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX’
RESPONSIBILITY TO REPLACE DEFECTIVE MEDIA OR REFUND CUSTOMER’S PAYMENT IS
THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS
WARRANTY. TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT,
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER
TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH
DAMAGES.
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General Safety Summary

Review the following safety precautions to avoid injury and prevent damage to
this product or any products connected to it.

Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of the system. Read
the General Safety Summary in other system manuals for warnings and cautions
related to operating the system.

Injury Precautions  Use Proper Power Cord. To avoid fire hazard, use only the power cord specified
for this product.

Avoid Electric Overload. To avoid electric shock or fire hazard, do not apply a
voltage to a terminal that is outside the range specified for that terminal.

Avoid Overvoltage. To avoid electric shock or fire hazard, do not apply potential
to any terminal, including the common terminal, that varies from ground by
more than the maximum rating for that terminal.

Avoid Electric Shock. To avoid injury or loss of life, do not connect or disconnect
probes or test leads while they are connected to a voltage source.

Ground the Product. This product is grounded through the grounding conductor
of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Do Not Operate Without Covers. To avoid electric shock or fire hazard, do not
operate this product with covers or panels removed.

Use Proper Fuse. To avoid fire hazard, use only the fuse type and rating specified
for this product.

Do Not Operate in Wet/Damp Conditions. To avoid electric shock, do not operate
this product in wet or damp conditions.

Do Not Operate in an Explosive Atmosphere. To avoid injury or fire hazard, do not
operate this product in an explosive atmosphere.

Product Damage  Use Proper Power Source. Do not operate this product from a power source that
Precautions  applies more than the voltage specified.

Provide Proper Ventilation. To prevent product overheating, provide proper
ventilation.

MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer v



General Safety Summary

vi

Symbols and Terms

Do Not Operate With Suspected Failures. If you suspect there is damage to this
product, have it inspected by qualified service personnel.

Terms in this Manual. These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result
in injury or loss of life.

/N
/N

CAUTION. Caution statements identify conditions or practices that could result in
damage to this product or other property.

Certifications and
Compliances

Terms on the Product. These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the
marking.

WARNING indicates an injury hazard not immediately accessible as you read the
marking.

CAUTION indicates a hazard to property including the product.

Symbols on the Product. The following symbols may appear on the product:

A\ S VAN m]

DANGER Protective Ground ATTENTION Double
High Voltage (Earth) Terminal Refer to Manual Insulated

Refer to the specifications section for a listing of certifications and compliances
that apply to this product.

MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer



Preface

This manual documents the MPEG-2 DVB/ATSC/ISDB-S/ARIB System
Analyzer, Option CA (conditional access), and DVB Channel Coding and
Decoding software applications.

If you purchased an MTS300 test system and are looking for information about
hardware or software installation, first-time operation, or specifications, refer to
the MTS300 MPEG Test System Hardware and Software Installation Technical
Reference, Tektronix part number 071-0261-XX.

For the latest information about MTS300 software features and known problems,
refer to the MPEG Test System Software Version 6.0 Read This First document,
Tektronix part number 071-0666-XX, that accompanied your test system,
software product, or upgrade.

Manual Structure

This manual is divided into the following sections:

Getting Started. The Getting Started section contains all the information you need
to get the MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer up and running.

Operating Basics. The Operating Basics section contains a tutorial that new users
should use to familiarize themselves with the system analyzer. Experienced users
can also consult the tutorial for detailed instructions for unfamiliar tasks.

Reference. The Reference section contains in-depth descriptions of the analyzer
capabilities, the software interface, and configuration options. This section also
contains information on how to use the conditional access and DVB channel
coding and decoding software.

Appendix A: What to Do if an Application Locks Up. Appendix A describes how to
recover if the test system locks up.

Appendix B: Software Repair. Appendix B contains information you might need
to reinstall application files.

Appendix C: Analyzer Tests. Appendix C contains bitstream tests for some
versions of MTS300 software.

Glossary. Consult the glossary when you encounter an unfamiliar term.

Index. The Index is an alphabetical listing of the topics covered in this manual.

MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer vii
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Symbols and Terms

Related Documents

viii

Wherever possible, this manual uses symbols and terminology consistent with
Microsoft® Windows® and MPEG-2 standards. Refer to the Windows documen-
tation (included with the test system) for definitions and explanations of
Windows terminology. Refer to the Glossary at the rear of this manual for
definitions unique to MPEG or the MTS300 test system.

@ For information about the MPEG-2 standard, click the MPEG-2
help icon in the Tektronix MPEG Test System program group
MPEG-ZHelp  yindow.

For additional information about using MTS300 software to monitor, analyze,
and generate MPEG-2, DVB, and ATSC data streams, refer to the following
manuals:

B The MTS300 MPEG Test System Real-Time Analysis User Manual,
Tektronix part number 071-0658-XX, contains information about using the
real-time MPEG-2 System Analyzer application.

B The MTS300 MPEG Test System Stream Creation Applications User
Manual, Tektronix part number 071-0778-XX, contains information about
using the MPEG-2 DVB/ATSC Transport Stream Multiplexer, DVB Table
Editor, ATSC Table Editor, DVB Channel Coding and Decoding, Jitter
Adder, Error Injector, and OpenMux (real-time multiplexer) applications.

B The MTS300 MPEG Test System Program Stream Analyzer User Manual,
Tektronix part number 071-0662-XX, contains information about using the
deferred-time Program Stream Analyzer application.

B The MTS300 MPEG Test System Dolby Digital Audio Stream Analyzer User
Manual, Tektronix part number 071-0661-XX, contains information about
using the deferred-time AC-3 Audio Stream Analyzer application.

B The MTS300 MPEG Test System Audio Stream Analyzer User Manual,
Tektronix part number 071-0663-XX, contains information about using the
deferred-time MPEG Audio Stream Analyzer application.

B The MTS300 MPEG Test System Video Stream Analyzer User Manual,
Tektronix part number 071-0664-XX, contains information about using the
deferred-time MPEG Video Stream Analyzer application.

MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer
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Related Applications

The applications that appear in version 6.0 Tektronix MPEG Test System
program group and Start menu depend on the system configuration and its
installed options. Table i summarizes all test system applications available in
release 6.0.

MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer ix
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Table i: Tektronix MPEG Test System version 6.0 applications

Icon Application title Function User document
-*® Master Client Continuously monitor an input bitstream for MTS300 MPEG Test System
71 % compliance with the MPEG-2, DVB-SI, ATSC Real-Time Analysis User Manual
Master Client PSIP, and ISDB/ARIB digital television 071-0658-XX

standards. Use this client to start or assign to an
input/output the following real-time applications
and servers:

AnalysisServers, MPEG and TMCC used to
perform real-time analysis on a transport stream
input

Expert Client, used display the results of
real-time transport stream analysis performed by
an MPEG analysis server.

Configuration Client, used to configure MPEG
analysis servers for specific errors.

TMCC Expert Client, used to display the results
of reeal-time transport stream analysis per-
formed by a TMCC analysis server.

TMCC Configuration Client, used to configure
TMCC analysis servers for specifc errors.

Stream Player, used to generate transport
streams from a local file.

Stream Recorder, used to capture transport
stream input.

OpenMux, used to configure and generate
transport streams from local transport stream
and elementary stream files.

- Hardware Diagnostic Perform onboard self-tests for the MPEG Test | MTS300 MPEG Test System
2P System. Hardware and Software Installation
Hadwars Technical Reference 071-0667-XX

laqnostic
(Information repeated in both
manuals)

Private Syntax Interpreter | Create table definitions used by the Real-Time
Analyzer to interpret private syntax sections.

Private Syntas
| terpreter

X MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer
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Table i: Tektronix MPEG Test System version 6.0 applications (Cont.)

Icon

Application title

Function

User document

Defemed-Time
Bnahyzer

MPEG-2 DVB/ATSC
System Analyzer

Analyze transport streams and packetized
elementary streams saved to the system disks.

0B Charnel

DVB Channel Coding
and Decoding

Code and decode transport stream files to DVB
specifications.

MTS300 MPEG Test System
MPEG-2 DVB/ATSC System
Analyzer User Manual 071-0659-XX

MTS300 MPEG Test System
Stream Creation Applications User
Manual 071-0778-XX

(Information repeated in both
manuals)

'

Program Stream Analyzer

Analyze MPEG program stream files.

MTS300 MPEG Test System
Program Stream Analyzer User
Manual 071-0662-XX

Program
Shrea..
i MPEG Video Stream Analyze MPEG-1 and MPEG-2 video elementary | MTS300 MPEG Test System Video
Analyzer streams files or streams extracted from the Stream Analyzer User Manual
Video Sheam MPEG-2 DVB/ATSC/ISDB-S/ARIB System 071-0664-XX

nalyzer Analyzer or Program Stream Analyzer.

o MPEG Audio Stream Analyze MPEG-1 and MPEG-2 audio elementary | MTS300 MPEG Test System Audio
Analyzer streams files or streams extracted from the Stream Analyzer User Manual

Audio Stream
Bnalyzer

MPEG-2 DVB/ATSC/ISDB-S/ARIB System
Analyzer or Program Stream Analyzer.

071-0663-XX

ik

Dolby Digital Audio Stream
Analyzer

Analyze Dolby Digital (AC-3) audio elementary
stream files or streams extracted from the
MPEG-2 DVB/ATSC/ISDB-S/ARIB System

MTS300 MPEG Test System Dolby
Digital Audio Stream Analyzer User
Manual 071-0661-XX

Dalky Digital
Analyzer Analyzer.
MPEG-2 Transport Stream | Create transport stream files from PSI/SI/PSIP
F Multiplexer table files, elementary stream files, and data
tultiplexer files.
o TMCC Combiner The TMCC Combiner (MTS300 Option TM or
MTS3FTM) is a wizard that guides you through
THCC creating a single- and multiple-stream transport
Caormnbirer

stream files for ISDB-S environments.

DWE T able
Editor

DVB Table Editor

Create and edit PSI and DVB Sl table files for
use with the transport stream multiplexer.

&TSC Table Editar

ATSC Table Editor

Create and edit PSI ad ATSC PSIP table files for
use with the transport stream multiplexer.

ARIB Table
Editor

ARIB Table Editor

Create and edit ARIB table files for use with the
transport stream multiplexer.

MTS300 MPEG Test System
Stream Creation Applications User
Manual 071-0778-XX

MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer
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Table i: Tektronix MPEG Test System version 6.0 applications (Cont.)

Icon Application title Function User document
I’ Jitter Adder Add jitter to PCR data in MPEG-2 transport MTS300 MPEG Test System
stream files. Stream Creation Applications User
Jitter Adder Manual 071-0778-XX
Error Injector Insert or correct errors in transport stream
packets.
E rmor [ njector
&}9 Tektronix Software Enter or reenter the general password to enable | Read This First, MTS300 MPEG
Protection licensed applications. Test System Software V6.0
Liceres 071-0666-XX
tanager
@ MPEG2_Part1 The international MPEG-2 system standard in none
(ISO/IEC 13818-1) Windows Help format.
MPFEG-Z Help
Uninstall MTS Remove MPEG Test System software from the | MTS300 MPEG Test System User
system disk. Manuals
Uninstall MT S

Software Version

Table ii lists the MTS300 MPEG Test System application version numbers
supported by this manual. To verify an application version number, select Help
in the application menu bar; then select About from the Help menu.

Table ii: MTS300 MPEG Test System (V6.0) supported applications

MPEG-2 DVB/ATSC System Analyzer V5.02 and above
DVB Channel Coding and Decoding V1.0 and above

Xii MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer
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Contacting Tektronix

Phone 1-800-833-9200*

Address Tektronix, Inc.
Department or name (if known)
14200 SW Karl Braun Drive

P.O. Box 500

Beaverton, OR 97077

USA
Web site www.tektronix.com
Sales support 1-800-833-9200, select option 1*
Service support 1-800-833-9200, select option 2*

Technical support Email: techsupport@tektronix.com

1-800-833-9200, select option 3*
1-503-627-2400

6:00 a.m. - 5:00 p.m. Pacific time

*  This phone number is toll free in North America. After office hours, please leave a
voice mail message.
Outside North America, contact a Tektronix sales office or distributor; see the
Tektronix web site for a list of offices.

MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer xiii
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Getting Started

Requirements

Software Key

With the MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer you can test
transport streams for compliance with MPEG-2, DVB, and ATSC television
standards.

The information in this section explains how to install software and run the
analyzer for the first time.

You can install the MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer on
either a Tektronix MTS300 MPEG Test System or a personal computer with the
following minimum requirements:

B 150 MHz Intel Pentium processor

= 32 MB RAM

B 140 Mbytes free disk space (for MTS software) plus adequate space for
transport stream test files

m  CD ROM drive (for software installation)
B Windows NT 4.0 operating system (Service Pack 6)
B 1024 x 768 pixel video monitor with 256 available colors

If you are installing the analyzer software on an Tektronix MTS300 MPEG Test
System, refer to the MTS300 MPEG Test System Hardware and Software
Installation Technical Reference (included with the test system) for complete
installation instructions.

You must install the software key (included with the software) on the computer
parallel port before you can start the system analyzer.

MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer 1-1
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Logging On

Tektronix MTS300 MPEG

1-2

Test System

To use the parallel port with the software key installed, attach any ancillary
cables directly to the software key. The software key will not interfere with
parallel port communications.

NOTE. To run the MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer, the
software key must be installed on the computer parallel port. Do not remove or
misplace the software key.

To run the MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer software on
your personal computer or MTS300 test system, use the appropriate logon
procedure.

To run the MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer on an
Tektronix MTS300 MPEG Test System, use the following procedure to log on.

1. Switch the computer power on to begin Windows NT initialization.
Initialization can take up to two minutes. Under normal circumstances, no
action is required until the Begin Logon window appears.

2. When the Begin Logon window appears, simultaneously press the
CTRL + ALT + Delete keys to open the Logon Information dialog box.

You should not need to log on to Windows NT if you are using the default
auto-logon feature (with Administrator and MPEG2 as the user name and
password). However, if this behavior has been changed, complete the log on
procedure by performing step 3.

3. Enter your user name and password in the User name and Password text
boxes, and press ENTER.
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Personal Computer  You can run the MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer on a
personal computer that has no MTS300 system hardware.

1. Switch the computer power on to begin Windows NT initialization.
Initialization can take up to two minutes. Under normal circumstances, no
action is required until the Begin Logon window appears.

2. When the Begin Logon window appears, simultaneously press the
CTRL + ALT + Delete keys to open the Logon Information dialog box.

3. Enter your user name, password, and domain. Press ENTER. These
parameters must be previously set up by your NT administrator.

Changing Passwords  You can change passwords at this time. Refer to the Windows NT online help for
instructions. If you change passwords, be sure to create a new emergency repair
disk as explained in Appendix B: Software Repair.

Installing Software

NOTE. If you do not have the Java run-time environment installed on your
system, or if the environment is incorrect for this software, run the executable
file located in the jre directory on the Application CD.

Perform the following steps to install the System Analyzer software on your
personal computer.

1. Install the software key as described in Software Key on page 1-1.
2. Log on to Windows NT as Administrator.

3. Right-click the My Computer icon on your desktop, and then select
Explore from the resulting submenu. In the Exploring window, select the
icon that represents the disk drive onto which you will install the software
(usually drive C:).
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4. Check the status bar at the bottom of the Exploring window to verify that the
target disk has at least 140 Mbytes of free space. You cannot install the
software on a disk with less than 140 Mbytes of free space.

[BY Exploring - C-\

File  Edit ¥iew Toolz Help
|.é\|| Falders Contents of 'C:Y
Desgktop A || Mame | 5|ze| Type | Mt:l
£~ My Computer (3 Acrobata File Folder 5—
. [H-E 3% Floppy &) [Bin File: Folder 8/
ﬁm [T carkn File Falder 1/
() [Ee File Folder B
-2 Mtsdocs on whwesleyk! (E:] Y- File. Fralele 1=
L B2 o on wiacques' [F) =] r:‘ b
|42 abject(s] [128MB [Disk fre= space: 409ME] 4
Free space

5. Place the MPEG Test System Version 6.0 Installation Software CD ROM
into the CD ROM drive.

6. Click the Windows NT Start button and select Run... from the submenu.

7. Enter d:\Setup.exe in the resulting Run window as depicted in the following
illustration. In this example, d is the drive letter for the CD ROM drive; use
the drive letter that is correct for your computer.

Run HE

Type the name of a program, Folder, or document, and
‘windows will open it for you,

=

¥ Fumin Separate fdemen Space

Ok I Cancel | Browse. . |

8. Click OK to start the software installation.
9. In a few seconds, the installation screen appears.

10. Read the Copyright and Setup text and click Next to proceed to the Choose
Destination Directory window.

11. The default destination folder is C:\MTS300. Click Next to accept the
default folder.

NOTE. It is strongly recommended that you use the default destination folder.
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12. The Setup Type window opens. Select MTS Software Only, and then click
Next.

Setup Type

Click the type of Setup pou prefer, then click Mest.

b T 5400 S oftware Dy

— Description

< Back I Newt > I Cancel |

13. The Select Program Folder window opens. Click Next to accept the default
folder name (Tektronix MPEG Test System) and continue.

14. Review the Destination Directory, System Product, and Start Menu Folder
selections in the Selection Summary window. If the selections are incorrect,
click Back and change the information as needed. Once the information is
correct, click Next to proceed with the installation.

The setup program begins installing the software and related files. The
activity and progress gauges appear at first to show that the installation is
progressing. Installation proceeds without your input (and sometimes with
no apparent activity) for approximately 3 minutes, depending on your
computer.

# Copying MTS100 Data files...
hinyeditable.exe
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15.

16.

17.

18.

19.

20.

21.

During a normal setup, the computer displays two empty program group
windows after it copies the program files to your disk drive. After the
windows appear, a message reminds you to verify that the software key is
installed.

Verify that the software key is installed on the parallel (printer) port as
described in Software Key on page 1-1; then click OK.

The Setup Complete window opens; click Finish to continue.

A Notepad window opens to display the Readme file. Scan the text for
important information, and then select Exit from the File menu to close the
window.

Another Setup Complete window opens. Accept Yes, I want to restart my
computer now.

Remove the test system software installation disk from the CD ROM drive
and click Finish to complete the setup and reboot the system.

When prompted, log on as any user. The Windows NT initialization process
can take up to two minutes to complete.
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Entering the License Password

Perform the remaining steps to enter the general password that corresponds to the
attached software key. Doing so enables the applications that are included with
your MTS300 MPEG Test System product.

et

Licernse Manager

1. Double-click the License Manager icon to start the application. The
Tektronix Software Protection window appears.

"s Tektronix Software Protection

To Enable Licensed Software Applications,
Fleaze Enter pour General Pazsword.
then Click 0K

Cancel |

2. Consult the password document supplied with your software and identify the
general password.

3. Enter the three 6-character hexadecimal numbers of the password in the
corresponding Tektronix Software Protection window entry fields (lowercase
characters are acceptable).

4. Click OK. A License message window appears.

5. If the password is correct, click OK to acknowledge the message. If you
made an error entering the password, click OK and return to step 3.

Restart the computer (again) to complete the MPEG-2 DVB/ATSC/ISDB-
S/ARIB System Analyzer software installation.
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Running the Software

Locate the Tektronix MPEG Test System icon on the Windows NT desktop. If it
is not already open, double-click the folder icon to open the program group
window.

The Tektronix MPEG Test System program group window appears as shown
below. Double-click on the Deferred-Time Analyzer icon to start the analyzer.

& CAWINNT\Profiles\All Users\DesktopiT ektronix MPEG Test System | _ [O] x| |
File Edit Yiew Help
3 Tekionix MPEG Test 5, v| &1 il dlEl@l «| X|=| [Eol==
P e = =] E=) =]
L] 2= opee? [zl [l 1=
License Deferred-Time  Multiplexer OB Table ATSCTable  ARIE Table
hdanager Anahszar Editor Editor Editor
e J Y|
<3N~ - # B
TMCC TMCC Differed  OVE Channel  Audio Stream Dalby Digital - ErrorInjector Jitter Adder
Combiner  Time Analyzer  Coding and... Analyzar Analyzer
P I
MPEG-2 Help Program Uninstall Upgrade “ideo Stream
Stream... WATE300%5 1 Wizard Analyzer
19 ahject(s) |8.09KB Y

Exiting MTS300
Applications

1-8

To exit an MTS300 application, select Exit from the application File menu or
click the close box in the upper-right corner of the application window. The
current configuration is preserved and used the next time you start the applica-
tion.

Close
zer - [Statistic view] [ [O] =] button

Yiew Analysis [Data Storage  Window  Help -7 x|

Il ==tlan |l

In the default configuration, application information and error messages (up to
2048 KB) are automatically saved in the Windows NT Event Viewer. No
additional information is saved.
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Shutting Down the  To avoid loss of data and possible problems during subsequent Windows NT
Computer initialization, always shut down Windows NT before switching the computer
power off. To shut down Windows NT, select Shut Down from the Start menu.

3‘__‘| Bun...

Tektionix MPEG Test Syst...|

In the Shut Down Windows dialog box, select Shut down the computer? and
then click Yes. After a few seconds, the Shutdown Computer window appears
with the message It is now safe to turn off your computer. You can now power
off the computer.

CAUTION. Do not switch computer power off before the message It is now safe to
turn off your computer appears. Doing so may result in lost data and difficulty in
restarting Windows NT.

Software Repair

If you experience operating problems following the installation of application
software or if the system becomes corrupt, refer to Reinstalling the MTS300
Software in Appendix B.
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Operating Basics

This section describes the features and identifies the components of the MPEG-2
DVB/ATSC/ISDB-S/ARIB System Analyzer. This section also contains a
tutorial to introduce you to the operation and capabilities of the analyzer. The
files required for this exercise are included with the application. When you
complete the tutorial, you are encouraged to analyze your own input streams and
experiment with the configurations and options.

If you need additional information on any topic while reading this section, refer
to the Reference section beginning on page 3-1.

Deferred-Time Analysis

The MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer uses several
graphical views to present transport stream data. These views give access to each
field, and each bit if you wish, within the transport packets, PES packets, and the
various PSI, SI, and PSIP tables.

Hierarchic View. The Hierarchic View is a diagram of the data components carried
by the transport stream. This view graphically depicts the MPEG transport
stream file by using icons to show the interrelationship of its components. These
icons identify each PAT (Program Association Table), NIT (Network Information
Table), PMT (Program Map Table), and PES (Packetized Elementary Stream)
packet, and three types of elementary stream (video, audio, and data). Additional
icons indicate the PID (Packet Identification) number for each data component.

For additional information on this view, refer to The Hierarchic View, beginning
on page 3-15.
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Hierarchic View of Sample_trp - Standard: MPEG-2

o —— r

B 4

iI I 4

Interpreted View. The interpreted view shows every field in the selected transport
packet, table section, or PES (packetized elementary stream) packet. Any packet
in the file can be accessed. You can search for errors in this view.

The interpreted view shown below is of one 188-byte transport packet in the
SAMPLE.TRP binary stream; this view can be created by double-clicking on the
TS (engine and tender) icon in the Hierarchic view.

TS - Sample.trp - Standard: MPEG-2 [_ [}
Rem 178300 - Boition -0 i’
sy byte | |mreport amer | | payleadanit et DI TPt aduptatiozy COrLGLET
ndicator start indicater jutor vl SaRmbLEE eld coziral COTLET
cordrol
Lo Lo M« JL o J[eJ[ o J[ + J[ o
Payload
124
a | 2

For additional information on this view, refer to The Interpreted View, beginning
on page 3-23.

Timing Displays. Two types of timing displays are available: PCR (Program
Clock Reference) contained in the transport packet headers and PTS/DTS
(Presentation/Display Time Stamp) contained in PES packet headers. The PCRs
are shown in a graphical format indicating their arrival time. The graphical
display of the PTS/DTS shows a time line for each access unit (such as a video
frame) indicating data arrival and value of each time stamp.
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Acquiring Transport Stream and Elementary Stream Files

The standard configuration Tektronix MTS300 MPEG Test System includes
sample video and audio elementary stream files and a sample transport stream
file in the Cfg-trp directory. These files contain pictures, common industry test
signals, and sample signals in MPEG-2 format. Use these files as example
formats for the tutorials and to construct sample transport streams.

Two additional sources of elementary stream files are available: a CD ROM
(Tektronix part number 063-1914-XX) and the Tektronix FTP site.

Test System CD ROM  To use the files on the CD ROM, either copy the files to the C:\MTS300
directory on the system disk or leave the disk in the CD ROM drive.

Audio Files. The CD ROM contains the following audio files in the Audio
directory:

MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer

15kz-064.mp2
15kz-128.mp2
15kz-192.mp2
15kz-256.mp2
1kz-064.mp2
1kz-128.mp2
1kz-192.mp2
1kz-256.mp2
400-064.mp2
400-128.mp2
400-192.mp2
400-256.mp2

4kz-064.mp2
4kz-128.mp2
4kz-192.mp2
4kz-256.mp2
Music064.mp2
Music128.mp2
Music192.mp2
Music256.mp2
Sync-064.mp2
Sync-128.mp2
Sync-192.mp2
Sync-256.mp2

The file names indicate the elementary stream bit rate. For example, the file
15kz-256.mp2 contains a 15 kHz audio tone at 0.256 Mbits/s.

The following Dolby digital audio files are also available:

acmod2_0.ac3
acmod3_0.ac3
acmod3_2.ac3
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Video Files. The CD ROM has a Video directory containing a 525 and a 625
directory. The Video\525 directory contains streams with 525-line video; the
Video\625 directory contains streams with 625-line video. The directories
contain the following listed files:

2-4

MPEG Test System FTP
Site

100b_015.mp2
100b_060.mp2
100b_120.mp2
Bbc3_015.mp2
Bbc3_060.mp2
Bbc3_120.mp2
Cact_015.mp2

Cact_060.mp2

Cact_120.mp2

Mobl_015.mp2

Mulb_120.mp2
Pulb_015.mp2
Pulb_060.mp2
Pulb_120.mp2
Sync_015.mp2
Sync_060.mp2
Sync_120.mp2
Tens_015.mp2
Tens_060.mp2
Tens_120.mp2

Mobl_060.mp2
Mobl_120.mp2
Mulb_015.mp2
Mulb_060.mp2

V700_015.mp2
V700_060.mp2
V700_120.mp2

The file names indicate the elementary stream bit rate. The file 100b_060.mp2,
for example, contains a video elementary stream with a bit rate of 6.0 Mbits/s.

Examples Directory. The CD ROM also contains the following files in the
Examples directory:

10khz.mp2
1khz.mp2
Demo_015.mp2

Demo_060.mp2
Sample.trp

You can access the same signals (and any new bit streams that become available)
via anonymous FTP from the Tektronix FTP site, fp.tek.com. If you have a web
browser, point it to the following URL:

FTP://ftp.tek.com/tv/test/streams/Element/

Or, use FTP to contact ftp.tek.com. Log in as anonymous and use your email
address as the the password. MPEG files are available in the subdirectories of
/tv/test/streams/Element. Each directory contains a Readme.txt file that describes
its contents.

The following script illustrates the procedure for connecting to the MPEG Test
System FTP site. Your entries are indicated with bold face type. Remember to
transfer data in binary mode.

% ftp ftp.tek.com
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Connected to inetl.tek.com.
220 inetl FTP server (Version wu-2.4(1) Sun Jan 29 12:29:00 GMT 1995)
ready.

Name (ftp.tek.com:user): anonymous

331 Guest login ok, send your complete e-mail address as password.
Password: enter your email address

230-
230-TEKTRONIXFTPARCHIVE
230- /

230-

230 Guest login ok, access restrictions apply.
ftp> cd /tv/test/streams/Element

250 CWD command successful.

ftp> get README. TXT

The data included in this FTP site distribution is available to you on an as-is
basis. Tektronix disclaims any and all warranties, whether express, implied, or
statuary, including any implied warranties of merchantability or of fitness for a
particular purpose.

If you do not have access to FTP, contact Tektronix at 1-800-TEK-WIDE and ask
for MPEG Test System support. An engineer will help you acquire the data. If
you have Internet access but are having trouble accessing the site, contact your
local system administrator.
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Tutorial: Analyzing a Transport Stream

This tutorial introduces the features and capabilities of the MPEG-2 DVB/ATSC/
ISDB-S/ARIB System Analyzer. Using step-by-step procedures and a standard
sample transport stream file, you can follow along with your test system.

NOTE. This tutorial is written assuming a basic level of familiarity with the
Windows 95 or Windows NT 4.0 operating system. If you are not comfortable
with either operating system, review the Windows NT documentation.

Getting Help

Additional information on MPEG-2 bit streams and analyzer operation is
available from the following convenient sources:

B The Reference section of this manual, MPEG-2 DVB/ATSC/ISDB-S/ARIB
System Analyzer, beginning on page 3-1.

B The analyzer Help menu.

B The MPEG-2 Help utility, which contains applicable MPEG-2 standards in
Windows Help format.

Double-click on the MPEG-2 Help icon in the Tektronix MPEG Test System
program group window to the start the Help utility.

& Tektronix MPEG Test System M= &3
File Edit Yiew Help

RN

Defered-Time DB Channel  ATSCTable DVE Table
Analyzer Coding and... Editar Editor

Frogram Stream
Analysis

MPEG-2 Help
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Starting the Analyzer Application

Double-click on the Deferred-Time Analyzer icon in the Tektronix MPEG Test
System program group window to the start the application and open the

application window.

& Tektronix MPEG Test System

[ [Of ]
File Edit Yiew Help
o = B OB E e
g DvEChamel  ATSCTable DvBTable ProgramSteam  MPEG-2 Help
Coding and... Editar Editar Analysis

Errar Injector Jitter Adder Multiplexgr ~ Video Stream
Analyzer

The Application Window

The following illustration notes the important features of the analyzer application

window.

MPEG2 DVB / ATSC / ISDB-S/ARIB System Analyzer
Menu bar ——>»  Fle Edt Selection Analsis FC2Dilon Options ‘window Help

Upper toolbar ——

Lower toolbar —— R ¥

Awudio Stream
Analyzer

Daolly Digital
Analyzer

Status bar—— |
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MenuBar  The Menu Bar contains the following menus:

m  File. Use File menu commands to control the analyzer/disk interface and
printing.

m  Edit. Use Edit menu commands to move among items (transport packets,
elementary stream packets, table sections) in the selected document window.

m  Selection. Use Selection menu commands to control extractions from a
transport stream file.

®  Analysis. Use Analysis menu commands to access the stream analysis
functions.

B Unscrambling. Use the Unscrambling menu command to access the
Unscrambling parameters entry dialog box. Available only if Option CA
(conditional access) is enabled.

®  PC2 Dialog. Use PC2 Dialog menu commands to send entitlement messages
to the PC2 card reader.

®  Options. Use Options menu commands to select analyzer configuration
options.

B Window. Use Window menu commands to manage the various open
document windows.

m  Help. Use the Help menu to access various forms of help information.

Upper Toolbar  The upper toolbar contains command button shortcuts for several menu
commands. Click on a button to execute a command.

Open Save As Hierarchic View Add View Standard
(to open a file)

To display an tooltip of a command button function in the status bar (at the
bottom of the application window), position the cursor over the command
button.
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Lower Toolbar

Status Bar

Status bar
message

E—

The lower toolbar contains command button shortcuts for the Edit menu
commands. Click a button to execute a command. The buttons are available only
when the active window contains an open file.

Previous Next Number of items
@m m@ @
First GoTo Last Find next error

To display an explanation of a menu selection in the status bar, position the
cursor over the menu selection.

MPEG2 DVYB # ATSC / ISDB-5/ARIB System Analyzer
Edit Selection Analpsis FCZDialog Options  Window Help

Cirl+0 !

ISDE-S44RIB

SEVEAS

Bt
Frinter S etup.

Exit

W 2l 2 ¥

Open an existing document
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Opening an Existing Transport Stream File

Open the sample transport stream file Sample.trp.

NOTE. You must specify the measurement standard (MPEG-2, DVB, ATSC or
ISDB-S/ARIB) before opening a file.

1. Select MPEG-2 from the Options menu.

2. Select Open from the File menu. A standard Windows Open dialog box
appears within the application window.

Open [ 2] x]
Look in: |@Efg-trp j gl lf_g

) D efault brp

tatrp
. iy

File narne: |Sample.trp Open

Files of type:  [Stream [ TRP:2BIN - TS) =l Cancel |

rao peh as read-only

Select Stream from the Files of type list.
Select Cfg-trp from the Look in list.

Select Sample.trp.

SANER L S

Click Open.

The Hierarchic View of Sample.trp window appears within the application
window.
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The Hierarchic View

2-12

Hierarchic View of Sample trp - Standard: MPEG-2

PID 51 PES ATTDIO

4] | Ay

NOTE. The Analyzer cannot generate a hierarchic view if the stream does not
contain a PAT (program association table, PID 0) or PMT (program map table).

The hierarchic view that appears when you first open a file is based on the first
versions of the PAT and PMT tables found in the stream. You can use the Next
command in the Edit menu or click on the Next command button (in the lower
toolbar) to go to the next PSI version, if any, in the stream.

When you open a multiplex file in the application window, a hierarchic view
appears. The hierarchic view uses icons to show the interrelationship of stream
components and is the starting point for many types of analyses. With the
hierarchic view, you can contextually select, display, and analyze specific
portions of the transport stream. Table 2-1 describes the System Analyzer
hierarchic view icons.
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Table 2-1: Icons used in the hierarchic view

Icon

Element type

Multiplex transport packets. This icon represents all (188/204/208-byte) transport

packets that make up the stream. If you visualize the transport stream as a train,

this icon represents every car in the train, regardless of its configuration or what it
contains.

Transport packets of a particular PID (Program ID). Other elements (tables,
clocks, PES packets) are the “payload” contained within transport packets or are
constructed from the payload of several transport packets that have the same
PID. The PID number appears under the icon.

In the hierarchic view, the icon to the right of this icon represents the payload of
packets with this PID.

Transport Packets that contain independent PCR clocks. The PID appears under
the icon.

PAT (Program association table) sections. Always contained in PID 0 transport
packets.

CAT (Conditional access table). The CAT table allows you to associate one or
more conditional access systems with the transport stream.

PMT (Program map table) sections.

NIT (Network information table). Provides access to service information tables
through the PSI/SI/PSIP commands from the Selection menu. Also used for
Private sections.

When the DVB option is selected in the Options menu, this icon can represent
SDT, BAT, EIT, TDT, TOT, and TSDT sections, plus DIT and SIT sections. When
the PSIP option is selected in the Options menu, this icon can represent MGT,
EIT, ETT, T/CVCT, RRT, and STT sections. The table type is listed below the icon.

When the ISDB-S/ARIB option is selected in the Options Menu, this icon can
represent EIT, SDT, DIT, SIT, TSDT, TDT, TOT, BIT, DCT, DLT and SDTT sections.

PE:

PES (Packetized elementary stream). This icon represents all packets that,
together, contain a given elementary stream. Individual PES packets are
assembled from the payloads of several transport packets.
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Table 2-1: Icons used in the hierarchic view (Cont.)

Icon Element type

R MPEG video elementary stream.

.

VIDED

- M | Digicipher Il video elementary stream.

B gicip y

I

GLD

o MPEG audio elementary stream.

% !
ATILIO

E]Qﬁ% Dolby digital (AC-3) audio elementary stream.

AC-Z

E]Qﬁ% AAC (Advanced Audio Coding) audio elementary stream.
LML

oo Data elementary stream.

0010

10001

DAL

MIP (Mega-frame initialization packet). The MIP defines the start of the

. mega-frame and the transmission characteristics of the DVB-T (terrestrial DVB)

] transport stream.

G DSM CC (Digital storage media command and control).

110001
DEM CCD

ECM (Entitlement control message) sections.
()

ECM

iiﬁ” EMM (Entitlement management message) sections.
i s
HLM
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Shortcut Menus. Each type of hierarchic view icon has a context-specific shortcut
menu that allows quick access to the functions available specifically for the
chosen element. Display this menu by clicking the right mouse button on the
icon. Hold the mouse button down, highlight the desired command, and release
the button to select the command.

"
Transport Packets Section ;ﬂ;

PID kap Check CRC r S'ave

L RIS RS bt Yideo Stream Analvzer |
P&l rate T-5TD Analysis

k ranspor Packets |

ransport Packets Sgve
FCR Analysis Audio Stream Analyzer

Section P!ES Fackets Sve |
Check CRC FTS/DTS ALC-3 Strearn Analyzer

NOTE. You can select the first command on the shortcut menu (or the only
command in one-item menus) by double-clicking on the icon. For all except
elementary stream icons, this will open an Interpreted View of the packet or
section.

Exploring the TS Icon

1. Click on the TS icon with the right mouse button and hold the button down
to open the TS shortcut menu.

Transport Fackets
FID kap
hultiples Allocation
P&l rate
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2. Highlight Transport Packets and release the button. This opens an
interpreted view of the first complete transport packet in the stream.

TS - Sample_trp - Standard: MPEG-2 (O]
Item data —— Rem 179300 - Position : 0b =
. ey byts | |mreport smor | | papload it mmeport. FIL trareport. aduptatio corkirnaitg
Header fields —— indior | | st indicator | | prioriry sqambling | | field comerol | | couer
cordrol

L]l o JL+ JL o Jle ][ o J[ 1+ ][ o

Payload

Packet (item) ——
contents

[ 124

4] | Ay

NOTE. You can also open the same interpreted view by double-clicking the
TS icon.

The Interpreted View  The interpreted view shows the structure of the transport packet and provides
access to all the information contained in the packet header and payload. The
transport packet display shows one transport packet at a time.

1. Use the command buttons on the lower toolbar to scroll through the transport
packets; notice that the Item number changes as you scroll.

o Ee S o

First GoTo Last Find next error

The transport stream in Sample.trp consists of 9300 transport packets, as
indicated by the item number (Item 1/9300) at the top of the display. If an
interpreted view does not show this information when the view is first
opened, click on the Number of Items or the Last command button to add the
information to the item data.
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2. Find the next packet syntax error in the stream by clicking the Next error
button. The program will search forward in the stream until it either finds an
error or reaches the end of the file. If it finds an error, it displays the inter-
preted view of the transport packet that contains the error. Because there are
no syntax errors in any Sample.trp transport packets, the Analyzer displays
the No Error Found message.

Hext Emmor

@ Mo Emar Found

3. You can learn about specific packet fields by double-clicking on the
rectangle that identifies the field. Double-click the PID rectangle now.

TS - Sample_trp - Standard: MPEG-2 (O]
[ TwepemPulke | eml6300- Boshion: 0b ﬂ
s byts | |moeport arer | | paylead it eIt Tepat aduptaticn oLty
ndicator start indicater | | prioriey soamb ling, fie1d cortrol coumter
cottral

Lo JL o JL + J[ = ]

Dayload

The PIDis a 13 bit field,
indicating the type of the data
stored in the packet payload.
[Loes PID value 0x0000 is reserved
for the Program Association
Table. PID value 0x0001 is
reserved for Conditional
Access Table. PID values
0x0002-0x000F are reserved.
PID value 0<1FFF is reserved
for null packets.
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4. Click anywhere in the interpreted view outside the field name message box
to dismiss the message. Then double-click on PID value 0, to display help
information about this value. In this case, the message reminds you that PID
0 always identifies the PAT.

e bepte | [trmeport emror | | pagrload it trmeport. trmsport. adaptation conitirnity
indicator start idicator priority soambling field cordrol CONTtEr
conitrol

[ o J[ v J[ o ] [ o [+ J[ o ]
Program Association Table ‘
Tayload

5. Sometimes you can learn more by looking at field values displayed in
hexadecimal base. Use one of the following methods to display hexadecimal
values:

m  Select Base from the Options menu; click the Hexadecimal option
button in the Base dialog box; click OK to proceed.

B Press the F2 function key to toggle field values (and values in the
hierarchic view) between decimal and hexadecimal base.

o
Emfetiaira

Decimal Hexadecimal

The Hexadecimal View  The hexadecimal view shows all bytes that make up the current item. An
MPEG-2 transport packet contains either 188, 204, or 208 bytes.

1. To open a hexadecimal view, click the Add View command buttonon the
upper toolbar. The View Type submenu opens.

I
m —iew Twpe—

Transport packet
Hexadecimal
Binary
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2. Select Hexadecimal from the submenu. This produces a hexadecimal view
of the current transport packet.

@ TS - Sample trp - Standard: MPE G-2 H=] 3
Transport Packet Item 1 / 9300 =

47 40 00 10 00 00 BO 11 66 00 C1 00 6O 06 00 E6 10 6O 01 EO . .
15 10 9D F6 57 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF . .

-

A 2P

The first few bytes appear in blue characters on the display to indicate that
they are required header information for the type of item. A transport packet
has four required bytes. The blue, required bytes may be followed by several
bytes shown in gray (for an example, use the command buttons to go to
transport packet three of Sample.trp). The gray bytes are optional or variable
header information. The remaining bytes, displayed with black characters,
are the payload or data bytes. When viewing 204 byte length packets, the last
16 bytes are shown in Red.

3. Close both transport packet windows (interpreted and hexadecimal views).
You are ready to look at a PID map of the sample transport stream.

PID Map  The PID map can help you find the stream location and exact packet (item)
number of a particular table section.

1. Click on the hierarchic view TS icon with the right mouse button. Hold the
button down to open the shortcut menu.

2. Select PID Map from the menu.
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2-20

& PID Map for Sample trp - Standard: MPEG-2 M=) B3

TS packets 1 to 180 - Coleurs according to PSI versien number 1
PHT CAT TSDT NIT

Uideo Audio Other
(0000001) 0021 0050 0050 0050 0050 0050
(0000011) 0050 0050 0050 0050 0050 QeSO
(00E0021) 0050 0050 0A50 0O50 0O50 050
(00EAE31) GOS0 AOSO 0050 0050 0050 0es50
(0000041) O0OSO GOS0 0050 00%0 0050 0050 05O
(0000051) 0050 0050 0050 0050 0050 0050
(0000061) 0050 0050 0050 0050 0E50 0050
(oeE00T71) 0050 0050 0050 0% 0050 0050
(0000R81) Q050 0050 0050 0050 0O50 0ESO
(0000091) 0050 0050 0050 0050 0050 0S50

al | AP

The PID map represents every transport packet in the stream with its PID
(for uniformity, every PID is listed in a four-digit field). The black numbers
down the left side of the window indicate the packet number of the first
packet of every row. In the map, each unique PID is color-coded according to
the type of element it identifies. For example, light green characters signify
PIDs of packets that contain PAT sections. The first PAT section is in packet
one.

Click the Next command button (p) repeatedly until you see the next light
green PID. The second PAT section in Sample.trp is in packet 334.

Close the PID map. You are ready to look at the Multiplex Allocation in a
sample transport stream.
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Multiplex Allocation  You can use the Multiplex Allocation view to see what portion of the transport
stream multiplex is used by each PID.

1. Click on the hierarchic view TS icon with the right mouse button to open the
shortcut menu. Select Multiplex Allocation to open the Multiplex Alloca-
tion for the Sample.trp window.

= Multiplex Allocation for Sample trp - Standard: MPEG-2 (O]

MIES-2

[ P 0=0161%{16120 bitss |

[ ro 16=0022 %2150 bitsizd

- PID 21=0.151 % (15053 bitefe)

[ ro 4z=001L w1075 by

- PID S0=61344 4406134408 it)- Prog 1ES 1
PID' 51=0505% (50537 bitefe)- Prog 1ES 2
PID 8110= 0011 %1075 bits/s)

PID 8101 =37 706 WL 3T T0560 bitess]

Prog 1 62000 5406200000 83)
PAT 0161 %016 129 hits/s)
HIT @ 0022%(2150 hite)s)

4] | Ay

You may find the multiplex allocation pie chart useful for determining which
PIDs are present in the transport stream and for confirming that each PID
uses the expected amount of the multiplex.

NOTE. PID 8191 is the stuffing PID; it is not shown in the hierarchic view.

2. Close the multiplex allocation window. You are ready to look at the transport
packets of a particular PID with a minimum of clutter.
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Exploring the Transport Packet Icon

The transport packet (rail car) icon represents transport stream packets that are
identified with a particular PID. Other elements (such as table sections or PES
packets) are the payload contained within these transport packets; the elements
may be fully contained within one packet or constructed from the payload of
several packets with the same PID. The PID number appears under the transport
packet icon. In the hierarchic view, the icon immediately to the right of a
transport packet icon represents the payload.

1. Press the F2 function key (if necessary) to display hierarchic view values in
decimal base.

2. Double-click on the PID 21 transport packet icon.

The analyzer opens the TS - Sample.trp -> PID 21 window.

hem 1- Bosition : 165b -

s byts | |moeport arer | | paylead it TPt I TaEpat wduprtation CopLivaity

ndicater st ddicator PrieTLy s ling feld cordrel ST

canirel

Lol o JL v JL e Jf=]l =« [+ [ o
Payload
Lo ]
Ll | W o4

You can search for errors and get additional information about the fields and
field values as you did with the transport packet at the TS level. The difference is
you are now looking at only PID 21 packets, which contain the PMT sections
that describe program one.
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3. Click the Last command button in the lower toolbar to go to the last PID 21
packet in the transport stream. There are only 14 PID 21 transport packets in
the Sample.trp stream.

TS - Sample_trp -3 PID 21 - Standard: MPEG-2 (O]
ltem data — > [ TmspmtPadet | memles1s- Position: 16250720 i’
o byts | |mveport amer | | payloadumit L. 1 el kRt adaptaticn comt ity
mdicator start idicator ricTiy Seramh 1z field copdral ConTter
cordrol

[ 1T o 11 1 [N T 0 [T l_lj
1] | v

The item Position is the number of the first byte in the packet relative to the
beginning (byte 0) of the transport stream file; there are 1625072 bytes in the
file (and stream) before the last PID 21 packet.

As with the TS interpreted view, you can open a hexadecimal view of the packet
through the Add View command button. Another way to look at the packets is in
a binary view.

1. Click the Add View button.

2. Select Binary from the View Type submenu. The analyzer opens a window
titled TS - Sample.trp -> PID 21.

B TS - Sample_trp - PID 21 - Standard: MPEG-2

Transport Packet Item 184 /7 14 i’
01000111 # 01000000 # OOOIOI0T # OOO11101 # COOOOOOO
00000010 # 10110000 # 00010111 # COOOOOOO # COOOOOO1 H
11000001 # 00OO0OOE H# OCOOOOOED # 11100000 # GO110010 #
11110000 # 00000000 # Q00000O1Q # 11100000 # Q0110010 #
11110000 # 00OO0ODO # 00000100 # 11100000 # 00110011 #
11110000 # 000OOODO # 00001110 # 11106010 # 01110111 #
010160161 # 11111111 & 11111111 & 11111111 & 11111111 &
11111111 # 111111711 # 11111111 8 111117111 8 11111111 8
11111111 # 11111111 # 11111111 8 111117111 # 11111111 #
11111111 # 11111111 8 11111111 8 11111111 8 11111111 8
11111111 # 111111711 8 11111111 8 111117111 8 11111111 8
11111111 # 11111111 8 11111111 8 11111111 8 11111111 8
11111111 # 111111711 # 11111111 8 111117111 8 11111111 8
11111111 # 11111111 # 11111111 8 111117111 # 11111111 #
L]_1|111111 H4 11111111 # 11111111 # 11111111 4 11111111 H ’;
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The first eight-bit byte, which corresponds to the sync byte (see the
interpreted view on page 2-22), is 01000111; the binary equivalent of

71 decimal and 0x47 hex. The next three bits correspond to the following
three packet fields, and the 13 bits after that (to the end of the third byte)
correspond to the PID 00000 00010101 (which equals 21 decimal).

3. Close the PID 21 interpreted and binary view windows.

Exploring the PAT Icon

The PAT shortcut menu has two commands: Section and Check CRC.

Section  PAT (Program Association Table) icons represent PAT sections, which are always
contained in PID 0 transport packets. Use the following procedure to open an
interpreted view of a PMT section.

1. Click on the hierarchic view PAT icon with the right mouse button. Hold the
button down to open the shortcut menu.

2. Select Section from the shortcut menu to open an interpreted view of the

PAT.
=: Sample.trp -» PAT - Standard: MPEG-2 - [Of ]
Item data —> BenL-Posiim: 30 =
table id | | section rmdas| | =0 TeserTed seckio, tmrepart | |Tesered Tersion Qe st serkiog lust sectican
Header fields —— o lngth || smemid wmber || ndicter || wembe | | aasber

Lo JL v JloJlz Jlw Lo Jl=1[e J[L v J[ o J[ o

progom | |reserved | | mebmock

Program Q—> | | ®=b= e

information

o JL 7 J[ s |

progrm | |reserved | (progmm map
Program 1 —— | | zomber P>

information
[ I

CRC
Section CRC——

Cecl02DEGST
-

4] | M

NOTE. You can open the same interpreted view by double-clicking on the PAT
icon.
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You can do all the same things at the PAT section level that you can at the
transport packet level. You can search for errors, get information on the
fields and field values, and scroll among the PAT sections contained in the
stream.

3. Close this window.

Check CRC  The Analyzer automatically calculates and checks the CRC (cyclic redundancy
code) of the first PAT section when opening a transport stream file. To check the
CRC of every PAT section in the stream and compare it to the number coded into
the section’s CRC field, do the following:

1. Click on the PAT icon with the right mouse button and hold the button down
to show the PAT shortcut menu.

2. Highlight the Check CRC command and release the button. Because there
are no CRC errors in the Sample.trp PAT sections, the Analyzer displays the
following dialog box:

CRC Analysis for PAT sections for Sample. trp

@ All CRC are corract

3. Click OK to close the dialog box.

4. The Message for... window also opened during the analysis. Dismiss this
window and click No to close the Closing of the error message view dialog
box. The purpose of the Message for... window is explained later.
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Exploring the PMT Icon

The MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer can perform several
types of analyses on PMT (Program Map Table) sections.

Section  Use the following procedure to open an interpreted view of a PMT section.

1. Double-click the on PMT icon to open an interpreted view of the first PMT
section in the stream.

Sample.trp -> PMT (PID 21 - Program 1) - Standard: MPEG-2 - [Of ]

Bom 1 Posiion :193%
table id | | sectiom oprdace( | mero | [reserved sectinn program | [reserwed Tersion. et Tt sectiom Tust section, | |zeserved | [PCEPID | |reserved | | progRm o
indicator lemgth nmibeer rommber ndicator rormber rommber lmgth
Lz v Jle =z Jl= M Qe o JL v JL o JL o JL 7 J[e J[s J[ e |
Etrenm type| (resenved | | elemerdary | (reserved ES5 dnfin
P Ingth
Lz JLz )= Jls J[ o ]
tream type| [reserred | | elemerdary | |reserwed ES frdoe
o gt
L JL7 gl s Jls J[ e |
CEC
-
<] | 2

Syntax analysis checks all PMT sections in the stream for errors and variations
from the standard. It searches for errors within the PMT itself and relative to the

other tables (NIT and SDT for example).

Syntax Analysis

1. From the Analysis menu select Syntactic.

The example does not have any PMT syntax errors.

Syntactic Analysis for Sample trp -> PMT (FID 21 - Program 1) - Standard: MPEG-2

@ Mo Errar Found

2. Click OK to close the Syntax Analysis for... window.

3. Dismiss the Message for... window and click No to close the Closing of the
error message view dialog box.
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The fact that the analyzer found no syntax errors in any of the PMT sections
does not guarantee there are no such errors in the entire stream. To widen the
search do the following:

a. Click anywhere on the hierarchic view window or minimize the PMT
interpreted view; the remaining, hierarchic view window is then
automatically selected.

b. Select Syntactic from the Analysis menu. This time, the analyzer
searches the entire stream for errors and opens a Message for... window.

The Message for... window reports errors, warnings, and information
about analyses performed in Hierarchic and Interpreted View windows.

c. Select the Message for... window and type * on the numeric keypad to
expand the window. Note that all errors in this case are in one PES
packet.

NOTE. For more information on the message window and error reporting, refer
to Message Window on page 3-72.

4. Close the Message for... window.

During the Syntax analysis you may have noticed a message window similar
to the following illustration. For most analyses performed in the hierarchic
view, and for Go to searches performed in the interpreted view, pressing the
Escape key interrupts the running process. Use this feature to terminate an
analysis or search that becomes too lengthy. Click in the active window
before executing the keystroke.

Perform a syntactic analysis
PES packet level
Press Escape to abort
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Check CRC  You can check the CRCs in all PMT sections through the shortcut menu just as
you did with the PAT sections.

You can also check every CRC in the transport stream just like you checked the
syntax of all items in the stream:

1. Select the hierarchic view.
2. Select Check CRC from the Analysis menu.

If CRC errors are found, the analyzer lists the errors in the Message for...
window. Because Sample.trp contains no CRC errors, the analyzer reports that
all CRC are correct.

3. Click OK (or press Enter) to dismiss the CRC Analysis... message window.

4. Close the interpreted view window and the Message for... window.

PCR Analysis  PCR (Program Clock Reference) analysis allows you to see a graphical
representation of the PCRs versus time.

1. Click on the PMT icon with the right mouse button and hold the button
down to open the PMT shortcut menu.

2. Select PCR Analysis from the menu to open a window that diagrams the
first ten clocks in the program. (Note: If the Transport Stream Property
dialog box opens, click OK to accept the default Mux Rate.)

% PCR of Sample.trp (PID 50, Pragram 1) - Standard: MPEG-2 H[s] E3

-
PCR Clock Wiew Mhatiplescrate: 10000000 bits/sec :I

PCRromber 1to 10

ELLERLLLELD

0000301 0.180706 0361110

4] | Ay
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3. Double-click on the third clock icon. This opens the PCR value box shown
below.

PCR Clade Ve Tfattiplescrate : LOOOOO00 brits fsec

P CE rommber 1to 10

PUR number 3

anonzol
PCR Base : 241 units
PCR Extension 1 227 units
PCR Value [PCRY] : 0.080463963 sec
Interpolated PCH [PCRI] : 0.080463985 sec
PCRI - PCRY : 0.000000022 sec
Previous PCR Arrived Since : 0.040156807 sec
Packet Number : 536
Packet Number of PID 50 1328

4. Click anywhere in the PCR clock window to dismiss the value box.

5. To display the values of all ten diagrammed PCRs at once, click the Add
View command button in the upper toolbar.

6. Seclect PCR Values from the View type submenu. The analyzer creates a
window that lists the values for all ten PCRs in the diagram.

PCR wvalues -  Multiplex rate: 10000000 bitsfsec :I
PCR number 1

PCR Base 1 27 units

PCR Extension 1 21 units

PCR Value [PCRY] : 0.000300778 sec
Interpolated PCR [PCRI) : 0.000300778 sec

PCRI - PCRY : 0.000000000 sec

Previous PCR Arrived Since : 0.000000000 sec

Packet Number 13

Packet Number of PID 50 01

PCR number 2
PCR Base 1 3627 units
PrR Fytencinm . * 194 units ;I

You can use the command buttons on the lower toolbar to navigate among
the program PCRs.

7. Click the Next command button to show the values of the next ten PCRs
(numbers 11 through 20) in the stream.

8. Select the original PCR of Sample.trp (PID 50, Program 1) window again.
Notice that the diagram now shows PCRs 11 through 20.

9. Close all windows except the hierarchic view.
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2-30

T-STD Analysis

T-STD analysis checks the selected program against the transport stream system
target decoder model defined in the MPEG-2 standard.

NOTE. The Dynamic Analysis algorithm uses the “Leak method” to transfer
video elementary stream data from the main buffer, MBn, to the elementary
stream buffer, EBn. Buffer overflow can occur when analyzing streams (such as
those created with the MPEG Test System Multiplexer application) that require
“VBV delay method” data transfer.

Refer to ISO/IEC 13818-1 for additional information about leak method and
VBV delay method buffering.

1. Select the Options menu and verify that Visual TSTD and LTW is
check-marked.

2. Right-click the PMT icon and select T-STD Analysis from the shortcut
menu.

Section
Check CRC
FCR Analysis

3. [If a Transport Stream Property window opens, click OK to accept the
multiplex rate and continue.

Because Visual TSTD and LTW mode is selected, the analyzer opens a T-STD
Buffering Simulation window. The window contains dynamic bar graphs of the
video, audio, and system buffers; the graphs show how full each buffer is at a
given point in the simulation and also change color from blue to yellow to red as
buffer overflow approaches and occurs. The simulation is not real-time and may
take several minutes.
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Y T-STD Buffering Simulation for SAMPLE TRP (program 1) =] 3

Processing packet #627 - Current time is 0.094293 s.

TE1 ME1 EEL
vibeo | 0% — ox —[iox
Sime = 512 Teytes Sime = 7500 bytes Sime = 220ET6 bytes
TE2 B2
aupto| 0% —Jl 20%
Sime = 512 Teytes Sime = 3504 bytes
TEBsys Bsys
SYSTEM 0% ——| 0%
Sime = 512 Teytes Sime = 1536 bytes
2 H 4

4. To terminate the simulation at any time, click the Abort button in the
lower-right of the simulation window. The simulation pauses and you can
choose to resume analysis or close the window.

5. Buffer overflows occur near the end of the Sample.trp simulation. To access
an error report, select the Message for... window and type * on the numeric
keypad. You may have to move the buffering simulation window aside to
gain access to the Message for... window.

&= Message for Sample trp - Standard: MPEG-2

B k)
@ Mates
5§ TSTD Analysis (+344)
1 BB 2/7/99 3:43:25 PM*Complete™ (+344)
2 Program #1 (+344)
1§ "Overflow! in bufer MBT (+344)
g Pecket #8056, #3957, #8358, , #8977 (+22)
g Packet #6979, #5960, #8387, ., #3300 (+322)

NOTE. For more information about the message window and error reporting,
refer to Message Window on page 3-72.

6. Close all windows except the hierarchic view.
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Exploring the PES Packet Icon

The PES (Packetized Elementary Stream) packet icon represents all packets that,
together, contain a given elementary stream. Individual PES packets are
assembled from the payloads of several transport packets. You can learn more
about the PES packets and their PTS/DTS (Presentation and Decode Time
Stamps) through this icon.

Interpreted View 1. Double-click the PES icon immediately to the right of the PID 50 transport
packet icon to open an interpreted view of the first video PES packet.
Sample_trp -» PES PID 50 - Standard: MPEG-2 - [Of ]
Eom 1- Bosirion : 338% - Thue :0 D00310 = ﬂ
pudict At sreum id | | PES padist
code pref length
| 1 | | 224 | | 40005
10 IES PEZ odata alizvmart | |copyright | | origialer | | PTSDTS | [ESCRflz rESmeﬂag Dhtrick addftismal PES CRC IES DES header daty
Seramh 1z Tricrity mdicatar I o flagze mode flaz copryr if flaz flag ot ems oty g lenzth
comtral
e JC o JC o Jo Je e e Jre JC o JC e Qe e [ w ]
anll PTS 0ol LTS PES pachet.
L] =
[3 J[aeres][ 1 |[emsz][  4vmm2 -
al | AP

2-32

The Item data (near the top of the window) includes a Time: entry. This is the
time, relative to the beginning of the transport stream, that the first byte of
the packet appears in the stream. The time is included in all interpreted views
that you open after performing an analysis involving a multiplex rate
calculation. Both PCR analysis and T-STD analysis, performed through the
PMT icon, involve a multiplex-rate calculation.

The current interpreted view offers the same options as the previous syntax
analysis of the entire stream within the PID 50 PES packet.

Click the Next Error button on the lower toolbar. The program checks each
packet in the stream for errors. If it finds an error, it jumps to the transport
packet containing the error. There are several errors in the last PID 50 PES
packet in Sample.trp. The errors are highlighted in red on the test system
display.
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Sample_trp -» PES PID 50 - Standard: MPEG-2 - [Of ]
Eem 21 /21 - Dosition : 1667000 - Time : 1333600 < =
stream id |\ PES padiet
)=
!" 56056
PEE | [dssligemere| opyrigt| [orizpater | [ 7S 0TS | [ESCREng| [ree ag] | Dottmiar | [ addsionsd | [PES cRE i | [ASmeanraN |
Tricrity mdicatar I o flagze mode flaz copryr if flaz flag ot ems oty g ety

T P | | I | N

0010' |st Reser\red Est:R ESCR mode || fieldid | | irdraclice || equency PESpar_'ket
comml reffesh tnmeation copy'mﬁ) Byt.es ‘) datatrrte

_.4324?99 ~n5393914»\5u%| I u@z =

4] | M

3. You can find out more about an error through the interpreted view. In the
upper right corner of the view window, double-click on the packet start
code prefix box to find out more about that field.

streem id | | PESpacket

packet start code prefix
The packet start code prefixis a 24-hit
code. Together with the stream_id that
follows it constitutes a packet start
code that identifies the beginning of a
packet. The packet_start_code_prefix
is the bit string '0000 0000 0000 0000
0000 0001 (0x000001).

4. Read about the field and then click once outside the message window (but
inside the interpreted view) to dismiss the message.

5. Now, double-click on the field value to see the value error message.

packet start stream id | | PES pachet
condhe prefh Lensth

Error.’must be 0x000001,

6. Close the interpreted view window.
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PTS/DTS

2-34

PTS/DTS analysis extracts the presentation and decode time stamps embedded in
the elementary stream and shows their relative time positions in a graphical
display window. With this display you can verify the logical sequence of all time
stamps (the PTS must arrive later than the DTS and both must follow the
associated data arrival for example) and check for the existence of B fields,
which have no DTS.

1. Click on the PID 50 PES icon with the right mouse button and the button
down to open the PES packets shortcut menu.

2. Highlight PTS/DTS and release the button. This opens a window containing
a diagram of the first four PTS/DTS events in the elementary stream.

PTS{DTS of Sample.trp (PID 50. Program 1. ES 1) - Standard: M... =] E3

DPTEDTE Clock Viewr

-
DT2/DTS romber 1o 4 ﬂ

0000301

T ¥
0245300 0420700

=

4] | Ay

The preceding illustration reveals some errors in the Sample.trp PID 50
elementary stream:

m  Three of the arrival times do not coincide with the start of the associated
access unit.

®m  Two of the PTS/DTS events involve more than one access unit.

Both of these errors suggest problems in the encoding process. Below is a
diagram from a correctly encoded stream.
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W PTS/DTS of DEFAULT TRP (PID 50, Program 1. ES 1) M=l B3

PTS/DTE Clodk Wiew PTS/DTS ramber 1o 4

1 T
0000301 0225500

T
0450700

Table 2-2 lists and explains the icons used in the PTS/DTS diagram.

Table 2-2: PTS/DTS graphic view icons

Represents Double-click for
PCR (Program Clock Refer- Time value of the PCR and location of the packet
ence) within the transport stream (TS packet number)

. Arrival time of the PTS/DTS

Arrival time value, time since the previous PTS/DTS
arrived, and location of the packet (PES packet
number) within the elementary stream

DTS (Decode Time Stamp)

Time value of the DTS and location of the packet
within the elementary stream (PES packet number)

PTS (Presentation Time Stamp)

Time value of the PTS and location of the packet
within the elementary stream (PES packet number)

AU (Access Unit)

DH::: [w]| B2 |5

Begin time

End time

Size in bytes

Type of frame (intra, predicted, or bidirection)
Reference time

*

Beginning of GOP

Not applicable

MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer
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The example timing diagram illustrates several features of a correctly encoded
MPEG-2 video stream:

B Access units arrive one after another, as you can see from the left side of the
diagram.

B The order of access unit decoding and presentation is visible in the right
portion of the diagram.

®m  Intra (I) and predicted (P) pictures must be decoded before presentation and
therefore have both DTS and PTS. Bidirection (B) frames are decoded and
presented at the same time and therefore have only presentation time stamps.

® B frames use information in an associated P frame; the P frame must be
decoded before the B frame(s) are decoded, but is presented after the B
frame. In the example, the order of frame decoding is IPBB, but the order of
presentation is IBBP.

3. Double-click on the first arrival icon to reveal its values.
PTS/DTS rommber 1to 4

Gk |

0poozal 0243500 0480700

.g D
mml Arrived number 1 —*

| Value : 0.000303178 sec v
Previous PTS/DTS : 0.00000D0D0D0OD sec
Packet PES number Ha
— —
y;)
L"'_I I - ! ¥

4. Click within the PTS/DTS window, but outside the value window, to dismiss
the value window.
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5. Double-click on the first AU icon to learn more about the access unit.

PTEDTE Clock Wiew DTS/ TS rommber 1 to 4

0000301 0245500 0420700

z 2

K—1ﬁ : ’
Access Unit number 1

Begin AU 1 0.000391178 sec
—— End AU : 0.116557385 sec

Size : 87036 bytes
— Type sintra(l)

Reference time ;0

Begin GOP : Yes

6. You can navigate among the time stamps of an elementary stream with the
lower toolbar command buttons or the equivalent commands in the Edit
menu.

7. Experiment using the lower toolbar command buttons to move among all the
time stamps in the elementary stream (or at least that portion of the stream
saved as Sample.trp).

8. Close all windows including the hierarchic view of Sample.trp.
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Viewing PSI/SI Data

2-38

You can access interpreted views of PSI, SI, PSIP or ISDB-S/ARIB tables using
the following procedure. The specific menu selection depends on the standard
used when you opened the active file: MPEG-2 (PSI), DVB (PSI/SI), ATSC
(PSI/PSIP) or ISDB-S/ARIB (PSI/SI/ARIB).

1. Select DVB from the Options menu.

2. Open a DVB (Digital Video Broadcast) transport stream file if you have one
available.

3. Select PSI/SI from the Selection menu. The PSI/SI Selection dialog box

appears.
PSI/SI Selection
—Type
C BAT  PMT  CAT © TEDT
50T O BAT CEIT
C BST O TDT CTOT
C oIm 8T
' EMM  ECM

™ Private Section

a4 | Cancal

4. Select NIT and then click OK to open an interpreted view of the first NIT
section in the stream. The exact appearance of the view will depend on the
configuration of your particular DVB stream.

I Dwb trp -> NIT (PID 16) - Standard:- DVB [ [O]x
=
Hetwod Infomation Tab le Tem 1- Posttion : 187971h =
tahledd | | cortiom cyntat| | Tecermed TeseTmod. coctimm | pwtarorh id B0 e oL CUTHE Tt coction Tact coction DR etk decrriptor DVE MG OTE STTeAm
mudirator fithre use length resermed ommher nddicator rumiher rumiher reserred descriptar reserved Toop kngth
Tengih

Lo 10 v M0 v L= 00 Qe Lz Tl JL o [ e Lo J[w [ w = J[ = ][ ¢ ]

CEC

-
4
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NOTE. You can also open this view by double-clicking the NIT hierarchy icon or
by selecting Section from the icon shortcut menu.

5. Double-click on a descriptor field, if the NIT contains them. The resulting
descriptor message box contains an ASCII decode of the network informa-
tion associated with the transport stream.You can use the same technique to
view descriptor information in any DVB table in the stream.

DVE retrrork: desriptor DUE trRnSpOTt StTedm
Tegermed desiptar Tegermed loop Jergzth
= L
(IEER | oo scriptor
Satellite Delivery System :I

descriptor tag 67
descriptor length 11
frequency (GHz) 000.10000
orbital position (degrees)  002.0
west east flag 1 eastern position
polarisation 1 linear - vertical
modulation 1 @PSK
symbol rate (Msymbolis)  000.0000
FEC inner 5 718 conv. code rate

a | A

6. Close the NIT section window.
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Automatic Analysis

2-40

In the course of this tutorial, you have used the MPEG-2 DVB/ATSC/ISDB-
S/ARIB System Analyzer to perform several kinds of analysis on various stream
elements. The analyzer also has an automatic analysis feature that simplifies
evaluation of the entire transport stream, yet still permits detailed analysis of
many types of errors.

The following procedure requires that you have the hierarchic view of
Sample.trp open on your analyzer display. If you closed that window, open
Sample.trp again using MPEG-2 as the standard. Refer to page 2-11 to
refamiliarize yourself with this process if necessary.

1. Select Automatic analysis from the Options menu. The Options for
automatic analysis dialog box appears.

Dptions for automatic analysis

Chooge the analyses you want
ta be performed by the
automatic analysis:

2l Spntactic

[V Corgistency

¥ PSI/51/PSIP rate -
¥ FCR clocks

¥ PIS/DTS stamps ﬂl
¥ Semartic

V' Dynamic

QK

2. By default, automatic analysis includes all the listed tests. Automatic
analysis takes several seconds to several minutes, depending on the size and
complexity of the file, speed of your system, and the number and type of
analyses selected through this dialog box. Dynamic analysis, the last
selection in the dialog box, takes much longer than all other tests combined.
If you are following this exercise to familiarize yourself with the analyzer,
deselect Dynamic analysis.

NOTE. The MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer can conduct
three kinds of Dynamic analysis: T-STD (transport stream target decoder), LTW
(legal time window), and Smoothing Buffer. Automatic analysis includes only
T-STD analysis; the remaining dynamic analyses must be performed manually.
Refer to the Reference section of this manual for more information about
Dynamic analysis.

3. Select OK to confirm the selections and close the dialog box.

4. Select Automatic from the Analysis menu.
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5. Click OK in the Transport Stream Property window to accept the calculated
multiplex rate and continue.

The Automatic analysis for Sample.trp window appears momentarily before
being covered by the Message for Sample.trp window. The Automatic
analysis for window lists the progress of each test. As the analysis proceeds,
cells in the Status column change from blank to Running to Completed. As
each test is completed, either OK or Errors (in red) appears in the corre-
sponding Result cell. To view the Automatic analysis for... window during
analysis, drag the Message for... window to a corner of the application
window.

& Automatic analysis for Default_trp - Standard: ISDB-5 7ARIB

Status Result
Syntactic Completed Errors
Congistency Completed 0K
PSISI{PSIPISDB rate | Completed OK
PCR Completed OK
PTSIDTS Completed 0K
Semantic Completed 0K
Dynamic Running...

| Cancel all the analyses |

NOTE. To end the Automatic analysis at any time, click Cancel all the Analyses
in the bottom-right corner of the Automatic analysis for... window. To abort the
current “Running” analysis, click skip current task.
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2-42

During the analysis, the Message for... window opens to display progress and
keep a record of errors, warnings, and information specific to each test. To
fully expand the data in the Message for... window, select the window and
type * on the numeric keypad. To learn more about the Message for...

window and error reporting, refer to page 3-72.

&% Message for Sample. trp - Standard: MPEG-2

- @ MNotes
Eﬁ Automatic Analysis (+357)
E% 2/8/99 2:33:52 PM = Cornplete™ (+357)
55 syntactic Analysis “Complete™ (1)
il PES (+9)
EE packet start code prefic (+1)
O prp PID#5D (+1)

-8 Errar, must be 0x000001. (+1)
]

e Packet#21 (1)
H- B stream iﬁu

il PES header data length (+13
L 0070 (+1)

l tdarker bit (+3)

| marker kit (+1)

£
g
E_
L
H

- Stuffing Bytes (+1)
]gf: Consistency Analysis *Complate™ (+2)
]@1:; FSI/S] rate analysis =“Complete™
]ﬁ FCR Analysis =Complete™

H- i P75 analysis =*Complete™

- Semantic Analkysis *Complete® (+2)

H-] TETD Analysis *“Complata™ (+344)

6. Double-click on a listed PCR, PTS/DTS, or semantic error to view addition-
al details about an error. Double-clicking a listed syntax error, for example,
opens an interpreted view of the item that contains the error. Red characters

indicate syntax errors.
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Sample_trp -> PES PID 50 - Standard: MPEG-2 M=) B3
Bom 21 - Positicm : 1667000 - Time : 1333600 5 ﬁ’
packet stat stream id | | PES packet

code prefi Lemgzth,

[0 [ o ][ senss ]

10 PES PES | [dun adigrmene | [copyrighe| [evigtater || PTs DTS | [ESCR M| [ESnreteg [ Dommet || addiviona | [pEs e
soRmhlitg PrioTity Indicator copr flagzs mode flag copry o flas lag.
conrol

el = Qe e Qe JL v JLe JLe Jle J v J[ 3 [ o ]

010 | [ [eTe] | [Resered | [ ESER B0R | [tridemods | [Geldid | [ itrastice | [ fequency | [ addttionad | [ Stufire ||| PESpacket

‘ ‘ uTme comtral refresh st ion c@ﬁmm Btes daty brrte
[ 12 ||pszaeroa]| 3 |leossszenss]| we | 0 [ o | o || 3 || ux [ e || smm |

| H oz

7. Use the following techniques to learn more from an interpreted view:
m  Each block in the interpreted view represents a field of data. The field value

(or number of bytes in a data field) appears below the field name.

Press the F2 key to toggle the value between decimal base and hexadecimal

base.

idi : 1 1di : 1
copry vt copry vt

LLW Or >
B Double-click on a field name for more information about the field.

ﬂ frequency Shaffng PES packet

frach tnmcation Erytes datatryte

Zl additional copy info

This 7 bit field contains data
relating to copyright information.

B Double-click on a data field name to add a hexadecimal view of the

interpreted view.
‘ ook 1R ||c0wlmmgH e |r=m
[ 0 Qe [« Packet PES Item 21

| BF O3 40 00 DA F8& A9 AC Az C1 9C OO 6%
(T sz | = 03 EO 39 795 D% 23 14 41 FO 90 61 F5 1t

v A1 7D AO 1E DC B2 EA 28 BF CE 8A 13 CE
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m  Double-click on the field value/size to reveal additional information about
the value and any errors.

PES packet
datalbryte

[ |I% 55691 |
Number of stuffing bytes. Error,
all bytes mustbe 1111 11171

LIEEE] [
i
4

8. Return to step 6 and and explore some of the other error messages. The type
of display and information available is the same as when the individual
analysis is conducted manually (by selecting it from the Analysis menu).
Refer to the Reference section for more information about each type of
analysis.

Quitting the Analyzer

This completes the tutorial for the MPEG-2 DVB/ATSC/ISDB-S/ARIB System
Analyzer. Select Exit from the File menu to quit the application.
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MPEG-2 DVBJATSC/ISDB-S/ARIB System Analyzer

The MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer allows you to
analyze MPEG-2 DVB, ATSC and ISDB-S/ARIB binary streams at the
following levels:

B Transport stream (TS)
m  Packetized Elementary Stream (PES)

m  PSI (MPEG Program Specific Information), SI (DVB Service Information),
and PSIP (ATSC Program and System Information Protocol) tables

m ISDB

The analyzer can perform three basic levels of analyses: Syntactic (structural),
Semantic (coherence between all components of the multiplex), and Timing
(PCR and PTS/DTS clock).

The analyzer demultiplexing function allows you to select and save transport and
PES packets and PSI, SI, and PSIP tables. The analyzer is not designed to
analyze the audio, video, or data contents of elementary streams, although you
can extract and save these component to separate files for use in other applica-
tions. If the audio and video analyzer options are installed, you can begin an
analysis of these elements with a right mouse click.

Overview

The major functions of the Analyzer application are analysis, filtering, and
information extraction (saving streams and stream components).

Analysis  The application can analyze the following aspects of the MPEG transport stream
and its embedded objects:

®m  Multiplex characteristic

®m  Cyclic redundancy code (CRC)
B Syntax or structure

m  Consistency

m  PSI/SI/PSIP/ISDB rate

B Program clock reference (PCR)

B Presentation and decoding time stamp (PTS/DTS)
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Filtering

Saving Streams and
Stream Components

3-2

B Semantics, or coherence among multiplexed components
®  Mega-frame (MIP) coherence
B Dynamic T-STD, LTW, and smoothing buffer usage

®m  Entitlement management message (EMM) selection and diffusion (Option
CA required)

For one-step analysis of most aspects of all levels of the MPEG data stream, you
can also perform an Automatic analysis.

The MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer filters enable finding
and viewing transport stream packets, PES packets, and PSI/SI/PSIP table
sections that meet up to four criteria of your choosing. You can search for rare,
significant, or troublesome stream items on the basis of these characteristics:

®m  Program ID (PID)
B The presence and value of of up to three selected packet or section fields
B A sequence of up to four bytes

B The presence of the start of an elementary stream access unit

The analyzer gives you the ability to extract information from the binary stream
and save it to a file for later use or analysis. This information includes the
following:

B Transport packets

m  PES packets

m  PSI, SI, PSIP, and ISDB-S/ARIB tables
B Elementary streams

To save elementary stream data, double-click on the stream icon in the PSI
hierarchic view. A Save as dialog box appears with the file type set to match the
type of stream. Select the appropriate drive and directory, enter a file name, and
click OK.

NOTE. You can also display video and audio elementary streams using the
optional Video and Audio Stream Analyzers (if installed on your system).
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The Application Window

Menu bar —— ‘&=
Upper toolbar —— &2

Lower toolbar — = ¥

Status bar—> _

Menu Bar

MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer

All analyzer functions occur within the application window. The menu bar is
immediately below the window title and provides access to the various analyzer
commands. The upper toolbar, immediately below the menu bar, and the lower
toolbar, below the application workspace, provide direct access to commonly
used menu commands. The status bar, on the bottom of the window, displays
information about the various menu commands and command buttons.

The Menu bar provides access to the main analyzer menus.

File Menu. The File menu controls the analyzer-disk interface. The commands in
this menu operate as in all Windows applications. See Opening a File

(page 3-14) and Extracting and Saving Stream Elements (page 3-65) for more
information on opening various MTS300 file types and saving transport stream
data to files.

w
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Open... Ctrl+0
Saveas..

Erint...
Frinter setup...

Exit

Table 3-1: File menu commands

Use To

Open Open an existing transport stream, packet, or PSI/SI/PSIP/ISDB file
Save as Save the current selection to disk

Print Print the current view

Printer setup Change printer settings

Exit Quit the Analyzer application

Edit Menu. Use the Edit menu to navigate among sections of a stream or objects
embedded in a stream. These commands duplicate the actions of the command
buttons on the lower toolbar.

Mext Ctrl+M
Erevious Ctrl+B
Eirst
Last

Goto..
Mumber of items
Mext errar

The buttons are shown below, from left to right: First, Previous, Go to, Next,
Last, Number of items, and Next error.

W 2 bk

Table 3-2: Edit menu commands

Use To

Next Go to the next item (PAT, transport packet, PES packet, table
section...)

Previous Go back to the previous item

First Go to the first item
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Table 3-2: Edit menu commands (Cont.)

Use To
Last Go to the last item
Go to Go to a selected item

Number of items

Count and display the number of items

Next error

Locate and display the next item that has at least one syntax error

Selection Menu. The Selection menu provides access to several different views of
stream data on several different levels.

Selection
ESl hierarchic
Sl hierarchic

Multiplex
Transport packet
FES packet
Elerertary stream
Folisl

FEilters

Selection

ESl hierarchic

Multiplex
Transport packet
FES packet
Elerertary stream
Fsl

Filters 4

Table 3-3: Selection menu commands

Use

To

PSI hierarchic

Create a new hierarchic view of the transport stream represented by
the selected window.

Sl hierarchic

Display an Sl (DVB) hierarchic view of the transport stream; this
command is present only when DVB s selected in the Options menu.

PSIP hierarchic

Display a PSIP (ATSC) hierarchic view of the transport stream.

Multiplex

Display an interpreted view of the transport packets (all PIDs). This
command is equivalent to double-clicking on the TS (engine and
tender) icon and is not available when a hierarchic view is selected.

Transport packet

Display an interpreted view of the transport packets of a specified PID.

PES packet

Display an interpreted view of the PES packets encoded in the
transport packets of a specified PID.

Elementary stream

Extract an elementary stream and save it to a file.

PSI/SI or PSI Display an interpreted view of the specified PSI/SI sections; Sl only
present when DVB is selected in the Options menu.

PSI/PSIP Display an interpreted view of the specified PSI/PSIP sections.

PSI/SIISDB Display an interpreted view of the specified PSI/SI/ISDB sections.

Filters Open the Filters submenu.
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Filters Submenu. The Filters submenu enables extraction of transport stream
components or objects that meet user-specified criteria. Refer to Filters,
beginning on page 3-56, for a complete explanation.

Mew...

Open...
Edit..
Sawve..

Appk..

Table 3-4: Filters submenu commands

Use To

New Create a new filter

Open Open an existing filter (*.flt) file

Edit Modify a filter

Save Save a filter to disk (*.flt) file

Apply Apply a filter to the stream represented by the selected hierarchic view

Analysis Menu. Use the Analysis menu commands to analyze stream contents and
characteristics either automatically (selected analyses one after another) or
manually (one analysis at a time).

tdultiplex Characteristics  * bdultiplex Characteristics

bultiples Characteristics  #
Check CRC Check CRC
Syntactic Syntactic Check CRC
Consistency Check Congistency Check E‘,‘ﬂtaﬂliﬂ
FSl{5| Rate PSI{FSIP Rate Consistency Check
PCR PCE
s i PS1/51/1SDB Riate
Semantic Semantic F'EE
tega-frame (MIF) Dynamic k PTS/DTA
Dynamic » e Semantic
Autamatic EMiM 5 Dinamic 3
Ehitd 4 .
= Atonnatic:
Ebdid »
DVB mode ATSC mode

ISDB-S/ARIB mode
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Table 3-5: Analysis menu commands

Use To

Multiplex Open the Multiplex Characteristics submenu

Characteristics

Check CRC Check CRCs of the various tables in the selected PSI hierarchy
(Check CRC begins on page 3-31)

Syntactic Check the stream for syntax errors

(Syntax Analysis begins on page 3-33)

Consistency Check

Check for consistency within the stream
(Consistency Check begins on page 3-34)

PSI/SI, PS/PSIP, or
PSI/SI/ISDB Rate

Analyze the rates of the various PSI/SI/PSIP tables within the stream
(PSI/SI/ISDB-S/PSIP Rate Analysis begins on page 3-37)

PCR

Check the program clock references in the stream
(PCR Analysis begins on page 3-38)

PTS/DTS Check the time stamps in a selected elementary stream
(PTS/DTS Analysis begins on page 3-41)
Semantic Check all transport packets for semantic errors

(Semantic Analysis begins on page 3-45)

Mega-frame (MIP)

Check the fields and syntax and semantic control of the selected
mega-frame initialization packets of the DVB stream

Dynamic Open the Dynamic (analysis) submenu
Automatic Perform an automatic sequence of analyses

(Automatic Analysis begins on page 3-54)
EMM Open the EMM submenu

Multiplex Characteristics Submenu. The Multiplex Characteristics submenu
provides access to multiplex-related information.

Multiplex Characterstics

Bata . Ctrl+F
Multiplex Allocation
PID kap
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3-8

Table 3-6: Multiplex Characteristics submenu commands

Use To

Rate Display the overall multiplex rate as calculated from the first ten PCRs
and, if the calculated rate is incorrect, enter the correct value
(Multiplex Rate begins on page 3-29)

Multiplex Allocation Display a pie chart of PID allocation in the stream
(Allocation begins on page 3-30)

PID Map Display the sequence of PIDs in the transport stream
(PID Map begins on page 3-31)

Dynamic Submenu. The Dynamic analysis submenu contains selections for
dynamic analysis of the MPEG bit stream.

DOrymarnic I-5TDO
LT
Smaoathing Buffer

Table 3-7: Dynamic submenu commands

Use To

T-STD Conduct a transport stream system target decoder simulation
(T-STD Analysis begins on page 3-48)

LTW Check the effect of LTW (legal time window) offset and piecewise rate
field values (LTW Analysis begins on page 3-52)

Smoothing Buffer Conduct a smoothing buffer simulation
(Smoothing Buffer begins on page 3-54)

EMM Submenu. Use this menu to specify EMM analysis parameters used during
processing.

Etid selection
Diffusion rate

Diffusion holes
Discontinuity

Table 3-8: EMM submenu commands

Use To
EMM selection Specify EMM types and transport packet portion
Diffusion rate Specify EMM PID number
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Table 3-8: EMM submenu commands (Cont.)

Use To
Diffusion holes Specify EMM PID number and hole length
Discontinuity Specify EMM PID number and discontinuity type

PC2 dialog Menu. This menu sends Viaccess ECMs and EMMs to a PC2 card.
See page 3-77 for additional information. You must install Option CA (Condi-
tional Access) software to use this command.

EC? dialog

Table 3-9: PC2 dialog menu commands

Use To
PC2 dialog Send EMM or ECM selection to the PC2 card

Options Menu. Use the Options menu to set various analyzer options and to save
and restore program configurations. Refer to The Options Menu, on page 3-68,
for more information.

Diptions

HMPEG-2 Chrl+b4

DB Cul+l

ATSLCPSIP »
v |SDE-5/4RIB

GI-D Identifization
A3 [dentification in DWE Mode

v Yigual T-STD And LTw
Unzerambling
D utput Meszages In File

Base...

Font...

Directories...
Automatic Analysis...
Interpretation. .

S.ave Configuration...
B ead Configuration...
Set Default Comfiguration. ..
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Table 3-10: Options menu commands

Use To

MPEG-2 Specify MPEG-2 as the standard to open a new file

DVB Specify DVB as the standard to open a new file

ATSC PSIP Open the ATSC PSIP submenu

ISDB-S/ARIB Specify ISDB-S/ARIB as the standard to open a file

Visual TSTD and LTW | Switch the graphic view of TSTD and LTW dynamic analysis on/off

Unscrambling Switch the Unscrambling option on/off

Output messages in file | Switch the output message option on/off

Base Specify the numeric base (decimal or hexadecimal) used in the
interpreted and hierarchic views

Font Specify the text font (typeface and size) used in analyzer views

Directories Configure default directories

Automatic Analysis Configure automatic analysis (specify the analyses to perform)

Interpretation Configure the interpreted view

Save configuration Save the current user configuration to a file

Read configuration Read and apply a previously saved user configuration

Set default Reset all options to the default settings

configuration

ATSC PSIP Submenu. Use this menu to specify ATSC PSIP Standards options.

ATSCFSIP Terrestrial Cirl+T
Cahkle Chrl+C

Table 3-11: ATSC PSIP submenu commands

Use To
Terrestrial Specify ATSC PSIP Terrestrial as the standard to open a new file
Cable Specify ATSC PSIP Cable as the standard to open a new file
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Window menu. Use the Window menu to manage the various analyzer windows.

Cascade

Til=

Arrange [cons
Close wview
Close all
Add wiew

« 1 HierarchicView of S&MPLE TRFE
2 TS5 - SAMFLE. TRP

Command operation is identical to all other Windows applications, with the

exception of Add view. Use Add view to create a new window that displays
current window data in a different format. A small submenu, like those shown
below, appears when you select Add view.

—Wiew Type— —Wiew Type— —Wiew Type— —Wiew Type—
FSl Transport packet FCR Graphic FTS/DTS Graphic
Hexadecimal Hexadecimal PR Yalues FTS/DTE Walues

Binary

Binary

Table 3-12: Add view menu commands

Use

To

(the first choice)

Create a duplicate of the selected view

Hexadecimal

Create a byte-by-byte, hexadecimal view of the data

Binary

Create a bit-by-bit, binary view of the data

(PCR or PTS/DTS)
Values

stamp

Create a view that lists numeric values related to the clock or time

Help Menu. The Help menu provides standard Windows and application-specific

information.

Contents
U zing Help

About MPEGZ DVE A ATSC /1SDB-5ARI1B System Analyzer

MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer



MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer

3-12

Upper Toolbar

Table 3-13: Help menu commands

Use To

Contents Open a Help window and display the table of contents

Using help Provides general information on how to use the Help system
About... Display the application version and copyright

The following table lists the command buttons found on the upper toolbar. Click
the appropriate button to select one of these functions:

Table 3-14: Upper toolbar commands

Icon Name Function
pE Open Open an existing stream. Equivalent to the
= Open command in the File menu.
Save as Save streams and stream elements. Equivalent

to the Save As command in the File menu.

o | o | [P

PSI Hierarchy

Display the hierarchic structure of the current
PSI. Equivalent to the PSI hierarchic command
of the Selection menu.

m

View

Create a new window similar to the current
window. Selecting this icon opens a submenu
that offers a choice of window display modes.
This selection is similar but not equivalent to
the Add view command in the Window menu.

MPEG-2 | OB |

ATSC PSIP Terrestrial |
ATSCPSIP Cable |
[SDE-S/ARIB |

Standard to open new
file

Specify the standard to open a new file:
MPEG-2, DVB, ATSC PSIP Terrestrial,
ATSC PSIP Cable. Selections identical to
those found in the Options menu.
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Lower Toolbar  The commands from the lower toolbar are only available if the selected
document window contains specific items (stream packets, transport tables,
elementary stream packets, PES, or PSI, SI DVB ATSC PSIP and ISDB-S/ARIB
table sections). When the document window does not contain any of these items,
the command buttons are not available. Click the appropriate command button to
implement one of the functions described in table 3-15.

Table 3-15: Lower toolbar commands

Icon Name Function

ﬁl Start Accesses the first item. Equivalent to the First command in the Edit
menu

il Previous Selects previous item. Equivalent to the Previous command in the Edit
menu

ﬂ Go To Goes directly to an item. Equivalent to the Go to command in the Edit

* menu

LI Next Selects the next item. Equivalent to the Next command in the Edit
menu

ﬂl End Goes to the last item. Equivalent to the Last command in the Edit
menu

ol Number Displays the number of items. Equivalent to the Number of items
command in the Edit menu

’Q Error Finds and displays the next item that contains at least one syntax error.

2 Equivalent to the Next Error command in the Edit menu

Status Bar  The left side of the Status Bar displays a brief explanation of a menu entry when
you position the cursor over a menu selection in the Menu bar. The right side of
the Status Bar displays the selected standard (MPEG-2, DVB, ATSC,
ISDB-S/ARIB) for the current active window.

W4 2 ¥

Dizplay information about MPEGZ DVE / ATSC / ISDB-S/ARIB Spstem Analyzer

The Escape Key

You can terminate most activities performed by the analyzer with the Escape key,
which is located in the upper left-hand corner of the keyboard. When you press
this key, the current activity will terminate as soon as possible and the analyzer
will display the available results. Use this feature to terminate an analysis in the
hierarchic view or a Go to search in the interpreted view that becomes too
lengthy.
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If the requested activity can be terminated, a message similar to one shown
below appears when you initiate the activity. Select the active window and press
the Esc key to terminate the activity.

Perform a syntactic
anz{}}ysis
Press Escape to abort

Opening a File

The MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer can open MPEG-2
transport stream files (*.trp, *.bin, or *.ts file extensions), PES packet files
(*.pes extension), and section files (*.si extension).

B
To open a file, select Open from the File menu, click thea command button
in the upper toolbar, or type CTRL+0O.

Open [ 2] x]
Look in: |@Efg-trp j gl IE_ =

) D efault brp
Sample.trp

Files of e [Stieam [ TRP:BIN2 TS) =l Cancel |

rao peh as read-only

In the Open dialog box, do the following:

1. Select the appropriate drive, directory, and file type. Sample files are in the
c\MTS300\Cfg-trp directory.

2. Select the file to open from the files list.
3. Double-click on the file name, click the OK button, or press ENTER.

When you open a transport stream file, a hierarchic view appears in the
application window. If you open a transport packet, PES, or section file, an
interpreted view appears.
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The Hierarchic View

Table 3-16: File type definitions

File type Definition

Stream Transport stream file consisting of a packet of 188 bytes
beginning with 0x47. The analyzer performs an automatic

Transport Packet synchronization on the first three valid packets.

PES Packet PES packet file consisting of packets beginning with 0x000001

start code. The analyzer performs an automatic synchroniza-
tion on the first valid start code.

PSI/SI/PSIP/ISDB-S/ARIB Section file beginning with a table as the first byte.
Section

When you open a multiplex file in the application window, a hierarchic view
appears. The hierarchic view uses icons to show the interrelationship of stream
components and is the starting point for many types of analyses. With the
hierarchic view, you can contextually select, display, and analyze specific
portions of the transport stream. Some items (and their icons) apply only to
DVB, ATSC, or ISDB-/ARIB streams and appear only when DVB, ATSC, or
ISDB-/ARIB options are selected from the Options menu

Icon menus. Each icon type in the hierarchic view has a context-specific shortcut
menu. These menus allow quick access to the functions specifically available for
the chosen element. To display a popup menu, click on the the icon with the
right mouse button. Hold the button down, highlight the desired command, and
release the button to select the command. You can select the first command on a
menu by double-clicking on the icon.

Some example menus are shown below. Menu entries vary by icon type and the
standard selected in the Options menu (MPEG-2, DVB, ATSC PSIP).
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3-16

PSI Hierarchic View

s E
Transport Packets Section P!ES Packets

PID hap Check CRC FTS/DTS
Fultiplex Allocatian PCR Analysis
PSSl rate T-5TD Analysis
ranspont Packeis |

ransport Packets Section Save
PCR Analysis Check CRC Audia Stream Analyzer

Double-click for an interpreted view. You can double-click on a table icon to
display an interpreted view of the table section. For additional information on the
interpreted view, refer to The Interpreted View on beginning on page 3-23.

Scrambling Information. If a portion of the stream is scrambled, the base icon
incorporates the lock symbol.

Transport stream and packetized elementary stream scrambling is identified at
the following levels:

oy
'
[ ]

Lid

s

The figure below shows the PSI hierarchic view of a simple MPEG-2 transport
stream.

When you open a stream, a consistency analysis is performed on the first 3,000
valid transport packets of the file and the results displayed.
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Hierarchic View of Sample_trp - Standard: MPEG-2

o —— r

iI I 4

D 51 DES

B 4

The analyzer can generate a hierarchic view only if the stream contains a PAT
(program allocation table, PID 0) or PMT (program map table).

The hierarchic view that appears when you first open a file is based on the first
versions of the PAT and PMT tables found in the stream. Use the Next command
in the Edit menu, or click on the Next command button (in the lower toolbar), to
go to the next PSI version, if any, in the stream.

Stream Elements and Icons. Hierarchic view icons represent the various elements
that make up or are embedded in the transport stream.

Table 3-17: Icons used in the PSI hierarchic view

Icon

Element type

Multiplex transport packets. This icon represents all (188/204/208-byte) transport
packets that make up the stream.

Transport packets of a particular PID (Program ID). Other elements (tables,
clocks, PES packets) are the payload contained within transport packets or are
constructed from the payload of several transport packets that have the same
PID. The PID number appears under the icon.

Transport Packets that contain independent PCR clocks. The PID appears under
the icon.

PAT (Program Association Table) sections. Always contained in PID 0 transport
packets.

CAT (Conditional Access Table). The CAT table allows you to associate one or
more conditional access systems with the transport stream.
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Table 3-17: Icons used in the PSI hierarchic view (Cont.)

Icon

Element type

=

PMT

PMT (Program Map Table) sections.

HII

NIT (Network Information Table). Provides access to MPEG-2 PSI, DVB SI, ATSC
PSIP, and ISDB-S/ARIB program and service information tables through the
PSI/SI/PSIP commands in from Selection menu. Also used for Private Data
sections.

L
E:

PES (Packetized Elementary Stream). This icon represents all packets that,
together, contain a given elementary stream. Individual PES packets are
assembled from the payloads of several transport packets.

=}

VIDEQ

MPEG video elementary stream.

Digicipher Il video elementary stream.

MPEG audio elementary stream.

Dolby Digital (AC-3) audio elementary stream. (DVB and ATSC modes only)

AAC (Advanced Audio Coding) audio elementary stream.

Luy(ufu) ]
LU [n]
1110001

DAL

DATA (data elementary stream).

MIP

-

MIP (mega-frame initialization packet). Special DVB-T transport packets in PID 21
(0x15).

040010
100110
110001

DEM CCD

DSM CC (Digital Storage Media Command and Control).

1

=
=
=

ECM (entitlement control message) sections.

'F"’
Fa
L] K.l

=
~

2

EMM (entitlement management message) sections.

3-18
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Sl (DVB) Hierarchic View

MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer

Table 3-18: Special hierarchic view symbols

Symbol Significance
? The question mark is added to a TS icon when the transport packets have
| undefined PIDs and are not referenced by any PSI table. (This is permissible in
MPEG-2, but may indicate a PSI configuration problem).
— The lock symbol, superimposed on an icon, indicates that part of the stream is
4k scrambled. Scrambling on the transport stream level is indicated by a lock on the
TS (rail car) icon and the following PES and ES icons; scrambling on the PES
alm level is indicated by a lock only on the PES and ES icons.
[
A red square (border) surrounding a base icon after a Consistency analysis
indicates that the data type, declared in a PSI table, is not valid.

A red X over a base icon as a result of Consistency analysis indicates that a
specific PID, declared in a PSI table, cannot be found in the transport stream.

If the open transport stream file contains DVB SI tables, you can use the SI
hierarchic command in the Selection menu to display an SI hierarchic view.

DVB_SAMP.TRP -> DVB b =] 3
e =
i -2 o -
H2 Tel CIMEDL 51 Ell
=L —E
S1 E2l
§ Eit
51
m
g1
g Eit =
2l - Mo

Stream Elements and Icons. The SI hierarchic view uses the icons described in
the table below.

Table 3-19: Icons used in the Sl hierarchic view

Icon Element type
_ Nit (Network information table) sections.
Nit
Sdt (Service description table) sections.
Sdt
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Table 3-19: Icons used in the Sl hierarchic view (Cont.)

Icon Element type

S (Service information) sections.

Eit (Event information table) sections.

Bat (Bouquet association table) sections.

Transport stream referenced in NIT and BAT tables.

s

Event referenced in an EIT table.

Ll EH H B~

TV service referenced in a SDT table.

Radio service referenced in a SDT table.

Txt Teletext service referenced in a SDT table.

NOTE. Use the Next command in the Edit menu, or click on the Next command
button (in the lower toolbar), to go to the next SI version, if any, in the stream.

The PSIP (ATSC)  If the open transport stream file contains ATSC PSIP tables, you can use the
Hierarchic View  PSIP hierarchic command in the Selection menu to display a PSIP hierarchic
view.
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newhtsc. TRP > ATSC - Standard: ATSC PSIP Tenes... [H[=] E3
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00001
i o

Ts 1 Ts 1 TWTest

Tnitial wersion
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Stream Elements and Icons. The PSIP hierarchic view uses the icons described in
Table 3-20.

Table 3-20: Icons used in the PSIP hierarchic view

Icon Element type
w Mgt (Master guide table) sections.
TVect sections.
T¥ct
CVct (Cable virtual channel table) sections.
Cvct

Eit (Event information table) sections.

Ett (Extended text table) sections.
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Table 3-20:

Icons used in the PSIP hierarchic view (Cont.)

Icon

Element type

Transport stream referenced in TVCT and CVCT tables.

Event referenced in EIT and or ETT tables.

(=

1101

=

Digital TV virtual channels referenced in VCT tables

[=]

Analog TV virtual channels referenced in VCT tables.

Radio virtual channels referenced in VCT tables.

Rrt (Rating Region Table) sections.

Stt (System time table) Sections.

Data virtual channels referenced in the VCT table.

Virtual channels referenced in VCT tables but of unknown type or an unreferenced
channel.

NOTE. Use

the Next command in the Edit menu, or click on the Next command

button in the lower toolbar, to go to the next PSIP version, if any.

3-22
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The Interpreted View

The interpreted view provides access to the various fields and syntax and
semantic control functions within the transport stream.

To create the interpreted view, double-click on one of the multiplex element

icons in the hierarchical view, such as a transport packet, packetized elementary
stream, mega-frame initialization packet, or table section. If errors are detected in
the interpreted view, erroneous fields (and their values) appear in red.

The interpreted view of a transport stream packet is shown below.

TS - SAMPLE.TRP M=l B3
I—— A
o
cyme byt | [troepoct amor| | payloadunit tremeport. trmeport. adaptation | | contioity
indicater | | start indicator | | prioiby sombling | | fisld cortrol | | comar
control
L JC o v o J[e ] J v ][
Payload
184
.
K| H o

Item Information  The currently interpreted packet or section is called an “item.” Information about
the items relationship to other items and position in the transport stream appears
near the top of the interpreted view window.

TS - SAMPLE.TRP H[=] 3
Tem 2 F9300 - Posttior : 188 - Tame < 0000150 5 jl

b

Type ltem number Position Time

Item information includes the following:

®m  The item number is the position of the current item relative to all such items
in the transport stream. The total number of items (9300 in the example) is
displayed if you used a command button (in the lower toolbar) to go to the
last item or to count the items in the stream. You can also use command
buttons to move back and forth among the items and to search for an item
with a syntax error. Refer to The Lower Toolbar, on page 3-13, for more
information.
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Fields

3-24

B The position is that of the first byte in the item relative to the beginning of
the transport stream. The example item is the second 188-byte packet in the
stream; it begins with byte 188.

B The time is relative to the beginning of the stream and is displayed after a
multiplex rate calculation. Perform a multiplex rate calculation by selecting
it from the Multiplex characteristics submenu of the Analysis menu or by
typing CTRL+R. The analyzer also performs the calculation as part of
several other analyses, including PCR, PSI/SI rate, PTS/DTS, and Dynamic.

The interpreted view shows the fields of information and data that make up the
section or packet. Each field is represented by a name box and a value rectangle
below it. Fields vary in length from one bit to many bytes. The width of each
box/rectangle does not indicate the length of the field. You can configure the
interpreted view, through the Interpretation command on the Options menu (see
page 3-26), to show the length or position (in bits) of each information field.
The length or position is indicated below the value rectangles.

TS - SAMPLE_ TRP TS - SAMPLE_ TRP
Rem 179300 - Posti Rem 179300 - Posti
cyne brgte | [ameport smor | | payloadunit tranepeot. ‘ cyne brgte | [ameport smor | | payloadunit tranepeot. ‘
[ I = JC v 1o J[=] [ I = JC v 1o J[=]
1 1- ] 13—+ +— +—1=8 +—N +—10 +—11
Puyload Puyload
184 184
K| K|

The length of data fields, such as the Payload in the above windows,is always
shown (in decimal number of bytes) in the value rectangle. Value rectangles of
information fields contain the value of the field. To switch information field
values (but not data field lengths) between decimal and hexadecimal base, press
the F2 key.

i N

EmfEL

Double-click on the name box for an explanation of a field.
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Brem 2 £ 9300 - Position : 188 b - Time : 0000150 ¢ ﬂ
parload mit trmeport. trmsport. adaptation conitirnity
start dicator priority soambling field cordrol CONTtEr
cordrol
sync byte = | o [+ ][ o

The sync_byte is a fixed 8 bit
field whose value is '0100
01171" (0x47).

[

KN 2

Double-click on the value rectangle for additional information about the value.

[y | —— T | r— 3 ey || e | ———
ndicaror start udicaror oty soambling e 1d covarel COMMIET
corarsl
IET | I | T [ o M o+ [ o
May be assigned as
R network_PID,
program_map_FPID,
L elementary_PID, or for other
puUrposes.

Double-click on a data field name to add a byte-by-byte hexadecimal view of the
interpreted section, table, or packet.

B SAMPLE TRFP -> PES PID 50:2

Packet PES Item 5 / 21

00 00 01 E@ C3 4B 20 CO ©A 371 0O 03 ES AT
F4 S0 DD 8D 06 50 01 BS DB BE 20 50 A1 EB
8C 9E 76 03 52 CO 6B A1 40 O3 AR 28 AF EB

You can also display a hexadecimal view or binary view of any section or packet
by selecting the Add view command from the Window menu or by clicking on
the Add view command button in the upper toolbar.

Double-click on the descriptor field name in an SI table (NIT, SDT, EIT, or BAT)
section for an ASCII decode of the descriptor information.

MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer 3-25



MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer

Interpreted View Options

3-26

transport original Tesermed
stream id retmrork id | | fishre use

EN | IR | T | oo [

trmspart original Tesermed tmmepont Cable deli\fery
Fmemid | | el | | Somuse || e descriptor tag 68
s L= L= = ]| descriptor length 1
frequency (MHz) 2000.0000
trasport || origiml || meseaved || trnsport DVR reserved 4095
Fmemid | | el | | Somuse || e FEG outer 2 (RS2
C e [ s [ v J[ = |[ modulation 2 (32 (jll
AN

4
[trwepert |[ erigmar || reseved || trmepent | [T

You can customize the appearance of the interpreted view through the Interpreta-
tion command on the Options menu. The Interpreted view options dialog box,
with default selections, is shown below.

The Length and Position settings, explained on page 3-24, apply to all inter-
preted views. You can use the remaining controls to determine which fields
appear in transport packet, PES packet, or (table) section interpreted views.

Interpreted view option
— Type

 PES packet Section ™ Length I Paosition

List Dizplay
0- Sync byte - 0- Sync byte -
1- Transport Eror Indicatar 1- Transport Eror Indicatar
2- Payload unik start indic ator 2- Payload unik start indic ator
3- Tranzport priority 3- Tranzport priority
4-PID 4-PID
5- Tranzport scrambling control 5- Trangport zcrambling control
E- Adaptation Field Comtral E- Adaptation Field Comtral
F- Cantinuity Caunter F- Cantinuity Caunter
9- Adaptation Field length 9- Adaptation Field length
9- Dizconbinuiby indicatar 9- Dizconbinuiby indicatar
10- Random access indicator 10- Random access indicator
11- Elementary stream priority indic. 11- Elementary stream priority indic.
12- PCR flag 12- PCR flag
13- OPCR flag 13- OPCR flag
14- Splicing point flag 14- Splicing point flag
18- Transport private data flag 18- Transport private data flag
16- Adaptation field extension flag 16- Adaptation field extension flag ;I
17- PCR base i

¥ &l W Reserved field

ok | | awar | | Deeear | Cancel

To configure the options, do the following:

1. Click the option button in the Type field to select the type of interpreted
view you want to change.

2. The default display is All fields, including the Reserved field. To hide a
field, select it in the Display list box and click the << button.
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3. To show just a few fields, click Delete all; this clears the display box, All
check box, and ‘Reserved’ field check box. Then select a field name from
the List dialog box and click the >> button. Repeat this until all the fields
you want to display are listed in the Display box. If you also want to display
the Reserved field, select that check box. Click OK. The changes take effect
immediately.

4. If you made changes to the displayed fields, ***Warning, display option***
appears at the top of the interpreted view window.

TS - SAMPLE.TRP H[=] 3
Rem L F9300 - Positior 0h % * Waming, displuy option *** jl

[ o] [emesponc o] [ pwimndws || wwegore | [0 | [ tmmepen | [ aigtacion | [ smncienatr |

5. To restore the interpreted view to the original configuration, select Inter-
pretation from the Options menu, click the appropriate Type option button,
click either Add all or the All check box; then click OK.

Saving an Interpreted  You can store a transport stream or PSI, DVB SI, ATSC PSIP, or ISDB-S/ARIB
View table.

Hexadecimal and Binary Views

You can add a hexadecimal view of the current interpreted view item by
double-clicking on a payload or data bytes name box. However, some items such
as table sections do not have these fields. To create a hexadecimal or binary view
for any interpreted view item, either click on the Add view command button (in
the upper toolbar) or select the Add view command from the Window menu. A
submenu, appropriate to the current item, appears as shown:

I
m —iew Twpe—

Transport packet
Hexadecimal
Binary

Select the top submenu command (Transport packet in the example) to add a new
interpreted view; select Hexadecimal or Binary to view the bytes or bits that are
the basis for the interpreted view.

The Hexadecimal View  The hexadecimal view shows the contents of the current item on a byte-by-byte
basis. The first few bytes appear in blue characters on the display to indicate that
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they are required header information for the type of item. A transport packet has
four required bytes; a PES packet has six. The blue, required bytes may be
followed by several bytes shown in gray. The gray bytes are optional or variable
header information. The remaining bytes, displayed with black characters, are the
payload or data bytes.

When displaying a hexadecimal view of transport packets with a 204 byte length,
the last 16 bytes are shown in red.

The hexadecimal view window shows the number of the displayed item, just like
the interpreted view. When you use the command buttons to move among similar
items in the stream, the hexadecimal view changes to display the contents of the

current item.

TS - SAMPLE TRP:2

Transport Packet Item 3 / 9300 fi

47 40 32 30 07 90 00 00 00 BD FE 15 00 00 01 EO C3 4B 80 CO
0A 31 00 01 E8 87 11 00 01 CC 67 00 00 01 B3 2C 02 40 13 OE
AB 23 81 10 11 11 12 12 12 13 13 13 13 14 14 14 14 14 15 15
15 15 15 15 16 16 16 16 16 16 16 17 17 17 17 17 17 17 17 18
18 18 19 18 18 18 19 1A 1A 1A 1A 19 1B 1B 1B 1B 1B 1C 1C 1C
1C 1E 1E 1E 1F 1F 21 00 00 01 BS 14 82 00 01 00 GO 00 00 81
B8 00 08 00 0O 0O OO 01 OO 0O OB 30 C8 00 00 O©1 BS 8F FF F3
8C 00 00 00 ©1 ©1 ©A 8D F1 2A 1F 25 25 C8 DE 88 01 F8 9C 73
DF 27 94 BA 3A 1E AD E7 CO 72 60 00 C5 09 28 DE 84 C9 F1 8E
A4 38 DC 73 20 A3 2D BO

A H 4

The Binary View  The binary view displays the current item on a bit-by-bit basis. The same
character color conventions used in the hexadecimal view apply to the binary
view. The contents will also change when you use the command buttons to move
among items in the stream.

When displaying a binary view of transport packets with a 204 byte length, the
last 16 bytes are shown in red.

TS - SAMPLE TRP:3 I =] B3
Transport Packet Item 3 / 9300 =

01000111 # 01000000 # 00110010 # 00110000 # OOOOO111 #
10010000 # 0OOOCOOD # ODOOOOOOD # COOOOOOO # DOOO1101 #
11111110 # 00010101 # 00OOOCOD # COOOOOOO # DOOCODO1 #
11100000 # 11000011 # 01001011 # 10000000 # 11000000 #
00001010 # 00110001 # 0OCOOOOO # ODOOOOGOT # 11101000 H#
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Multiplex Analyses

The Multiplex Characteristics commands provide valuable information about the
way programs are multiplexed in the MPEG-2 transport stream. To access these
commands, select Multiplex Characteristics from the Analysis menu; then
select one of the following entries: Rate, Multiplex Allocation, PID Map.

Multiplex Rate  To calculate the multiplex rate of a transport stream, select the window that
contains the hierarchic view and then either select Rate from the Multiplex
Characteristics submenu or type CTRL+R. The Transport Stream Property
dialog box appears, displaying the multiplex (mux) rate and the number of
programs in the stream.

Transport Stream Property

Mus Rate [bits/z)

Murnber of pragranns 1
ok I Cancel

The analyzer calculates the multiplex rate from the first ten PCRs found in the
transport stream. Because the sample is small and the precision of the number is
high, there can be error in the calculation. To ensure maximum accuracy of
analyses that use the multiplex rate to calculate results and detect errors, you can
enter the actual multiplex rate (if you know it) in the dialog box.

For example, if the exact multiplex rate of a stream is 10 Mb/s instead of the
reported 9,999,999 bits/s, enter 10000000 in the Mux Rate text box before
clicking OK. This increases the accuracy of subsequent PCR, PTS/DTS, and
Dynamic analyses, which use the multiplex rate in their calculations.
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3-30

Allocation

Select Multiplex Allocation from the Multiplex Characteristics submenu to see
a pie chart of the transport stream. The chart shows the stream fraction occupied
by packets of each unique PID.

E
[ eIn o= 0.161 %16 129 bitas)

- PID 16 = 0.022 % (2150 bits/s)

[ PID 21=0.151 % (15055 bitsis)

[ eIn $3=0.011 % (1075 bitsiz)

- PID 50 = G1.344 (5134404 bitsls) - Prog 1EE 1

[ FID 51=0.506% (50557 bitsls) - Frog 1 ES 2

- PID #110 =0.011 % (1075 bitsds)

- PID #191 = 37.796 % (57 T9569 bitsis)

Prog 1 :B2.000 % B200000 bitss)
FAT : 0.161 % (16 129 bits's)
HIT 10022 % (2150 bit a'5)

4] | H o

The analyzer calculates the percentages shown in the graph key by dividing the
actual number of transport packets of a given PID by the total number of packets
in the transport stream file.

All PIDs found in the transport stream are represented; those that are not
referenced in a PAT or PMT will appear in the hierarchic view only after a
consistency check (described under Consistency Check on page 3-34).

PID 8191 is reserved for stuffing bytes; it is not shown in the hierarchic view.
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Check CRC

PID Map

To open a PID map of transport stream file, select the hierarchic view and then
select PID Map from the Multiplex Characteristics submenu. A window
containing a PID map of the first 100 packets appears in the application window.
Use either the Edit menu commands or the command buttons in the lower
toolbar to display the PID maps of the other 100-packet portions of the stream.

The PID map lists the PID of every transport packet in the stream. In the map,
each packet is represented by its PID, and each unique PID is color-coded
according to the type of element it identifies. For example, the PIDs of packets
that contain data for video elementary streams are displayed in light blue
characters.

B PID Map for SAMPLE TRP M= B
TS packets 1 to 100 - Colours according to PSI version number 1f1
PHT NIT

Uideo Audio Other

(0000001) 0021 0050 0050 0050 0050 0050
(00B0B11) 0056 0050 0050 0050 0050 0050

(0000621) 0050 0050 0050 0050 0050 0050

(0000631) 0050 0056 0050 0050 0050 0050

(0000641) 0050 BOSH 0050 0050 0050 0050 0050
(0000051) 0050 0050 0050 0050 0050 0050
(0000061) 0050 0050 0050 0050 0050 0050
(00000T1) 0050 0050 0050 0050 0050 0050
(0000081) 0050 0050 0050 0050 0050 0050

(0000091) 0050 0050 0050 0050 0050 0050

K| H A

Many MPEG-2 tables (such as the PAT, PMT, and SDT) have CRC (Cyclic
Redundancy Code) fields. CRC field values are calculated from table data during
encoding. The decoder performs an additional calculation based on the received
data and compares that result to the field value to verify correctness.

The analyzer automatically calculates and compares the CRC of the first PAT
section when opening a transport stream file. Use the following procedure to
check all CRC:s in a transport stream.

1. Select the stream PSI hierarchic view.
2. Select Check CRC from the Analysis menu.

3. During the analysis, the Message for... window opens to report errors,
warnings, and analysis-specific information. To expand the messages, select
the window and type * on the numeric keypad. To learn more about the
Message for... window, see page 3-72.
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4. If the message window identifies CRC errors, double-click on the associated
Packet message entry to open an interpreted view of the section containing

the error.

=-efm EAMTS1008Bad_crctrp (+106)
: @ Motes
Qpening messages (+27)
2By cRCAnalysis (+79)
E'Eb 1729793 1:44:57 Phi *Complate® (+79)
o 18 PaT 2
5 pp FID#0 (+27)
=8 Bad CRC (+27)
b %Packet #1, 82, #3, .. #2T (+27)

S. Erroneous field values are displayed in red characters. Double-click on the
bottom value rectangles to confirm the error.

‘' Bad_crctrp > PAT - Standard: MPEG-2

Progrm Aesocition Section, Bem 1 - Dosition : 945

table id | |sectiom rmda| | =0 | [mesaved Seckin weport | (mesawed | | wersdan et TSt section st section
mdicator langth stream id TPIRer mdicator T0ImhEr TP
Lo JL v JLe =l w M e = J o J[+ J[ o ][ o

progom | |Teserved | [progrmmap
roxmber U]

I

progom | |Teserved | [progrmmip
Tommher PIL-

: [ 7 ][ n

CEC
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Syntactic Analysis
Use the following procedure to perform a Syntactic analysis:

1. To analyze all elements in the transport stream file, select the hierarchic view
and select Syntactic in the Analysis menu. To analyze the syntax of a single
stream element, open an interpreted view of the element (double-click on the
icon in the hierarchic view) and select Syntactic from the Analysis menu.

2. During the analysis, the Message for... window opens to report errors,
warnings, and analysis-specific information. To expand the messages, select
the window and type * on the numeric keypad. To learn more about the
Message for... window, see page 3-72.

3. If the message window identifies Syntax errors, double-click on the
associated Packet message entry to open an interpreted view of the section
containing the error.

Eﬂ: CAMTS2004CFG- TR Sampletrp (+5)

------ MNotes
E| y Syntactic Analysis (+H)

o BBy 1/29/991:15:03 P Complate™ (+9)
5B FES[(+9)
[—j packet start code prefix(+1)
5} -Fip PID #50 (+1)
= @. Error, must be D=0000071. (+1)

il stream iﬁ%)

#l FES header data length (+1)
0010¢+1)

harker bit (+3)

marker bit(+1)

A Stuffing Bwtes (+1)

4. Erroneous field values are displayed in red characters. Double-click on the
bottom value rectangles to confirm the error.

SAMPLE. TRP - PES PID 50 =] 3
T 21 - Position ; 1667000 b -

pachet start | | streamid | | PES packet

code prefee Langth

DTS DT DM trick

mode fag

wwmfwﬂng

T il
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Consistency Check

The Consistency check verifies the consistency of several table and stream items
within the PSI (MPEG-2), SI (DVB), PSIP (ATSC) and ISDB-S/ARIB
hierarchic views.

NOTE. The analyzer performs a PSI consistency check on the first 3000 valid
transport packets when you first open a transport stream file. Errors can easily
occur in later packets; always conduct a manual consistency check to eliminate
the possibility of consistency errors in the rest of the transport stream.

PSI Coherence  The PSI consistency check reviews the following items:
®  Internal PSI table and PMT descriptor consistency
m  PSI table and transport stream coherency:
B Missing PAT and PMT PID references
B Conformance of stream-types to standards
m  Missing PCRs in PCR_PID referenced packets

B Location of nonreferenced PID transport packets

Sl Coherence  The SI consistency check reviews the following items:

B Required transport stream SI tables: NIT actual, SDT actual, EIT actual
(present/following), TDT

m Internal SI table coherence
m  PSI and SI table:
m  Coherence of transport_stream_id between SDT actual and PAT
m  Coherence of transport_stream_id between NIT actual and PAT
B Coherence of service_id between SDT actual and PMT program_number

Table 3-21 identifies the SI Consistency Check abbreviations used in the error
message window; n denotes an integer value.
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Table 3-21: Sl consistency error abbreviations

Abbreviation Meaning

Sn Section number n (software order)
Ln Loop number in section n

FDL First descriptor loop

Dn Descriptor number n in the loop
Nid n Network_id = n

Tid n Table_id =n

Tsid n Transport_stream_id =n

Sidn Service id =n

Onid n Original_network_id = n

Eid n Event_id =n

Bid n Bouquet_id=n

Pnn Program number n

Snn Section number n

Vnn Version number n

PSIP Coherence

The PSIP consistency check reviews the following items:

B Required transport stream PSIP tables: MGT, TVCT, CVCT, EIT, ETT,

RRT, STT

m Internal PSIP table coherence

m  PSI and PSIP table:

B Coherence of transport_stream_id between the TVCT,/CVCT and PAT

®  Coherence of program_number between the TVCT/CVCT and PAT

m  Coherence of channel definition service location descriptor (TVCT
terrestrial or CVCT cable) and elementary stream description of the
corresponding program in the PMT

Table 3-22: PSIP consistency error

abbreviations

Abbreviation

Meaning

Sn

Section number n (software order)

Ln

Loop number in section n

GDL

General descriptor loop

Dn

Descriptor number n in the loop

Tid n

Table id=n
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Perform Manual Check

Perform Automatic Check

3-36

Table 3-22: PSIP consistency error
abbreviations (Cont.)

Abbreviation Meaning

TidExt n Table_id_extension = n
Tsid n Transport_stream_id = n
Sid n Source_id =n

Eid n Event_id =n

Rrn Rating_ region =n

Pnn Program number n

Snn Section number n

Vnn Version number n

Use the following procedure to perform a manual consistency check:

1.

Select MPEG-2, DVB, ATSC PSIP, or ISDB-S/ARIB from the Options
menu to include PSI, SI, or PSIP coherence in the search.

Select the hierarchic view of the stream you want to check.
Select Consistency Check from the Analysis menu.

During the analysis, the Message for... window opens to report errors,
warnings, and analysis-specific information. To expand the messages, select
the window and type * on the numeric keypad. To learn more about the
Message for... window, see page 3-72.

NOTE. The windows message unknown PID appears if a selected stream
contains tables in a standard not selected in the Options menu.

With DVB, ATSC or ISDB-S/ARIB selected in the Options menu, the analyzer
performs PSI and SI or PSI and PSIP or PSI, SI and ISDB consistency checks
sequentially.

Use the following procedure to perform an automatic consistency check:

1.

Select Automatic analysis from the Options menu. The Options for
automatic analysis dialog box appears.

Select the Consistency check box and clear all others; then click OK.
Select the PSI/SI/PSIP hierarchic view of the stream you want to check.

Select Automatic from the Analysis menu.
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5. During the analysis, the Message for... window opens to report errors,
warnings, and analysis-specific information. To expand the messages, select
the window and type * on the numeric keypad. To learn more about the
Message for... window, see page 3-72. For additional information on
automatic analysis or terminating the process, see page 3-54.

PSI/SI/ISDB-S/PSIP Rate Analysis

Implement the following steps to perform a PSI/SI (DVB) PSI/PSIP (ATSC)
PSI/SI/ISDB rate analysis on a transport stream:

1. Select the hierarchic view; then select the PSI Rate, PSI/SI Rate, PSI/SI/
ISDB or PSI/PSIP Rate command in the Analysis menu (the selection
available depends on which mode you opened the transport stream file in).

2. The analyzer opens a window similar to the one shown below that contains
tabulated information about the various tables (PAT, PMT, NIT, SDT) in the
transport stream and the frequency of their insertion into the stream.

™ Sample.tip -> PSI / Sl rate =] E3
a
BEI P2 mte Tefultipler Tate: 10000000 bits s A

Pinbyrtes|F. in sec. |Table length |Eate | Ocourencas [ blin time

PAT 1206549 00054 20 1550 15 00801
FMTprogl| 124001 0.1000 o6 2030 1 0.0093

P.inbytes: mazimum of sub tablesperiod average inbytes
P.insee. :marimum of ;b tablesperiod aveTape in seeands
Table lenpthaver ge of mb table s size in bytes

Rate caverpe of mb table s mte in bitsisecond
Oueeurence s: average of mb table s occurence

Iofin time : minimum time in second between two s2etions with the mme 'table_id' 'table_id_sxt'

4] | v o

3. Table 3-23 explains the columns in the PSI/SI/PSIP rate table. The rate table
refers to each table occurrence as a “subtable.”

Table 3-23: Information in the PSI/SI/PSIP rate table

Column Reports

P. in bytes The average number of bytes from the start of one table occurrence in the
transport stream to the start of the next occurrence

P. in sec. The average time (period, in seconds) between consecutive table occurrences;
(P. in bytes)*(8 bits per byte)/(multiplex rate). The analysis is compared to the
MPEG-2 DVB/ATSC/ISDB-S/ARIB standard. A red display indicates an
over-limit value.

Table length | Table size in bytes
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Table 3-23: Information in the PSI/SI/PSIP rate table (Cont.)

Column Reports

Rate The average subtable bits per second of transport stream (the table length in
bits divided by the average period)

Occurrences | The number of times the table occurs in the transport stream file

Min time The shortest time (in seconds) between consecutive table occurrences. The
analysis is compared to the MPEG-2 DVB/ATSC/ISDB-S/ARIB standard. A red
display indicates an over-limit value.

Keep the following in mind when interpreting the PSI/SI rate table:

B The times listed depend on the analyzer’s calculation of the multiplex rate. It
is good practice to check the multiplex rate before conducting a PSI/SI/PSIP
rate analysis and to correct the result if necessary. Refer to Multiplex Rate,
on page 3-29, for more information.

®  The PMT program numbers are not readily apparent from the hierarchical
view. To discover the number of the program mapped by a particular PMT,
double-click on the PMT icon. The program number is listed in the title of
the interpreted view window. Program numbers are also listed in the
interpreted view of the PAT.

Timing Analyses

The MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer conducts two types
of timing analysis: PCR (program reference clock) and PTS/DTS (presentation/
decode time stamps). PCR clocks are encoded in transport stream packets and
pertain to a given MPEG-2 program. The PTS/DTS are encoded into PES
packets and pertain to individual elementary streams only.

PCR Analysis  PCR analysis provides the following capabilities:
®  View a graphic diagram of the PCR clocks of each program in the stream.

m  Access detailed information about each PCR clock.

m  Search for clock errors of a single program or all programs in the transport
stream.
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Viewing a PCR graphic diagram. To see a graphic diagram of the PCRs in a
specific program, right-click on the PMT or TS (with PCR) icon to open the
shortcut menu. Hold the button down and highlight the PCR Analysis command;
then release the button to begin the analysis.

[

Section ackels
Check CRC TR, sis
k FCR &nalysis §
-3TD Analysis

You can also begin a PCR analysis by selecting PCR from the Analysis menu. A
dialog box will appear. Enter the number of the program you want to analyze and
click OK.

The analyzer opens a PCR graphic view window. Typically, the initial view
displays the first ten clocks found in the transport packets of the selected
program. Each clock face icon represents one PCR clock. The arrow extending
down from the clock icon to the time line is normally black; when the analysis
detects a clock timing error, the line turns red.

PCR of SAMPLE.TRP (PID 50. Program 1)

-
PCR Clodk View Mfaltiplest rate: 10000000 bitsise j

PCE rapnber 1to 10

EEEERAERNLED

‘ 0.000301 0.180706 0.361110

-

A H 4

Use either the commands in the Edit menu or the command buttons on the lower
toolbar to view the remaining clocks (of the selected program) in the transport
stream.
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3-40

Listing PCR values. Double-click on a clock icon to list detailed information
about the clock.

B PCR of SAMPLE TRP (PID 50. Program 1) - (o] =]
Mibattiplecmate: 10000000 bits/sec ﬂ

PCEromber 1to 10
BERE R EEE B

0000301
PCR Base : 7241 units
PCR Extension : 227 units
PCR Value [PCRY] : 0.080463963 sec
Interpolated PCR [PCRI) 1 0.080463985 sec
PCRI - PCRY : 0.000000022 sec
Previous PCR Arrived Since : 0.040156807 sec
Packet Number 1 536
Packet Number of PID 50 1 328

This information includes the following:

Interpolated PCR (PCRI): The analyzer calculates interpolated PCR (PCRI)
from the previous PCR value, the number of intervening bits, and the
multiplex rate. If either the previous PCR or the multiplex rate is incorrect,
the PCRI is also invalid. An invalid PCRI can cause a false PCRI-PCRV
eITor.

If a PCR analysis results in numerous PCRI-PCRYV errors, check the
multiplex rate as described on page 3-29. In the case of an isolated
PCRI-PCRYV error, always check the previous PCR for accuracy.

Previous PCR Arrived Since: Previous PCR Arrived Since is the time
elapsed since the previous PCR of the same program. Any value over 0.1
second is an error and is displayed in red characters.

Packet Number: The packet number identifies the transport packet that
contains the PCR. To display an interpreted view of the packet, double-click
on the TS (engine and tender) icon in the hierarchic view to open an
interpreted view of the first transport packet. Then use the Edit menu or
lower toolbar buttons to go to the packet that has the same item number as
the PCR packet number.

Packet Number of PID n: Packet Number of PID 7 identifies the packet that
contains the PCR relative to all packets that have the same program ID. To
display an interpreted view of the packet, double-click on the PID n PCR
(freight car with clock) icon to open an interpreted view of the PID n
packets, and then go to the packet with the same item number.

To list the values for all PCRs shown in the graphic view window, either select
Add view from the Window menu or click on the add view command button in
the upper toolbar. Then select PCR Values from the View Type submenu.
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Searching for PCR errors. As mentioned earlier, the analyzer reports PCR errors
with red arrows in the graphic view. Erroneous information also appears in red
characters on the PCR value lists.

One way to search for PCR errors is to open a PCR graphic view and click the
Next Error command button on the lower toolbar.

A good way to search for all PCR errors in an entire transport stream file is to
use Automatic analysis. Automatic analysis is explained in detail beginning on
page 3-54.

Use the following procedure to search for PCR errors using Automatic analysis:

1. Select Automatic analysis from the Options menu. The Options for
automatic analysis dialog box appears.

2. Select the PCR clocks check box and clear all others; then click OK.

3. Select the PSI hierarchic view of the stream you want to check for PCR
errors.

4. Select Automatic from the Analysis menu.

5. During the analysis, the Message for... window opens to report errors,
warnings, and analysis-specific information. To expand the messages, select
the window and type * on the numeric keypad. To learn more about the
Message for... window, see page 3-72.

6. If the message window identifies PCR errors, double-click on the packet
error entry to create a PCR graphic view containing the erroneous clock.
Double-click on the clock icon(s) to open a window that lists the PCR
values.

PTS/DTS Analysis  PTS/DTS analysis extracts the presentation and decode time stamps from PES
packets encoded in the transport stream and shows those time stamps in a
graphical format. The PTS/DTS timing diagram, like the PCR clock diagram,
provides access to numerical data about the time stamps. It also offers informa-
tion about the associated MPEG-2 access units.

PTS/DTS analysis enables the viewing the “vital statistics” (numerical data) of
various timing objects and searching for PTS/DTS errors in one elementary
stream or all elementary streams in the file.
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3-42

Viewing a PTS/DTS timing diagram.

1. Right-click on the PES icon associated with the stream you want to analyze.
Hold the mouse button down and highlight PTS/DTS on the shortcut menu.

FID 51 FEZ AUDID

2. Release the button. A PTS/DTS timing diagram window appears, showing
the first four PTS/DTS events and the closest PCRs. Table 3-24 explains the
icons used and lists the information you can display by double-clicking on
each icon.

NOTE. You can also begin PTS/DTS analysis by choosing PTS/DTS from the
Analysis menu. A dialog box will appear. Enter the numbers of the program and
stream you want to analyze and then click OK.

# PTS/DTS of DEFAULT TRP (PID 50, Program 1. ES 1) MEIE

PTSDTE Clock Wiew PTS/D TS ramnber 1o 4

0.000301 0.225500

T 4
0.450700

Table 3-24: PTS/DTS graphic view icons

Icon

Represents

Double-click for

PCR (program clock reference)

Time value of the PCR and location of the packet
within the transport stream (TS packet number)

Arrival time of the PTS/DTS

Arrival time value, time since the previous PTS/DTS
arrived, and location of the packet (PES packet
number) within the elementary stream
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Table 3-24: PTS/DTS graphic view icons (Cont.)

Icon | Represents Double-click for

D DTS (decode time stamp) Time value of the DTS and location of the packet
within the elementary stream (PES packet number)

PTS (presentation time stamp) | Time value of the PTS and location of the packet
within the elementary stream (PES packet number)

— | AU (access unit) Begin time

End time

Size in bytes

Type of frame (intra, predicted, or bidirection)
Reference time

[ ] Beginning of a GOP Not applicable

The arrows leading down from the A, D, and P icons to the time line are
normally black, but turn to red when an error is associated with the object.
Red characters also highlight errors in the PTS/DTS value windows that
appear when you double-click on an icon.

The example timing diagram illustrates several features of a correctly
encoded MPEG-2 video stream:

B Access units arrive one after another, as you can see from the left
(“early”) side of the diagram.

B The order of access unit decoding and presentation is visible in the right
(later) portion of the diagram.

®m Intra (I) and predicted (P) pictures must be decoded before presentation
and therefore have both DTS and PTS. Bidirection (B) frames are
decoded and presented at the same time and therefore have only
presentation time stamps.

® B frames use information in an associated P frame; the P frame must be
decoded before the B frame(s), but is presented after. In the example,
then, the order of frame decoding is IPBB, but the order of presentation
is IBBP.

3. Use the Edit menu commands, or the command buttons on the lower toolbar,
to view diagrams of other time stampsand to search for time stamp errorsin
the same elementary stream.

4. To view the data for all time stamps and access units at once, select Add
view from the Window menu or click on the Add view command button.
Select PTS/DTS values from the View type submenu. The resulting window
lists information about the displayed time stamps in the left column and
information about the access units on the right. The number of access units
in the display appears after Nb Access Unit: at the top of the window.
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Incorrect values (such as equal PTS and DTS values, or an arrived value that
is later than either the PTS or DTS) are displayed in red characters.

PTSIDTS value : Nb Access Unit: 4 :l
PTSIDTS number 1 Access Unit number 1
Reference PCR number 1: 0.000300778 sec Begin AU :0.00039171°
Packet PES number o1 End AU :0.1164423!
Arrived value 10.000303178 sec Size AU 187036 byte
Previous PTSIDTS :0.000000000 sec Type rintra (i
PTS value - 0.330700000 sec Reference time :0
DTS5 value :0.290700000 sec

Access Unit number 2
PTSIDTS number 2 Begin AU (0.1164423¢
Reference PCR number 3: 0.080313593 sec End AU :0.15544551
Packet PES number 143 Size AU 129170 byte
Arrived value :0.114600796 sec Type : predicted
Previous PTSIDTS :0.114297618 sec Reference time :3
PTS value 1 0.450700000 sec
DTS value - 0.330700000 sec Access Unit number 3

Beqgin AU :0.15544551~

1| H

Searching for PTS/DTS errors. As mentioned earlier, one way to search for
PTS/DTS errors is to open a graphic view and look for red arrows leading from
A, P, and D icons to the time line. If no errors are present, click on the Next
error command button (on the lower toolbar) to search for errors later in the
elementary stream.

A good way to check the entire transport stream file for PTS/DTS errors is to use
Automatic analysis. Automatic analysis is explained in detail beginning on
page 3-54.

Use the following procedure to search for PTS/DTS errors using Automatic
analysis:

1. Select Automatic analysis from the Options menu. The Options for
automatic analysis dialog box appears.

Select the PTS/DTS stamps check box and clear all others; then click OK.
Select the PSI hierarchic view of the stream you want to check for errors.

Select Automatic from the Analysis menu.

AN I O

During the analysis, the Message for... window opens to report errors,
warnings, and analysis-specific information. To expand the messages, select
the window and type * on the numeric keypad. To learn more about the
Message for... window, see page 3-72.
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Semantic Analysis

6.

If the message window identifies PTS/DTS errors, double-click on the
packet error entry to create a PTS/DTS graphic view containing the
erroneous time stamp.

A red arrow leading from an icon to the time line indicates an error.
Double-click on the icon that represents the incorrect time stamp to create a
value window for the stamp.

Use the following procedure to perform a Semantic analysis on an MPEG-2
transport stream:

1.
2.

Select the PSI hierarchic view of the stream you want to analyze.
Select Semantic from the Analysis menu.

During the analysis, the Message for... window opens to report errors,
warnings, and analysis-specific information. To expand the messages, select
the window and type * on the numeric keypad. To learn more about the
Message for... window, see page 3-72.

If the message window identifies semantic errors, double-click on the
associated packet message entry to open an interpreted view of the section
containing the error.

£ il PEs )
EE stream id [+1])
o
El.’ﬂ? PID #E50 (+11
E% PES packets of the sarme PID shall have the same strearn_id [+1)

o EE] Packet ﬂ'-__-"lkl"l ]

For additional information about an erroneous field, double-click on the
name of the field containing the error. The analyzer does not identify
semantic errors with red characters or special symbols in this interpreted
view.
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shall not be incremented
when the
adaptation_field_control of
the packet equals '00' or "10°.

Mega-frame (MIP) Analysis

This analysis checks the coherence of mega-frame initialization packets, a
concept described by the DVB-T standard. A MIP is a special transport packet
with its own syntax, which is always located in PID 0x15.

Use the following procedure to perform a Mega-frame analysis:

1.
2.

3-46

Select the PSI hierarchic view of the DVB stream you want to analyze.
Select Mega-frame (MIP) from the Analysis menu.

During the analysis, the Message for... window opens to report errors,
warnings, and analysis-specific information. To expand the messages, select
the window and type * on the numeric keypad. To learn more about the
Message for... window, see page 3-72.

If the message window identifies mega-frame errors, double-click on the
associated packet message entry to open an interpreted view of the section
containing the error.

Erroneous field values are displayed in red characters. Double-click on the
value rectangles to confirm the error.
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Dynamic Analyses

- CAMTS2004CFG-TRP\Dvhirp (+152)
2 Notes
5 % Megaframe (MIP) Analysis (+152)
E% 2/12/99 17:20:31 AM *Complete** (+152)
2-m TS (+152)
oY miP Pointer (+1)
=E Invalid painter field: shall be lowerthan 10584 imaximum possible megaframe size in B4-0AM
. iggg] Packet#2 (1)
=¥ MP duplication (+157)
E@ each mega-frame shall contain exactly one MIF (+1561)
Packet#134, #334, #533. . #29361 (+151)

The analyzer performs the following types of dynamic analyses:

m  T-STD (transport stream target decoder), which checks the selected program
against the decoder model defined in the MPEG-2 standard.

m  LTW (legal time window) offset, which checks the validity of the optional
LTW offset and piecewise rate adaptation fields of the transport packets.

B Smoothing buffer simulation.

NOTE. The MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer dynamic analysis
algorithm uses the “Leak method” to transfer video elementary stream data from
the main buffer, MBn, to the elementary stream buffer, EBn. Buffer overflow can
occur when analyzing streams (such as those created with the MPEG Test System
Multiplexer application) that require “VBYV delay method” data transfer.

Refer to ISO/IEC 13818-1 for additional information about Leak method and
VBV delay method buffering.

Visual Mode  T-STD and LTW analyses provide a visual mode you can switch on and off.

Visual mode graphically represents the contents of the various decoder buffers,
shows the progress of the analysis, and provides a method to abort the process.
With visual mode active, the analysis time increases however. You must switch
visual mode on or off before you begin a T-STD or LTW analysis. In the Options
menu, click Visual TSTD and LTW to make the selection.
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T-STD Analysis = The MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer can perform T-STD
analysis on a selected program in the current transport stream or on all programs
in the stream.

Analyzing a Selected Program. There are two ways to start a manual analysis of a
single program:

1. Click on the appropriate PMT icon with the right mouse button; then select
T-STD Analysis from the shortcut menu.

Section
Check CRC
FPCR Analysis

=l

TN 213

The analyzer checks all video and audio streams in the program, and, if
visual mode is selected, creates a T-STD Buffering Simulation window as
shown on page 3-49. The graphic simulation shows buffer use of the first
video and the audio streams listed in the PMT.

2. With the hierarchic view selected, select Dynamic from the Analysis menu;
then select T-STD from the submenu. The TSDT Analysis dialog box

appears.
TSTD Analysis
Program number I'I—
& Al TS packets T User defined system buffer size
~ Selected TS packets TESys [ Bytes
BSyz I— Butes
Clart packet |-|—
7T User defined video buffer size
End packet IW 11 l— Bules
MB1 [ Byes
— Dizplay EB1 I— Bytes
iten bianeh steam I ilser defined audia buffer size
Audobranch:  steam | TB2 | Byles
EB2 [ Byes
aK I Cameel I
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Enter the following information in the check boxes:

®m  Enter the program you want to analyze. The program number in this dialog
box refers to the order that the particular program is listed in the hierarchic
view.

®m  To limit the portion of the stream to be analyzed, click the Selected TS
packets option button and enter the starting and ending packet numbers.

B The analyzer checks all elementary streams in the selected program, but by
default, shows a graphic presentation of only the first video and the first
audio elementary streams listed in PMT and hierarchic view. If you want to
see how a different stream uses the buffers, enter the stream number
according to the order the stream is listed among the video and audio streams
in the program. For example, to analyze the stream listed fourth under the
program listed third in the hierarchic view, enter 3 in the Program number
box and 4 in the Stream number box.

B You can define the video, audio, and system, buffer sizes. If you choose to
do so, complete all entries.

When you have entered all appropriate information, click OK. The T-STD
Buffering Simulation... window appears (if visual mode is selected).

T-STD Buftering Simulation for Sample.trp (program 1) - Standard: DVE  H[E] E3

DVB-SI ]
Processing packet #3581 - Current time is 0.087374 s. _

TEL EB1

D\“‘ ME1
viDEo | 0% — 0% —TEH%

Size = 512 higres Sime = 10000 byres Sime = 229576 bytes
THEZ B2
AuDIo | 0% —ﬂ 15%
Size = 512 higres Sime = 3554 hptes
THBsys Bsys
SYSTEM| 0% —{ 0%

Size = 512 higres Sime= 1556 hptes

g | LI—AI

The Buffering Simulation window has the following features:
® A counter that shows the current packet number.

m A display of the current PCR time.
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B Dynamic bar graphs of the three video branch buffers. If the program has no
video elementary stream, ***unused*** appears under each bar (instead of
size information). The buffer bars change colors to indicate usage:

Blue = normal

Yellow = filling up

Orange = close to overflow
Red = buffer full.

B Dynamic bar graphs of the two audio branch buffers that follow the same
usage and color conventions as the video branch buffers.

B Dynamic bar graphs of the two system buffers that follow the same usage
and color conventions as the video branch buffers.

B An Abort button that permits you to pause or end the simulation before the
end of the stream.

At the end of the analysis, all activity in the T-STD Buffer Simulation window
stops; if you are not using visual mode, the analyzer presents an End of
simulation dialog box.

Close the buffering simulation window to read the test results in the Message
window.

The Message for... window reports errors, warnings, and analysis-specific
information. To expand the messages, select the window and type * on the
numeric keypad. To learn more about the Message for... window, see page 3-72.

If the analyzer detects buffer underflow or overflow, errors are identified by
program number and packet ID in the message window. A new entry is added
when packet numbers are not consecutive between the previous error and the
current error.

Eﬂes

First error occurs in packet #309.

- F TSTD Analsis (+3848)
3-8y 6/4/38 3:21:43 PM ~Running™ [+3848)
- Program #1 (+3849)

E@ "Overflow" in buffer B
...... EF] Packet #2309, #310, #3117 [+3)

------ [E(F] Packet H336, 4337, 4338, . H343 +8)
------ EE] Packet ﬂBEWFU, HIT1, L HITE (8]
------ [E(] Facket H402, #403, 404, . H403 [+8]
------ EF] Packet #4365, #4237 #4338, #4433 [+8)
------ [E(] Facket H4E3, #470, 471, . HAT6 [+8]
------ EF] Packet #5002, #5023, #504, . H#503 (+8)

Last error occurred in packet #311.
Three consecutive errors found.
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Double-click on packet message entries to open an interpreted view of items
containing errors.

Analyzing all Programs in a Stream. You can use Automatic analysis to check an
entire stream at once for T-STD buffering errors.

1. Select Automatic analysis from the Options menu. The Options for
automatic analysis dialog box appears.

2. Select the Dynamic check box and clear all others; then click OK.

3. Select the PSI hierarchic view of the stream you want to check for T-STD
errors.

4. Select Automatic from the Analysis menu. A Buffering Simulation window
will not appear, even if Visual TSTD and LTW is selected in the Options
menu.

NOTE. A T-STD automatic analysis of an entire stream can take several minutes
depending on the file sizes.

During the analyses, the Message for... window opens to report errors,
warnings, and information about the analysis. To view messages, select the
window and type * on the numeric keypad. To learn more about the Message
for... window, see page 3-72. For additional information on automatic
analysis or terminating the process, see page 3-54.

If the analyzer detects buffer underflow or overflow, errors are identified by
program number and packet ID in the message window. A new entry is
added when packet numbers are not consecutive between the previous error
and the current error.

S. Double-click on packet message entries to open an interpreted view of items
containing errors.

T-STD Notes. Consider the following when reviewing T-STD analysis errors:

®  Overflow at the beginning of the simulation may not indicate encoder
problems, because the analyzer must wait for the first DTS in the stream
before emptying the EB and B buffers. Buffer overflow after the first DTS,
however, indicates improper encoding.

B T-STD errors can arise from several different sources, including PCR errors,
PTS/DTS errors, and multiplexing errors. PCR analysis, PTS/DTS analysis,
and analysis of the Multiplex Characteristics may help locate the problem.
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LTW Analysis

B Remember that although the error message window lists the last packet that
results in buffer overflow or underflow, the cause of the error is probably
earlier in the stream.

LTW analysis checks the validity of the optional LTW offset and piecewise rate
adaptation fields of the transport packets that contain the selected stream. The
analyzer does this by remultiplexing the packets to place each at the end of its
legal time window; it then performs a standard T-STD analysis on the resulting
transport stream.

To perform an LTW analysis, do the following:
1. Select Dynamic from the Analysis menu; then select LTW from the
submenu. The LTW Analysis dialog box appears.

LTW Analysis

Program number 1

& A TS packets

" Selected TG packets

—
Start packet 1 ME1 l— Butes
Erd packe! 200242 Ef] [

~Steamtobetested TB2 I Bytes
Shieam number 1 I—

EB2

ok I Cancel |

2. Enter the program you want to analyze. The program number in this dialog
box refers to the order that the particular program is listed in the hierarchic
view.

3. To limit the portion of the stream to be analyzed, click the Selected TS
packets option button and enter the starting and ending packet numbers.

The analyzer checks all elementary streams in the selected program, and by
default, shows a graphic presentation of only the first video and the first
audio elementary streams listed in PMT and hierarchic view.

4. If you want to see how a different stream uses the buffers, enter the stream
number according to the order the stream is listed among the video and audio
streams in the program. For example, to analyze the stream listed fourth
under the program listed third in the hierarchic view, enter 3 in the Program
number box and 4 in the Stream number box.

5. You can define the video and audio buffer sizes. If you choose to do so,
complete all enteries.
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6. When you have entered all appropriate information, click OK.

If you selected Visual TSTD and LTW from the Options menu, a graphic
window similar to the T-STD Buffering Simulation window appears (see
page 3-49). However, because only one stream is analyzed at a time, the
video or audio branch buffers (depending on the type of stream) are used.

NOTE. If the packets of the selected stream do not contain LTW offset fields, the
analyzer conducts a normal T-STD analysis of the stream.

At the end of the analysis, all activity in the LTW Buffer Simulation window
stops; if you are not using visual mode, the analyzer presents an End of
simulation dialog box. Close the buffering simulation window to read the
test results in the Message window.

The Message for... window reports errors, warnings, and analysis-specific
information. To expand the message, select the window and type * on the
numeric keypad. To learn more about the Message for... window, see
page 3-72.

If the analyzer detects buffer underflow or overflow, errors are identified by
program number and packet ID in the message window. A new entry is
added when packet numbers are not consecutive between the previous error
and the current error.

7. Double-click on packet message entries to open an interpreted view of items
containing errors.
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Smoothing Buffer
Simulation

Automatic Analysis

3-54

This analysis simulates a smoothing buffer using the values in the smoothing
buffer descriptor field that is optional in PMTs.

To begin smoothing buffer analysis, open the hierarchic view and select
Dynamic from the Analysis menu; then select Smoothing Buffer from the
Dynamic submenu. If the analyzer detects any overflow or underflow errors, it
creates a Message for... window and lists the errors. There is no graphic
representation of smoothing buffer analysis.

Using Automatic analysis, you can conduct a sequence of analyses on an entire
transport stream file. This provides a convenient way to screen a newly captured
transport stream for a wide variety of errors. As explained in the discussions of
PCR analysis (page 3-41), PTS/DTS analysis (page 3-44), and T-STD dynamic
analysis (page 3-51), Automatic analysis is helpful in searching for errors in the
entire transport stream/multiplex, as opposed to the narrow searches of a single
program or stream conducted by initiating the same single analysis.

Automatic analysis takes several seconds to many minutes to perform, depending
on the size and complexity of the file, speed of your computer, and the number
and type of analyses selected through this dialog box.

Dynamic analysis takes longer to run than all other tests combined. Be sure you
want to check all elementary streams in the transport stream multiplex for
compatibility with standard decoder buffers before selecting the Dynamic check
box. You can select all analyses but Dynamic for the first look at a transport
stream and later go back and select only Dynamic when you are ready to confirm
decoder compatibility.
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To initiate an Automatic analysis, perform the following steps:

1. Select Automatic analysis from the Options menu. The following dialog
box appears.

Dptions for automatic analysis

Chooge the analyses you want
ta be performed by the
automatic analysis:

2l Spntactic
[V Corgistency

e 0K
¥ PSI/51/PSIP rate -
¥ FCR clocks
¥ PIS/DTS stamps Cancel |
¥ Semartic

V' Dynamic

2. Clear the check boxes of the analyses you do not want to perform.

NOTE. The MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer can conduct
three kinds of Dynamic analysis: T-STD (transport stream target decoder), LTW
(legal time window), and Smoothing Buffer. Automatic analysis includes only
T-STD analysis; the remaining dynamic analyses must be performed manually.
Refer to Dynamic Analyses, on page 3-47, for more information.

3. Click OK to confirm the selections and close the dialog box.
4. Select Automatic from the Analysis menu.

The Automatic analysis for... window appears momentarily before being
covered by the Message for... window. The Automatic analysis for... window
lists the progress of each test. As the analysis proceeds, cells in the Status
column change from blank to Running to Completed. As each test is
completed, either OK or Errors appears in the corresponding Result cell. If
you want to view the Automatic analysis for... window during the analysis,
reposition the message window to the side.
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& Automatic analysis for Default_trp - Standard: ISDB-5 7ARIB

Status Result
Syntactic Completed Errors
Congistency Completed 0K
PSIfSIPSIPYISDB rate | Completed OK
PCR Completed OK
PTSIDTS Completed 0K
Semantic Completed 0K
Dynamic Hunning...

| Cancel all the analyses |

NOTE. To end the Automatic analysis at any time, click Cancel all the analyses
in the bottom-right corner of the Automatic analysis for... window. To abort the
current “Running” analysis, click Skip current task.

5. During the analysis the Message for... window reports errors, warnings, and
information specific to each test. To expand the messages, select the window
and type * on the numeric keypad.

To learn more about the error messages associated with each test, refer to the
individual analyses sections. To learn more about the Message for... window,
refer to Message Window on page 3-72.

The MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer filtering capability
allows you to find and view transport stream packets, PES packets, and
PSI/SI/PSIP/ISDB-S/ARIB table sections that meet one or more criteria of your
choosing. You can create filters to find and display the following stream objects
for example:

B Transport packets that contain the first bytes of all PES packets of a given
elementary stream (as indicated by the presence in the payload of hexadeci-
mal string 00 00 01).

B Transport packets of a given PID in which the payload unit start indicator is
set to one.

m  PSI/SI/PSIP/ISDB (table) sections of a given PID that contain a descriptor
tag with a value of 64.
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m  PES packets of a given PID that lack both PTS and DTS (PTS/DTS flag set
to zero).

When you define a filter, you specify the output level (transport packets, table
sections, or PES packets) and, if necessary, the PID. You can use from one to
four filtering criteria per filter. When applied, the filter looks for packets or
sections that meet all criteria and opens an interpreted view of the first item
found.

Once a filter is created, you can save it to a *.flt file for use in later analyzer
sessions; you can also edit existing filters and save them under a new name.

You can save an unlimited number of filters and have up to five open at any
time, ready to apply to the current transport stream.

Creating a Filter  Use the following steps to create a filter.

1. Select Filters from the Selection menu; then select New from the submenu.
The first Filters - Criterion dialog box appears.

Filters - Criterion number 1
Filter name : I
Carnrent :
Output lesvel : & Transpor Packet

© PSI/SIIPSIP Section

" PES Packet

Ferform search an:

& Al PIDs

™ TS Packets which PID = ID
Cancel | Endl | Mest s> |

2. Enter the appropriate information and select options as necessary. Comple-
tion of the first Filters - Criterion definition box is mandatory.

B The Filter name can be up to eight characters long. By default, the name
you enter is proposed as the file name when you save the filter.
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®  The Comment field can contain up to 255 characters. Enter a description

that will help you identify the filter and its function when you later open,
edit, or apply it.

Output level is the type of object you want to find. The filter result is an
interpreted view representing the packets or sections that meet the filter
(search) criteria.

Enter the PID of the packets you want to filter; you can select All PIDs
only if you have specified Transport Packet output.

If you select TS Packets which PID =, your selections in this dialog box
should fill in the blanks in the statement “I want to find the [blank 1]
items that are identified with [blank_2]...” where blank 1 is the output
level and blank_2 is either “any PID” or PID n.

If the Output level is PSI/SI/PSIP/ISDB-S/ARIB Section or PES packet,
you cannot perform a search on All PIDs; you must enter a PID number.

3. Click Cancel to close the dialog box and suspend filter definition, click End
to terminate filter definition, or click Next to open the second Filters -
Criterion dialog box.

Filters - Criterion number 2

Criterion lewel : & MNone

¢ Transport Packet
" PSIJEI/PEIP Section
i~ FES Facket

 Elementary Stream

Field -] vae: o

I daytes srarch = Hexadesina]

L@ = I

Cancel | << Prewvious |

NOTE. Completion of the second through fourth criterion boxes is optional.The
remaining filter definition steps let you add filter requirements. Strictly speaking,
none of the additions is necessary, but a filter without at least two criteria would
do no more than you could by double-clicking on a hierarchic view icon. The
third and fourth filter criteria are optional but may help you narrow your search
to exactly the packet or section you are interested in.
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4. Use the second through fourth Criterion dialog boxes to fill in the blanks of
one of the two following statements:

®  Each item I am looking for must be(or contain the part of)a [blank 3]
that has a [blank 4] field with the value [blank_5].

®  Each item I am looking for must be (or contain the part of) a [blank 3]
that contains the byte sequence [blank_6].

Where blank_3 is the Criterion level, blank 4 is a selection from the
Field drop-down list box, blank_5 is a number entered in the (field)
Value box, and blank_6 is a hexadecimal or text value entered into the
last value box when the “4 bytes search” check box is selected.

For example, you can make selections to complete the above statements
in the following ways:

®  Each item I am looking for must be a PES packet that has a
PTS/DTS flag field with the value 3.

®  Each item I am looking for must contain the part of a PES packet
that contains the byte sequence 00 00 01.

®  Each item I am looking for must be a transport packet that contains
the byte sequence 00 00 01 CO.

Several conventions apply to this dialog box:

B Some criterion levels may not be available, depending on the output
level specified in the first filter definition dialog box.

B The fields listed in the Field: drop-down list box depend on the
criterion level selection.

®  The Next button disappears when you select the Elementary Stream
criterion level or the 4-bytes search check box because the filter
cannot be any more specific than these selections.

®m  Selecting the Elementary Stream criterion gives you no further
options; the Field drop-down list contains only Beginning of Access
Unit (AU) and 4-bytes search is not available. Use Elementary
Stream criterion to find either transport stream packets that contain
the start of an AU or PES packets that contain the start of an AU.
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5. Click Cancel to close the dialog box and omit the secondary criteria, click

<< Previous to return to the previous filter definition dialog box, click End
to complete the filter creation and end the session, or click Next >> to define
up to two more filter criteria.

If you clicked End and forgot to name the filter, the dialog box below
appears. Enter a name and click OK to complete the filter or click Cancel to
terminate the session.

Warning : Filter name is empty

You must give the filter a name :

| )8 | Cancel |

If you clicked End and the filter name already exists, the following dialog
box appears. Enter a unique name for the filter or click OK to overwrite the
existing filter with the new filter. Click Cancel to terminate the session.

Warning : Filter name already used

“You mayw change the filker name

| )8 | Cancel
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Saving a Filter ~ Once a filter is defined, you can save it to a file and use it in another analysis.

1. Select Filters from the Selection menu; then select Save from the submenu.
The Save filter dialog box appears. The dialog box shows all currently
loaded filters.

Save filter
Selectafilter: & MNew
 Sample
O <Ermipty>
¢ <Empty>
 <Empty>

Filter camment :

TS packets with FID=40and payload unit start
indicatar=1

| QK I Cancel |

2. You can save up to five filters. Click the option button that corresponds to
the filter you want to save; then click OK.

3. A standard Windows Save As dialog box opens. The filter name (with a *flt
extension) appears in the File Name box. Click OK to accept the file name
and save the filter file, or enter a different name and click OK to save the file
under a new name.

Save as K=
Sawe in: |@ Filter =

File name: INEW-ﬂt Sawve |
Sawve as tvpe: IFiIter d Cancel |
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Opening and Loadinga  Use the following procedure to open and load a previously saved filter.

Filter

1.
2.

3-62

Select Filters from the Selection menu; then select Open from the submenu.

If no more than four filters are already opened and loaded into the analyzer
memory, the standard Windows Open dialog box appears. Select the desired
filter as you would any document from within any Windows application
(remember that the default filter file extension is *.flt). Click OK to load the
filter into analyzer memory.

If five filters are already loaded, the Open - Replace a filter dialog box
appears. This dialog box shows the filters currently loaded into the analyzer
memory. Select the filter you want to replace (with the filter you are about to
open). Click OK to delete the filter.

Open - Replace a filter
Selectafilter: & Filer 5
O MNew
O Sample
= Filter_1
" Filter 2

Filter camment :

| QK I Cancel |

The Windows Open dialog box now appears; select and open the desired
filter. Click OK to load the filter into analyzer memory.

The analyzer checks the selected file for a valid filter. If a filter is found, the
Open filter dialog box appears.

Click Yes to store the filter into memory, click No to redisplay the Open
dialog box to select a different filter, or click Cancel to abort the session.
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Editing a Filter ~ Use the following steps to edit an open filter.

1. Select Filters from the Selection menu; then select Edit from the submenu.
The Edit filter dialog box appears.

2. Select a filter and then click OK. The first Filters - Criterion dialog box,
containing the latest filter selections and settings, appears.

3. Proceed as if you were defining a new filter (see page 3-57). Change the
existing selections and make new ones as necessary.

4. Click End.

If you change the filter name through the course of editing, the new name will
replace the original name in the filter list dialog box. The previously saved filter
file is not affected.

You can save the edited filter as described in Saving a Filter (above). Use the
original name if you want to overwrite the old * flt file; enter a new name if you
do not.

Applying a Filter ~ Use the following steps to apply a filter to a transport stream.
1. Open an existing filter or create a new one.
2. Select the hierarchic view or a transport packet interpreted view.

3. Select Filters from the Selection menu; then select Apply from the
submenu. The Apply filter dialog box appears.

Apply filter
Selectafilter: & Filer 5
' New
O Sample
= Filter_1
' Filiar2

Filter camment :

TS packets with PID=40 and payload unit start
indicatar=1

| QK I Cancel
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4. Click the option button that corresponds to the desired filter. The comment
field applies to the selected filter.

S. Click OK. The analyzer displays an interpreted view of the first packet or
section (if any) that satisfies all filter criteria.

6. Use the lower toolbar buttons to move among all stream items that meet the
filter criteria. The full functionality associated with an interpreted view is
available to obtain information on a particular MPEG-2 DVB/ATSC/ISDB-
S/ARIB field.

The window heading identifies a filtered view. Messages at the top of the
window provide useful information about the items found.

¥ SAMPLE TRP - Filter : PES_STRT M=l B3
Tem 1- Position : 376 - Time : 0000301 5 ﬂ
Tlegsicalyomber of this tem {ametig all TS packets ) : 3 /9300

[srmetyte] [rmepart ewer | [ paylondmntt | [ tmspert | [P | [ trmspert. | [ adoptation | [ cotieusity |

If the analyzer finds no item that matches all filter criteria, a message window
indicates no matches.

3-64 MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer



MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer

Extracting and Saving Stream Elements

You can extract transport packets, PES packets, PSI, SI, PSIP and ISDB-S/ARIB
tables, and elementary streams from the current transport stream and save them
to disk files for later use or analysis.

Transport Packets  To save a portion of a transport stream, double-click on a hierarchic view TS
(engine and tender) icon to open an interpreted view of the transport packets;
then select Save As from the File menu or click the Save command button on
the upper toolbar. The Save Transport Stream dialog box appears.

Save Transport Stream
i Packet " Payload
& All Packeats & Al EID
= Select Facket Numbers  SelectFID

Eram |1
Tao IE\EDD

FID IU
Cancel |

Make the appropriate selections and click OK. A standard Windows Save as
dialog box opens with the file type set to Transport Stream (*.trp). Select the
appropriate drive and directory, enter a file name, and click OK.
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PES Packets  To save some or all of the packets in a PES stream, open an interpreted view of
the PES and select Save As from the File menu. The Save Pes Stream dialog box

appears.
Save Pes Stream E
~PesPackets ——— — PacketStream ID——
@ Al Packets & All Streams ID
 Select Mumber i~ Select Stream 1D
Erom IW
. Stream |0 |224
To |!
Cancel |

Make the appropriate selections and click OK. A standard Windows Save as
dialog box opens with the file type set to Pes Stream (*.pes). Select the
appropriate drive and directory, enter a file name, and click OK.

PSI, SI, PSIP and  To save one or more sections of a particular table (PAT, PMT, NIT, SDT, for
ISDB-S/ARIB Tables example) in the transport stream, double-click on the hierarchic view table icon
to open an interpreted view of the section. (To save more than one section, click
the End button on the lower toolbar to go to the last section and determine the
number of sections in the stream.) Then select Save As from the File menu or
click the Save command button. The Save sections dialog box appears.

Save sections

Section number

From |1
To I'IE

] 4 | Cancel |
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To save a particular section or sections, enter the appropriate From and To values
(if you clicked the End button before choosing Save As, the number of the last
section appears in the To box). Click OK to open A standard Windows Save as
dialog box. The file type matches the type of section (for example, PAT/.pat).
Select the appropriate drive and directory, enter a file name, and click OK.

Elementary Streams  To save an elementary stream, double-click on a stream icon in the PSI hierar-
chic view or right-click one of the icons and select Save from the popup menu.
The Save <Audio, Video.. > Stream dialog box appears with the file type set to
match the type of stream. Select the appropriate drive and directory, enter a file
name, and click OK.

A progress gauge opens to report the status of the save. To interrupt the save,
click the Abort button.

PES Extraction. To save an elementary stream at the PES level, open an
interpreted view of the PES and select Elementary stream from the Selection
menu.

Select Elementary Stream

Select Elementary Stream ID number:

Cancel

Enter the elementary stream ID number and click OK. The Save as dialog box
appears with the file type set to match the type of stream. Select the appropriate
drive and directory, enter a file name, and click OK.

A progress gauge opens to report the status of the save. To interrupt the save,
click the Abort button.
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The Options Menu

MPEG-2
DVB

ATSC PSIP
ISDB-S/ARIB

Gl-D Identification

AC3 Identification in DVB

3-68

Mode

Visual TSTD and LTW

Unscrambling

The Options menu provides you a way to customize analyzer configuration and
to save your configuration choices in a file so you can easily restore them in
future analyzer sessions.

Use these Options menu selections to specify the standard for analysis functions.
Menu selections apply to open new files only; changing the standard does not
alter files already opened.

Selecting DVB for example, activates/deactivates recognition of DVB syntax
and semantics in new files.

I 192

PIL 17 SDTEAT PID 17

1~DVB (DVB recognized) DVB not recognized

When DVB is not selected, the analyzer interprets any DVB SI sections as
private sections. Activate DVB when you are analyzing DVB SI streams;
deactivate the selection only if you know the streams you are analyzing contain
no DVB elements.

Likewise, selecting MPEG-2 or ATSC PSIP Terrestrial or Cable applies the
selected standards to new file analyses and interprets any other sections as
private sections.

Use this selection when you know that the stream you are analyzing has
Digicipher II video elementary streams. If this option is not selected and the
stream has Digicipher II streams encoded, they are interpreted as private data
streams.

Use this option to specify that Dolby Digital audio elementary streams be
recognized as such in DVB mode. This is automatic in ATSC PSIP mode, and is
not available in MPEG-2 mode.

This selection determines whether the T-STD and LTW dynamic analyses are
conducted in a window as visual buffer simulations or “in the background.”
Refer to Visual Mode on page 3-47 for more information.

Switch the unscrambling option on and off.
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Output Messages in File  Select this option to automatically save error messages and the contents of error
message windows to a text file.

If this option is selected and you open a file of a transport stream with PAT CRC
errors for example, the analyzer writes a list of the errors to a ASCII text file.
The file receives the name of the transport stream file with a .log extension and
is saved in the directory specified through the Options menu Directories
command. You can read the *.log file with an ASCII text editor, such as the
Windows NT Notepad application.

The analyzer similarly creates a *.log file and saves any message window error
lists generated during stream analysis. Examples of error lists are those that can
result when you conduct a syntax analysis or a consistency check.

Remember that selecting this option can, over time, result in many error log files
in the Message directory. It is good practice to periodically delete outdated files.

Base  The Base command opens a dialog box for selecting the numeric base used in the
hierarchic and interpreted views. F2 is the shortcut key for toggling between the
two settings.

=4 DRTENy Ludy @FQQ

Hierarchic view Interpreted view

Font  Use the Font command in the Options menu to change the typeface used in the
hierarchic and interpreted views. Choosing the command opens a dialog box for
selecting font, style (normal, bold, italic), and size. Make your selections and
click OK. The display changes immediately.

Directories  Use this command to specify default directories for output messages and
configuration files. Enter the complete paths in the Message directory and
Configuration directory text boxes; then click OK.
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Default directories | ]

Message directory:

|

Configuration Directory:

|C:\spare cfg-trp |

oncer_|

Automatic Analysis  Use this command to configure the automatic analysis sequence. Refer to
Automatic Analysis, beginning on page 3-54, for complete instructions.

Interpretation  Select this command to control the information that appears in the transport
packet, PES packet, and section interpreted views. See Interpreted View Options
on page 3-26 for a full explanation.

Configuration  All selections you make through the Options menu change the analyzer
configuration. The configuration in use when you exit the analyzer application is
restored the next time you start the program. The three configuration commands
in the Options menu let you save one or more configurations to files for later use
and allow you to easily return to the default configuration.

Save Configuration. Use Save configuration to save the current option settings to
a file. A standard Windows Save as dialog box opens. Be sure to select a Drive
and Directory that will make it easy to later retrieve the file; then enter a
descriptive name for the configuration file and click OK. The file receives the
extension *.acf by default.

Read Configuration. Select Read configuration from the Options menu to restore
a configuration file that you saved earlier. A standard Windows Open dialog box
appears. Change the Drive and Directory if necessary and then select the file
name. Click OK to restore the configuration saved in the file.

3-70 MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer



MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer

Set Default Configuration. Select Set default configuration to restore all default
analyzer settings. A dialog box appears; click OK to confirm the command.

The following settings make up the default configuration.

Table 3-25: Analyzer default settings

Option

Default setting

DVB

Not selected.

Visual TSTD and LTW

Selected.

Output messages in file

Not selected.

Base

Decimal.

Font

Times New Roman, Regular, seven point.

Directories

See note below.

Automatic Analysis

All analyses selected.

Interpretation

Neither field Length nor Position displayed.
All fields displayed for all types of interpreted view.

NOTE. When you select Set default configuration, the message and configuration
directories are changed to the directory that contains the most recently opened
file. This can cause confusion because the directories remain the same until you
change them through the Options menu Directories command, read a saved
configuration file, or (after opening a file from a different directory)again select
Set default configuration.
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Message Window

The analyzer uses the Message for... (Message) window to report errors,
warnings, and information about analyses performed in the hierarchic and
interpreted view windows, one message per open stream.

------ - Motes

Eﬁ Abam atic Analpsis [+1 3]

EE‘@ 5/28/98 1:15: 34 PM *Complete™ [+13)

[_j%w Syntactic Analysiz **Complete™ [+9)

OB PES (+9)
E& Consiztercy Analysiz “Complete™ [+2]
------ FID #43 iz found in the stream, but not referenced. [+1)
: % PID #3170 iz Found in the stream, but not referenced. [+1]
[]@-xg: PS1/S1 rate analysiz *Complete™
[]@ FCR Analysis “Comphete™
[ & # PTS analysis “Complete
|'_—‘|§ Semantic Analysis **Complete™ [+2]

0 m TS )

B FES (1)

Messages are grouped by analysis type and displayed in a hierarchical tree within
the message window. The nomenclature includes date and time, analysis level
syntax, and error description. The number of erroneous packets detected is
indicated between parentheses. You can save a message window with the File
menu Save as command and view (interpreted view) or delete data with the
popup menus.

NOTE. If the number of nodes in the message window exceeds 10,000, the
analyzer discards the remaining nodes; the number of nodes lost is documented
in the final node at the bottom of the tree.
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Identifying Icons

for... window.

Table 3-26: MTS300 analysis and element icons

Table 3-26 identifies the analysis and element icon types used in the Message

Icon

Application name

Icon

Function

Analyzed stream

Notes

e
B

Date and time stamp

Automatic analysis

iﬁgﬁ Syntactic analysis MPEG-2 PSI, DVB SI, ATSC PSIP,
’ or ISDB-S/ARIB Consistency analy-
sis
=i | PSI-Si rate analysis PCR and PTS analysis
ot
ti lysi ‘ T-STD analysi
Semantic analysis ;ﬁ-’ analysis
ﬁ‘b’ LTW analysis By CRC check
Field incriminated in the message @’ Message description
=22 | and subject of message
BBl | TS packet type BEE | PAT packet type
== | PES packet type ﬁ PMT packet type
E NIT packet type FiD | PID number
ﬁl Program Message Counter: records first,
second, third, and last packet
numbers of error occurrence.
ﬁ?ﬁ No errors found $ Mega-frame analysis

Error Reporting

the the icon bullets as follows:

B Green bullet: no errors detected

B Yellow bullet: warning

m  Red bullet: errors detected

Adding Notes

Color-coded bullets accompany most reporting in the message window. Interpret

The message window has a Notes node at the top level of the tree. Double-click

this node to open the Notes window. Type your comments in this window; the
first sentence is automatically appended to the node identification when you
close the window.

MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer

3-73



MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer

Navigating the Message

3-74

Window

The analyzer provides keyboard and mouse commands to help you navigate and
review messages. Additional commands are also provided to sort, edit, and
delete messages.

Keyboard Commands. Use the keyboard commands listed in Table 3-27 to
navigate the message window.

Table 3-27: Message window keyboard commands

Press (key) to perform function | Function

HOME Selects the top (root) node in the tree.
END Selects the last node in the tree.
PAGE UP Closes the next node of the tree.
PAGE DOWN Opens the next node of the tree.
Arrow keys
UpP Selects nodes upwards, vertically in the tree.
DOWN Selects nodes downwards, vertically in the tree.
LEFT Closes the preceding parents children upwards in the tree
one node at a time.
RIGHT Opens the proceeding parents children downwards in the
tree one node at a time.
* (Asterisk), numeric keypad Opens all children of the selected node.
- (Minus), numeric keypad Closes the children of the selected node.
+ (Plus), numeric keypad Opens the children of the selected node.

Popup Menus. Select a message in the message window with the left mouse
button and then right-click to obtain a popup menu. You can perform the
operations listed in Table 3-28 with the popup menus. The menu selection
changes depending on the message selected.

Table 3-28: Message window popup menus

Popup menu Function

View Displays an interpreted view of the selected node. (Equivalent
to double-clicking a node without children.) If the node does not
contain enough information to open a view, the children are
queried until sufficient information is recovered. If a view
cannot be opened, a warning is issued.

Delete Deletes the selected node and all of its child nodes. The
message ! ! ! Error messages have been deleted in this node !
!1'is appended to the parent list of the deleted node. The
number of items appearing in parenthesis is not updated.
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Print the Message Window
Contents

Create a Message
Window File

Save a Message Window

Table 3-28: Message window popup menus (Cont.)

Popup menu Function

Refresh Updates the number of errors entry (noted in parenthesis)
following the deletion of warning messages by the Delete
command. The number of errors for a node is the sum of the
child errors.

Sort by PIDs/Sort by fields! Sort by PIDs: Sorts the message window by PIDs; outputs a
list of messages for each PID.

Sort by fields: Sorts the message window by fields; outputs a
list of PIDs for each message type.

1 Execute from the root level only.

Select Print from the File menu to send the contents of the message window to a
printer.

To write the contents of the message window to a file, select Qutput messages
in file in the Options menu before you begin the analysis. The Save as dialog
box will appear when you begin the analysis. Enter a <file name> and click Save
to create a .LOG Error message file on disk.

If the number of nodes in the message window exceeds 10,000, the analyzer
discards the remaining nodes and documents the number lost in the final node. If
the Output messages in file option is on, messages written to a file will not be
lost.

Use the following procedure to save a message window to the hard drive.
1. Select Save as from the File menu or click

By

&l in the upper toolbar.

Select the storage location (drive/directory) in the Save in list box.
Enter a <file name> in the File name text box.

Select Error messages from the Save as type list box.

AN SR

Click Save.
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Option CA

You can perform the following tasks when you add Option CA to the MPEG-2
DVB/ATSC/ISDB-S/ARIB System Analyzer:

B Unscramble stream components previously scrambled with either the DVB
or CCETT algorithm. The Analyzer supports fixed control words and
Viaccess ECMs. You must attach a PC2 Smartcard reader to the system
computer to perform Viaccess unscrambling.

B Analyze various characteristics of Viaccess-compliant EMM (Entitlement
Management Message) table sections in transport streams that contain DVB
or CCETT scrambled components.

Activating Option CA

If you purchased Option CA with your System Analyzer, it is already activated.
If you are adding Option CA to the analyzer, you must perform the following
steps to activate the option:

1. Exit the MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer if the
application is running.

2. Double-click the License Manager icon in the Tektronix MPEG Test
System program group window.

& Tektronix MPEG Test System

File Edit “iew Help

Deferred-Time  Multiplexer DVEBT
Analyzer Editc
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The Tektronix Software Protection window appears.

"s Tektronix Software Protection

To Enable Licensed Software Applications,
Fleaze Enter pour General Pazsword.
then Click 0K

Cancel |

3. Consult the password document supplied with your Option CA upgrade kit
and identify the General password. Enter the three 6-character Hexadecimal
numbers of the password in the corresponding Tektronix Software Protection
window entry fields (lowercase characters are acceptable) and then click OK.
A License message window appears.

4. If the password is correct, click OK to acknowledge the message. If you
made an error entering the password, click OK and return to step 2.

When you enter the correct password, Option CA is available the next time you
start the the System Analyzer.

Unscrambling with the MPEG-2 System Analyzer

To extract and save scrambled elementary stream files you must select the correct
unscrambling parameters.

1. Open the transport stream (.trp) file.

2. To perform Viaccess unscrambling with an attached PC2 card reader, use the
following procedure to load the EMM access rights into the PC2 card;
otherwise, continue to step 3.

a. Double-click the EMM icon to open an interpreted view of the Entitle-
ment Management Message section.

b. Select the PC2 dialog menu item, which is available when an EMM or
ECM interpreted view is selected. A window opens to display the
message Are you sure you want to send this EMM to the PC2 card?.

c. Click Yes to send the EMM. You can now proceed with Viaccess
unscrambling.

3. If Viaccess fixed control words were used to scramble the program of
interest, use the following procedure to discover the control words;
otherwise, continue to step 4.
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a. Double-click the PMT icon for the program to open an interpreted view
of the program map table.

b. In the PMT interpreted view, locate and double-click the CA descriptor
field to open a descriptor window. Then identify the CA PID (7D2 in the
example).

= geramb1 TRP -> PMT (PID 22 - Program 2] ==

i | [reserwed | [PCE PID)| |reserved | | program

infio length
o J[owac [[owF [ ows || EEETEEN
Conditional access ﬂ
descriptor tag 0=9
descriptor length O=4
CA gsystem ID 00
reserved |
CAPID
private data bytes
h
4] | H o4

Kl I'lj!

c. Double-click the ECM icon to the right of the TS icon identified with the
CA PID.

An interpreted view of the ECM section opens and the PC2 dialog menu
item becomes available.

d. Select the PC2 dialog menu bar item to retrieve the control words from
the PC2 card reader.

MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer 3-79



Option CA
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e. Carefully copy the control words that appear in the resulting PC2 dialog
window for use in step 9 below; then click OK to close the window.

If Unscrambling does not appear on the Analyzer menu bar, select Unscram-
bling from the Options menu to create the menu bar item.

Click the Unscrambling menu bar item to open the Unscrambling parameters
window.

Unscrambling parameters

— Unszcrannbling algonthm

+ CCETT " DVE

— Unscrambling mode

 Automatic

" Fired ECM
PID Mumber : ID—
ECH_=ID ([PROGSCR_ECKZ_=ID in progress scrambling) - IIJ_
FROGSCR_ECM1_HID : I‘I_

% Fixed Control wards

Even CW [Even CW2 in progress scrambling] : 0= IFFFFFFFFFFFFFFFF
0dd Cw [0dd Cw2 in pragress serambling) | 0 IFFFFFFFFFFFFFFFF
Even O [in progress scrambling) : 0x |FFFFFFFFFFFFFFFF
Ddd C1 [in pragress scrambling] : O [FFFFFFFFFEFFFFFF

[ 1]

Cancel |

6. Select either the CCETT or DVB unscrambling algorithm.

Select Viaccess to use a PC2 card reader. (The reader must be attached to the
COM1 port of the host computer.)

Select the unscrambling mode that is appropriate to the scrambling used
during transport stream generation/encoding.

NOTE. The Automatic and Fixed ECM unscrambling modes are available only
when Viaccess is selected.

Automatic. Select Automatic unscrambling mode when stream components
have been scrambled with control words transported in the ECMs quoted in
the PMTs. The Analyzer looks for the ECM demultiplexing information in
the PMTs and, where necessary, the demultiplexed ECMs are sent to the PC2
card to decrypt the control words so they can be used for unscrambling.
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Fixed ECM. Select Fixed ECM unscrambling mode when stream compo-
nents have been scrambled with control words transported in special PID and
ECM XID (PROGSCR ECM1 XID and PROGSCR ECM2 XID in
progressive scrambling) ECMs. The Analyzer looks for the ECMs and, if
necessary, they are sent to the PC2 card to decrypt the control words so they
can be used for unscrambling.

Fixed Control Words. Select Fixed Control Words unscrambling mode
when stream components have been scrambled with user-specified control
words. In this case, you must also enter the hexadecimal control words: Even
CW and Odd CW for standard unscrambling; or Even CW1, Odd CW1,
Even CW2 and Odd CW?2 for progressive unscrambling.

9. If you selected Automatic unscrambling mode, proceed to step 10.

If you selected Fixed ECM unscrambling mode, enter the associated

parameters.
& Fived EChE
PID Murmber : ID
ECh_»I0 ([PROGSCR_ECMZ_¥ID in progress scrambling) © ID
PROGSCR_ECM1_¥ID |1

If you selected Fixed Control Words unscrambling mode, carefully enter the
appropriate control words.

Ewen CW [Even CW2 in pragress scrambiling] : 0 IFFFFFFFFFFFFFFFF
Odd O/ [0dd Cw/2 in progress scrambling) : 0 IFFFFFFFFFFFFFFFF

Ewer Cw 1 [in progress scrambling) : Ox IFFFFFFFFFFFFFFFF
0dd Cw1 [in progress scrambling) : Ox IFFFFFFFFFFFFFFFF

10. Click OK to confirm your selections and close the Unscrambling parameters
window.

Once you have entered the appropriate parameters for the open transport stream
file, you can analyze scrambled stream components and save scrambled
elementary streams.
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EMM Selection

To conduct EMM analysis on a transport stream (.trp) file, you must enable
Option CA (if necessary, refer to Activating Option CA on page 3-77), start the
MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer (Deferred-Time
Analyzer), and open a .trp file. Once a file is opened in the analyzer application
window, there are four choices available on the Analysis EMM submenu: EMM
selection, Diffusion rate, Diffusion holes, and Discontinuity. These choices also
appear on the EMM hierarchy icon shortcut menu; right-click the icon to open
the shortcut menu.

Liynamic 4 %
Automatic —

EMM selection Selection
Diffusion rate Diffugion rate
Diffusion holes Diffusion holes

Discontinuity Discantinuity

Analysis EMM submenu EMM shortcut menu

Use EMM selection first to specify the type(s) of EMM to analyze and the
portion of the stream to examine. Then select the type of analysis to perform.
You can initiate analyses through the shortcut menu only if the CA system (as
identified in the CAT descriptor) is France Telecom’s Viaccess system.

NOTE. You can perform analyses on non-Viaccess EMM sections through the
Analysis EMM submenu, but the analysis results may not be accurate.

EMM selection allows you to choose EMM types (U, S, GH, or GA) and to
select a particular portion of the transport stream for EMM analysis. The
Analyzer uses these settings during diffusion rate, diffusion hole, and discontinu-
ity analysis.

You can initiate EMM selection from either the Analysis menu or the EMM
hierarchy icon shortcut menu (right-click to open the shortcut menu).

Bynamic 4 ﬂ

Autoratic Section

\E MM selection W
Diffusian rate iffusion rate

Diffugion holes Diffusion holes
Discontinuity Digcantinuity
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Both methods open the same EMM Viaccess selection panel window. Notice that
the default selection is all EMM sections in the transport stream (.trp) file.

EMM Yiaccess selection panel
— EMM type —PID EMM transport packet
& ; & Al packets
¥ EMMS ™ Packets zelection

Beginning packet : I‘I
¥ EMMGH Anna

¥ EtM Ga

End packet : IEISEID2

Ok I Carcel |

1. In the EMM type panel, select the type(s) of EMM you intend to analyze.
There are four types:

EMM U: packets individualized for one customer.
EMM S: packets intended for a small number of customers.
EMM GH: packets for a group of customers.

EMM GA: packets for all customers.

2. To limit the portion of the transport stream for EMM analysis, choose
Packets selection and then enter the beginning and ending packet number.
The default beginning packet is the first transport packet in the .trp file; the
default end packet is the last transport packet in the file.

3. Click OK to confirm your choices and close the window.
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In diffusion rate analysis, the analyzer calculates EMM diffusion rates based on
your EMM selection choices. If you make no EMM selection choices, the
analyzer calculates diffusion of all EMM sections in the stream.

You can initiate diffusion rate analysis from either the Analysis menu or the
EMM hierarchy icon shortcut menu (right-click to open the shortcut menu).

®  Shortcut Menu. Select the Diffusion rate command from the shortcut

menu. If the defining CAT descriptor designates the CA system as France
Telecom (ID 1280), the Transport Stream Property window opens. If the CA
System ID is not 1280, the following message appears:

EMM Diffuzion Ratez Analysiz

& Impozsible, the conditional accass sustem must be Viacosss

In this case, initiate diffusion rate analysis through the Analysis menu as
described below.

Analysis Menu. Open the Analysis menu and select EMM; then select
Diffusion rate from the EMM submenu. The Analysis EMM — Diffusion
rates window opens.

Analyzis EMM - Diffuzion Rates

PID Mumber : IIJ

¥ “iaccess system

Cancel |

Select Viaccess system to instruct the analyzer to interpret the EMMs in
accordance with the France Telecom CA system. Enter the PID of the EMMs
that you want to analyze; then click OK to confirm your selections and
conduct the analysis.
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If the analyzer has not conducted a transport stream multiplex rate analysis since
you opened the .trp file, the Transport Stream Property window opens.

Transport Stream Property

Mus Rate [bits/z)

Murber of pragranns 2
ok I Cancel

If necessary, enter the exact multiplex (Mux) rate and click OK. In the example,
the exact multiplex rate is 10,000,000 bit/s instead of 9,999,999 that the analyzer
calculated from the first ten PCRs found in the transport stream.

NOTE. Because the sample used is small and the precision of the number high,

there can be error in the calculation. To ensure maximum accuracy of analyses
that use the multiplex rate to calculate results and detect errors, you can enter
the actual multiplex rate in the dialog box.

When you initiate the analysis, the EMM Diffusion Rates window opens in the
application window.

BB EMM Diffusion Rates of scramb1_TRP [FID 2000) =]
B
Selection parameters | EMM T, EMM 5, EMB GH, EMBM G4 | for all packets.
Fate (EMMisec) | Hurber of EM M
Diffusion Secondes er Lo 4 EMM 17 |400.725117390 &021
EMIM 3 0.000000000 o
EMM GH| 0.000000000 a
EMM GA | 0.000000000 1]
Glchal |400.725117320 a0zl
y Secondes
o 1 2 3 4
e il e =
a - J
F et et et e » EMIL T
» EMIL S hd
al | H

The display lists (in blue characters) the EMM selection parameters applicable
during diffusion rate calculation.
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The table on the right side of the view lists the results of the diffusion rate
calculation as well as the number of EMMs found for the calculation. The last
line in the table lists the overall EMM rate and number for all EMM types
combined.

A graphic representation of analysis results occupies the remainder of the
window.

Symbol Represents
g

-

§ i

All EMMs of one type transmitted during a given second

== | Diffusion holes at the start and end of a given second

Diffusion of EMMs during a given second

On the time plot, EMMs are grouped by second and by type. The presence of an
EMM icon on the axis for a particular EMM type, indicates that at least one
EMM of that type was transmitted during the second in question. Where no icon
appears, no EMMs were transmitted during this second.

Double-click an EMM icon to display information about the represented EMMs.

TRE iaeo ERE
B =] =g
W F| W F| |EegF

W M M L of the seconde 1

Number of EMM 1 395
First EMM number 1
Last EMM number 13956
[ First EMM date 1 0.015971202 sec
Last EMM date » 0.967964899 sec

Double-click a Hole symbol to display the Hole duration.

iy i i i

e [ [ W

17 l~1F [§v17 |~
=t == =t =

kMM U diffusion hole of the seconde begin 1

Hole length : 0.015971202 sec
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Double-click a Diffusion symbol to display the diffusion duration.

Wy W40 Wy By
il [E® = i
EMR! U diffusion time of the seconde 1

Diffusion time : 0.971993697 sec

As in other item views, you can use the Edit (lower) toolbar command buttons to
display subsequent seconds and navigate among results displays.

Diffusion Rates Algorithm. The algorithm used to calculate diffusion rates for the
different EMMs is as follows:

For a given selection, X is the selection start packet position and Y is the
selection end packet position. If the selection includes all EMM PID TS packets,
then X = 1 and Y = the position of the last EMM PID TS packet.

PID_EMM = CAT(Eurocrypt);
nb_EMM U = 0;

nb_EMM S = 0;
nb_EMM_GH = 0;
nb_EMM_GA = 0;

nb_EMM _total = 0;

nb_TS_ packets =0;

Do for all TS packets in the TS stream from packet X to packet Y

nb_TS_packets++;
if PID of packet TS == PID_EMM & payload_unit_start_indicator==1(i.e.
start of EMM) then

select case according to EMM type:
EMM_U : nb_EMM U++;
EMM_S : nb_EMM_S++;
EMM_GH : nb_EMM_GH++;
EMM_GA : nb_EMM_GA++;
end select;

end if;
end do;

EMM_U _rate = (Stream_rate/nb_TS_packets)*nb_ EMM_U;
EMM _S rate = (Stream_rate/nb_TS_packets)*nb_EMM_S;...
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In diffusion analysis, the analyzer searches for and identifies EMM diffusion
holes. The search is carried out based on your EMM selection choices (see EMM
selection on page 3-82). If you make no EMM selections, the analyzer searches
the entire transport stream (.trp) file. You can initiate diffusion hole analysis
from either the EMM hierarchy icon shortcut menu or the Analysis menu.

Shortcut Menu. If you know that the transport stream uses the France Telecom
Viaccess CA system, right-click the EMM hierarchic view icon to open the
shortcut menu; then select the Diffusion holes command. An Analysis EMM —
Diffusion Holes window opens.

Analysic EMM - Diffugion Holes

Holes length : ID 3EC

Cancel I

Enter the minimum duration hole to search for and then click OK. If the CA
system identified in the CAT is not Viaccess, the following message appears:

EMM Diffuzion Ratez Analysiz

& Impozsible, the conditional accass sustem must be Viacosss

In this case, initiate diffusion rate analysis through the Analysis menu, as
described below.
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Analysis Menu. To initiate diffusion hole analysis through the Analysis menu,
open the menu and select EMM; then select Diffusion holes from the EMM
submenu. Another Analysis EMM — Diffusion Holes window opens.

Analysic EMM - Diffugion Holes

PID Muriber : IIJ
Haoles length : IIJ 368G

V¥ “iaccess system

Enter the appropriate EMM PID and the minimum hole duration to search for.
Select Viaccess system to instruct the Analyzer to interpret the EMMs in
accordance with the France Telecom CA system. Click OK to confirm your
choices and start the analysis.

If you have not performed an analysis (since opening the .trp file) that calculates
the transport stream multiplex rate, the Transport Stream Property window opens
as shown on page 3-85. If necessary, enter the correct multiplex rate and click
OK to continue.

If the analyzer finds diffusion holes longer than the minimum duration, an EMM
Diffusion Holes view appears.

{8 EMM Diffusion Holes of scramb1. TRF (PID 2000) =]

| EMM diffision holes view higher than 0000500000 see |

Selection parameters | EMM U, EMM &, EMDB GH, EMB G, for all packets,

Diffusion Holes momber 1 to 4

Wy Wy Wy U U Wy o W
[ 8- 8- - - I I -
' ’ ' ’ ' ’ ' ’ » Holes

4] | Ay

The display lists (in blue characters) the EMM selection parameters applicable to
the diffusion hole search. A graphic representation of analysis results occupies
the remainder of the window.
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Analysis

Symbol Represents
iﬂ?:to An EMM at the start or end of a diffusion hole
o

———r— | An EMM diffusion hole

Double-click an EMM icon to display information about the EMM at the
beginning or end of a diffusion hole.

FIE Wi Wi W_p—i
[ [ W [
- S T ] O R CEN

EMM of the Hole beginning number 1

EMM type : EMM U
EMM Number o1
EMM date : 0.015971202 sec

Double-click the Hole symbol to display the Hole duration.

W) (o] [Ws—] [B—] [F4—
=d =d led e e-q
Lt T T O i O " s O ¥

Hole* number 1

Hole length : 0.000024800 sec

As in interpreted views, use the Edit (lower) toolbar buttons to display subse-
quent EMM diffusion holes.

In diffusion discontinuity analysis, the analyzer searches for EMM diffusion
discontinuities. The search is carried out based on your EMM selection choices
(see EMM selection on page 3-82). If you make no EMM selections, the
analyzer searches the entire transport stream file.

The analyzer can search for two discontinuity types:

B Address discontinuity, in which type U or type S EMM destination addresses
are not increasing and sequential. The search can be for increasing (but not
sequential) addresses, or for all increasing, decreasing and equal addresses.

®  Type discontinuity: The analyzer searches EMMs off all types for EMM type
transitions.

You can initiate diffusion discontinuity analysis from either the EMM hierarchy
icon shortcut menu or the Analysis menu.

MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer



Option CA

Shortcut Menu. If you know that the transport stream uses the France Telecom
Viaccess CA system, right-click the EMM hierarchic view icon to open the
shortcut menu; then select the Discontinuity command. An Analysis EMM
window opens.

Analysis EMM - Diffusion Discontinuitys

Discontinuitys type to search
i |ncreasing addresses
 Increasing, Decreasing and equals addiesses

™ EbM Tupes

Cancel

Select the type of discontinuity to search for and then click OK. If the CA
system identified in the CAT is not Viaccess, the following message appears.

EMM Diffuzion Ratez Analysiz

& Impozsible, the conditional accass sustem must be Viacosss

In this case, initiate discontinuity analysis through the Analysis menu as
described below.

Analysis Menu. Open the Analysis menu and select EMM; then select Disconti-
nuity from the EMM submenu. Another Analysis EMM window opens.

Analpzis EMM - Diffusion Discontinuity s

PID Mumber : ID

Discontinuitys bope to search

& |ricreasing addresses
el Ihcreasing, Decreasing and equals addiesses

 EMM Types

V¥ Wisceess System

Cancel I
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Enter the appropriate EMM PID and select the discontinuity type to search for.
Select Viaccess system to instruct the analyzer to interpret the EMMs in
accordance with the France Telecom CA system. Click OK to confirm your
choices and conduct the analysis.

If you have not performed an analysis (since opening the .trp file) that calculates
the transport stream multiplex rate, the Transport Stream Property window opens
as shown on page 3-85. If necessary, enter the correct multiplex rate and click
OK to continue.

If the analyzer finds discontinuities in the stream, the EMM Diffusion Disconti-
nuities view opens.

B8 EMM Diffusion Discontinuiltys of seramb1_TRP (FID 2000)

a
| EMM diffision discontumntys view on increasing, decreasing or equals addresses | A

Selection parameters | EMM U, EMB 5, EMB GH, EMM G, for all packets.

Diffusion Discontiznatys manber | to 4

By By B_p—o ) Iy
[P [P [P "] W~
o f| [Eegf] [Eapf] [{egf |8
. . . . ' 3 Discontimitys

4] | Ay

The display lists (in blue characters) the EMM selection parameters applicable to
the diffusion discontinuity search. A graphic representation of analysis results
occupies the remainder of the window.

Symbol Represents
EE?-;I An EMM at the start or end of a discontinuity

——— | A diffusion discontinuity
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Double-click an EMM icon to display information about the EMM at the
beginning or end of a discontinuity.

gm0 Bpmi FRE FRE
(e =g g g
B~ F [Ee ] [EsgE B~ F

EMM of the Digcontinuity beginning number 1

EMM type : EMM_U

EMM Number 1

EMM date : 0.0165971202 sec
EMM address : 0x 00 BE BC 20 0B

Double-click the Discontinuity symbol to display the Discontinuity type and
duration.

) e e B CE)
g BN g g [
g~ 7 [8~17 @7 (@17 [E-1F

Discentinuity number 1

Discontinuity type : On decreasing ort
Discontinuity length : 0.000024800 sec

As in other item views, you can use the Edit (lower) toolbar command buttons to
examine subsequent discontinuities.
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DVB Channel Coding and Decoding

The European Digital Broadcasting Project (DVB) specifies a baseline system
for satellite broadcasting. The transport stream channel coding portion of the
specification has the following flow:

m  MPEG-2 Transport stream file (Multiplexer)

®  Energy Dispersal — randomizing

B OQuter Coder RS (204, 188) — for byte error correction
B Interleaver — better burst error correction

®m  Inner Coder (Viterbi p/q) — bit error correction

B QPSK Modulator

The DVB Channel Coding and Decoding application also provides decoding to
return the coded file to a standard transport stream file.

Table 3-29 lists the type of coding/decoding, the type of input expected, and the
resulting file.

Table 3-29: Expected input file types

Operation Expected input Output
Energy Dispersal *trp *.eds
Reed-Solomon *.eds *res
Byte Interleaving *.res *.inl
Viterbi Encoding *.inl *vib
Byte Deinterleaving *.inl *.din
Reed-Solomon decoding *din *drs
Energy Dispersal removal *drs *.edr
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Starting the Application

Double-click the DVB channel Coding & Decoding icon in the Tektronix
MPEG Test System program group window to start the application. The
application window opens as shown below.

e . DYH Channel Coding & Decoding M= E3
Menubar — | Elle  Coding  Decoding  Generation  Help

Duration gauge ‘ 0%

TeKktronix
/

MTS Series

Screens srd Progmem Copynight
Thomcast

Status bar —— |

Menu Bar. Use the cursor to access the application main menus.
Duration Gauge. Displays the coding or decoding process status in percent.

Status Bar. Displays a brief explanation of a menu entry when you position the
cursor over a menu selection in the Menu bar.
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Menu Commands

Figure 3-30 lists the DVB Channel Coding and Decoding menu commands.

Table 3-30: DVB Channel Coding and Decoding menu commands
Menu Commands Function
File Quit Exits the Coder/Decoder application
Coding Chain Defines a list of coding modules
Energy Dispersal Defines and performs Energy Dispersal coding on a
selected file
Reed-Solomon Defines and performs Reed-Solomon coding on a
selected file
Interleaver Defines and performs Interleaver coding on a selected
field
Viterbi Defines and performs Viterbi coding on a selected file
Decoding | Chain Defines a string of decoding modules for a file
Delnterleaver Decodes a file for Interleaver coding
Reed-Solomon Decodes a file for Reed-Solomon coding
Energy Dispersal Decodes a file for Energy Dispersal coding
Removal
Generation | Pattern Generates a user-defined repetitive pattern and puts it in
afile
Transport Packet Generates a user-defined pseudo transport packet and
puts it in a file
Help Contents Open a Help window and display the table of contents
Using Help Provides general information on how to use the Help
system
About... Displays the application version and copyright

File Menu

Qluit
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Coding Menu

The Coding menu provides access to the required DVB channel coding for
satellite broadcasting (Energy Dispersal, Reed-Solomon, Interleaver, and
Viterbi). It also provides for chaining the various coding methods together.

Chain

Erergy Dispersal
Eeed-Solomon
Interleawer
“iterhi

Chain. The Chain command opens the Coding Chain dialog box, which allows
you to create DVB-compliant files.

Each check box defines one module in the coding chain. When all check boxes
are selected, the coding will produce a DVB-compliant file. If you deselect any
of the check boxes, you will generate a non-compliant file. (This feature is
provided for testing purposes.)

Coding Chain =]

—Coding Chain

¥IEnergy Dispersal
FIReed-Solomon(204.188)

¥ Interleaver

Cancel |

NOTE. If Energy Dispersal is not selected, it is replaced by a “B8 sync byte add
only” module in the chain.

When you select OK, the Open dialog box appears. Identify the file to code.

Although all file types (*.*) are available, the expected transport stream file type
for DVB compliance is *.trp. Use a file created by the Multiplexer application or
acquire one from a transport stream input through a rear-panel connector.

Select OK to initiate the coding process. Each coding module is performed in
the order given in the dialog box. During the coding process, a gauge in the
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Application Window reports the coding status. The gauge range is 0% to 100%
for each type of coding.

NOTE. To stop the coding process at any time, press the ESC key. This ends the
coding with the current coding module.

The READY statement in the status bar indicates that the coding process is
complete for the selected modules. There are now three additional files in the
original directory with the transport stream file. The new files share the original
name with the following extensions: *.eds, *.res, and .*ini.

For more information on individual coding modules, see Energy Dispersal
Coding on page 3-107, Reed-Solomon Coding on page 3-108, and Convolution-
al Interleaving Coding on page 3-108.

Energy Dispersal. The Energy Dispersal command allows you to use this coding
scheme alone, instead of in conjunction with the other code modules using the
Chain command. This module performs sync byte inversion for the first of each
group of eight transport packets, and randomizing of data using a PRBS (Pseudo
Random Binary Sequence). For more information on the actual coding, refer to
Energy Dispersal Coding on page 3-107.

Selecting Energy Dispersal opens the following dialog box.

Open [ 7]
File: name: Folders: o
IE cihmts200%cfg-p -
Cancel
ICFG.ND, - = = —I
Complex-gm (= MT5200
complex.
complex TRP E=r CFG-TRP
DEFALLT BAT
DEFAULT.EIT
DEFAULT.MIT -
DEFALILT.PMT d| |

Lizt files of bype: Dinves:

|40 types () x| [=Ecwtsim =] Netmork...l

This first byte of the selected input file should be the first byte of a transport
stream packet file (the sync byte, 47ygx). The input file should be a*.trp
transport stream file. Other file types are permitted, as long as they meet the sync
byte requirement, however.

Click OK to begin the coding process. A gauge in the Application Window
states the coding process status. When the gauge reads 100% and READY is
displayed in the Status bar, the coding process is complete.
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Completion of the coding results in a file with the same base name as the
original, except the extension is *.eds.

If you select a file that is inappropriate for Energy Dispersal, coding will occur
anyway. You can stop the coding process at any time by pressing the ESC key.

Reed-Solomon. Reed-Solomon coding takes the randomized transport packet
(from the Energy Dispersal coding) and adds 16 bytes to the field. (188 initial
packet size + 16 bytes of Reed-Solomon = 204 bytes.) For a more detailed
explanation of Reed-Solomon coding, see Reed-Solomon Coding on page 3-108.

The Reed-Solomon dialog box is displayed after choosing this command. Enter
the desired Coded Block Size and Size of Block to Code in the appropriate text
boxes. The maximum for both parameters is 255. The default values (204 and
188) are correct values for DVB.

Coded Block Size :
204

Size of Block to Code :
188

Ok | Configurationl Cancell

If you choose the Configuration command, the Reed-Solomon Configuration
dialog box appears.

Reed-Solomon Configuration | ]

Field Generator Polynomial P :
Dx‘a+ E X7 + EIX"B+ Ex‘5+ Dx‘zn Dx‘3+ Dx‘2+ Exﬁ + D

First Root of Code Generator Polynomial G{x) :

alpha

Cancel |

Use the Reed-Solomon Configuration dialog box to define different values for
p(x) (the Field Generator Polynomial) and alpha, which is the first root of p(x).
The default values are correct for DVB applications.
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When the configuration is complete, return to the Reed-Solomon dialog box by
selecting OK. If you are ready to code a file, select OK. This returns the Open

dialog box. The coding module accepts *.eds files (previously Energy Dispersal
coded) only.

Select a file and enter it in the File Name text box; then click OK. This initiates
the Reed-Solomon coding process. The Application Window gauge tracks the
progress of the coding process. When coding is complete, the gauge reads 100%
and the Status bar reads READY.

The coding process outputs a file with the original name and an added *.res
extension.

Interleaver. This module performs convolutional byte interleaving. See
page 3-108 for more information on this coding process.

When you choose the Interleaver command, the Open dialog box appears. There
are no parameters to adjust for this coding module.

The Interleaver requires a *.res file (a file previously Reed-Solomon encoded).
After selecting a file to code, click OK. This starts the Interleaver coding
module.

A gauge in the Application Window monitors the coding progress. Coding is
complete when the gauge reads 100% and the Status bar reads READY. Interleav-
er coding results in a file with the same base name as the selected file, except the
extension is *.inl.

Viterbi. Viterbi performs inner coding based on the Viterbi punctured convolu-
tional code. For more information on this coding process, refer to Viterbi Coding
on page 3-109.

NOTE. This application does not provide a method to decode Viterbi coding.
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When you select Viterbi, the following dialog box appears.

clig c2a3 34 &8

cancal|

Use the Viterbi dialog box to select the Viterbi Code. The code can be 1/2, 2/3,
3/4, or 7/8 (the default is 7/8). When you click OK, the Open dialog box
appears.

Use the Open dialog box to select a file for Viterbi coding. The expected file
type is an *.inl (Interleaver coding result). Once you select the file, click OK.
This begins the Viterbi coding process.

A gauge in the Application Window tracks the progress of the coding. The
coding is complete when the gauge reads 100% and the Status bar says READY.
The output of this module is a file with the same base name as the original file,
but it now has *.vtb as the extension.

Decoding Menu  The Decoding menu provides access to the required DVB Channel Decoding for
satellite broadcasting (Deinterleaving, Reed-Solomon Decoding, and Energy
Dispersal Removal). It also provides for chaining the various decoding methods
together.

Decoding
Chiain

Deintarleaver
Eeed-Solomon
Energy Dispersal Removal
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Chain. With the Chain command, you can decode the transport stream file using
the DVB-compliant method. The figure below shows the dialog box associated
with the Chain command.

Decoding Chain | ]

—Decoding Chain

[V Delnterleaver
¥ Reed-Solomon(204,188)

¥ Energy Dispersal Remowal

Cancel |

You can deselect any of the check boxes, however, all boxes must be checked to
generate a DVB-compliant file. You purposely deselect modules to create DVB
non-compliant files for testing purposes.

Choose OK to begin Chain decoding. A gauge in the Application window
reports the progress of each decoding operation. All chain decoding is complete
when the gauge reads 100% and the status bar says READY.

If the Energy Dispersal Removal module is not selected, it is replaced by a B8
sync byte removal module in the chain.

To stop the decoding process at any time, press the ESC key. This ends the entire
decoding chain with the current module.

Deinterleaver. When you select the Deinterleaver command, the Open dialog box
appears. The expected input file is one generated by the Interleaver coding
module (*.inl), although the Deinterleaver module will accept any file.

When you click OK, Deinterleaving begins. A gauge in the Application window
reports the decoding process status. Decoding is complete when the gauge reads
100% and the Status bar says READY. The resulting file has the same name as
the original, with the extension *.din added.

To end the decoding at any time, press the ESC key.
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Generation Menu

3-104

Reed-Solomon. When you select the Reed-Solomon command, the Open dialog
box appears. The expected input file is one generated by the Deinterleaver
coding module (*.din).

When you click OK, Reed-Solomon decoding begins. A gauge in the Applica-
tion window tracks the decoding process status. Decoding is complete when the
gauge reads 100% and the Status bar says READY. The resulting file has the
same name as the original, with the extension *.drs.

To end the decoding at any time, press the ESC key.

Energy Dispersal Removal. When you select the Energy Dispersal Removal
command, the Open box appears. The expected input file is one generated by the
Deinterleaver coding module (*.drs), although this decoding module will accept
any file type.

When you click OK, Energy Dispersal Removal decoding begins. A gauge in the
Application window tracks the decoding process status. Decoding is complete
when the gauge reads 100% and the Status bar says READY. The resulting file
has the same name as the original, with the extension, *.edr added.

To end the decoding at any time, press the ESC key.

The Generation menu allows you to create new *.trp files by defining a pattern
or transport packets.

Generation

Eatam
Transpor Packets

Pattern. This command generates a user-defined pattern. When you select the
Generation Pattern command, the Save As dialog box appears to name the file. A
default extension is not provided for the file name. However, if you enter a file
name without an extension, *.plp is automatically added.

Click OK to confirm the entry and close the dialog box. The Pattern entry box
appears; enter the number of bytes in the pattern and click OK.

Enter the number of bytes in the pattern

| |
OK I Cancel
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The Composition Motif entry box appears to define the repetitive pattern. Enter
the desired byte value in hexadecimal. One Composition Motif dialog box
appears for each byte you specified in the pattern.

Click OK to confirm the entry and close the dialog box.

Composition Motif | ]
Byte number 1

OK Cancel |

The Pattern entry box appears. Define the number of times you want the pattern
to repeat; then click OK.

Number of Pattern repetitions

OK Cancel |

The pattern is created and stored in the file specified above.

Transport Packet. This command generates a repetitive pattern of user-defined
transport packets.

When you select the Transport Packet command, The Transport Packets dialog
box appears to define the payload or to have random data loaded.

Transport Packets | ]
[T CCITT 2715-1

Transport Packet Header {in hexadecimal) :

Payload (in hexadecimal) :

x 184 bytes

Cancel
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If you select the CCITT 2"15-1 check box, random data is generated for the
payload. If you set the value of the first text box under the Transport Packet
Header, the last three text boxes will be dimmed. The default value of the first
text box is 47. You can also enter a value.

If the CCITT 2"15-1 check box is not selected, you can define the values of all
text boxes under the Transport Packet Header. The default value is 47 00 00 00.
You must define the payload, which is then repeated 184 times. Click OK to
confirm the selections.

The Number of Packets dialog box appears.

Number of Packets | ]
Enter the number of Transport Packets

OK Cancel |

Enter the number of transport packets in the transport stream; then click OK.
The Save As dialog box opens to name the file. A default extension is not
provided for the file name. However, if you enter a file name without an
extension, *.plp is automatically added.

Click OK, the application creates the desired transport stream file. When the
Gauge reads 100%, the transport stream file is complete.

Help Menu  The Help menu commands provide access to the Help system.

|
Contents
 UsingHelp

About MPEG2 DWE Channel Coder and Diecoder

Contents. Displays the Help system table of contents.
Using Help. Provides information on how to use the Help system.

About MPEG2 DVB Channel Coder and Decoder. Displays the application version
and copyright.
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Coding Types

This section defines the application coding types.

Energy Dispersal Coding  This is the first coding module and last decoding module.

The input of this coding module is an MPEG-2 transport stream, which is a
concatenation of packets of 188 bytes (1 sync byte plus 187 data bytes).

SYNC
1 byte

T

4THex

187 bytes

To comply with DVB and ensure adequate binary transitions, the data from the
MPEG-2 multiplex (transport stream file) is scrambled with a Pseudo Random
Binary Sequence (PRBS). The processing order at the transmitting side always
starts from the Most Significant Bit (MSB) of the synchronization byte (0 of
01000111).

The polynomial for the PRBS generation is : X3 + X14 + 1. It uses the 15-bit
shift register illustrated below for scrambling and descrambling (in the channel
coding process).

4‘ 1‘ 2‘3‘4‘5‘6‘ 7‘ 8‘ 9‘10‘11‘12‘13‘14‘15

)

Enable — / w Scrambled/descrambled
Clear/scrambled data output

data input

At the start of every eighth transport packet, the sequence 100101010000000
loads into the shift register. This provides an initialization signal for the
descrambler. The MPEG-2 sync byte (for the first transport packet in the group
of eight packets) is then inverted bitwise from 47ggx to B8ggx. The first bit at
the output of the PRSB generator is applied to the first bit (MSB) of the first
byte following the inverted MPEG-2 sync byte (BSggx).
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To optimize synchronization of the subsequent seven transport packets, PRSB
generation continues with its output disabled, leaving these bytes unrandomized.
Thus the period of the PRSB sequence is 1503 bytes as shown below.

‘88’ 187 randomized bytes ‘47 187 randomized bytes | 47 | 187 randomized bytes i B8| 187 randomized bytes
L

8 randomized transported packets

Reed-Solomon Coding  The Reed-Solomon RS (204, 188) code corrects up to 8 bytes in a 204 byte
block. This module takes each randomized transport packet at the output of the
Energy dispersal module and produces 204 bytes by calculating and adding 16
bytes at the end of the packet (188 bytes).

The Reed-Solomon calculates in a Gallois Field generated by the polynomial:
px) =x8+xt+x3+x2+1

The RS code generator polynomial (used for the 16 byte calculation) is:
g(x) = (x + a¥(x + al)...(x + ald)

where o = 02px

The RS (204,188), shortened code from the original RS (255,239), is implement-
ed by adding 51 bytes, all set to zero, before the information bytes (a transport
packet) at the input of an RS (255, 239) encoder. After the RS coding procedure,
these null bytes are discarded, and the transport packet remains as shown in the
following illustration.

‘ B8’ 187 randomized bytes ‘ 16 bytes

Convolutional Interleaving  Convolutional Interleaving, with depth I = 12, is applied to the error protected
Coding  packets. The following is a conceptual diagram of the Interleaver.

0

1717 =M cells .
2
Interleaver °_{ 17x2 cells }—.

input

Interleaver
output

.11_{ 17x11 cells e

3-108 MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer



DVB Channel Coding and Decoding

The Interleaver has 12 branches, cyclically connected to the input byte-stream by
the input switch. Each branch is a FIFO shift register, with depth (MJ) cells.

where M =17 or N/I
N = 204 the error protected frame length
I = 12 the interleaving depth
J = branch index

The cells of the FIFO contain 1 byte, and the input and output switches are
synchronized.

For synchronization purposes, the sync bytes and the inverted sync bytes are
always routed in the branch “0” of the Interleaver (corresponding to a null
delay).

The Deinterleaver is similar to the Interleaver, but the branch indexes are
reversed (j = 0 corresponds to the largest delay). The deinterleaver synchroniza-
tion can be carried out by routing the first recognized sync byte in the “0”
branch. The following diagram shows the interleaved transport packets.

‘ B8 ’ 203 interleaved bytes ‘ 47 | 203 interleaved bytes

Viterbi Coding  The inner coding is based on a Viterbi punctured convolutional code as
diagrammed below.

T 3

Datainput—»‘ 1‘ 2‘ 3‘ 4‘ 5‘ 6‘ 7‘ > Data output

& 3

Each byte of the input stream (MSB first) loads in a 7 (K = 7, constant length)
bit shift register. It then executes two polynomial operations. To produce a p/q
code (q output bits for p input bits) a “puncture’ is applied to the output of the
1/2 coder.

For example, in 7/8 mode, 7 bits produce 14 bits of 1/2 code and only 8 are
transmitted. (The puncture pattern for 7/8 is 11010101100110.)
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The TMCC (Transmission and Multiplexing Configuration Control) Deferred-
Time Client application allows you analyze the TMCC data of an ISDB-S/ARIB-
compliant transport stream stored on your local disk.

The TMCC Deferred-Time client has the following characteristics:

®m  Indicates the presence of sync bytes (0x47 for TMCC basic streams and W1,
W2, or W3 sync bytes for TMCC data streams)

®  Displays the syntax of TMCC data
m  Displays Slot, TSID, TS Name, and Modulation mode information
®  Displays information, warning, and error messages

B Indicates the presence of TMCC alarm and update flags in the transport
stream

®  Displays the overall stream rate

The TMCC Deferred-Time Client displays the results of the file specified in the
Input panel of the TMCC Configuration Client.

This section describes the TMCC Deferred-Time Client in the following

subsections:
B TMCC Deferred-Time Client Display Elements page 3-112
B Using the TMCC Deferred-Time Client page 3-118

To start the TMCC Deferred-Time Client, select the icon from the Tektronix
MPEG Test System program group window. Both the TMCC Deferred-Time
Client and the TMCC Configuration Client start, and a TMCC Analysis Server
icon appears in the system tray.

NOTE. In order for the TMCC Deferred-Time Client to display analysis results,
you must first specify the stream type (S_TMCC or M_TMCC) and rate from the
TMCC Configuration Client (usually the rate is automatically detected when the
TMCC Configuration Client opens the transport stream file).

MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer 3-111



TMCC Deferred-Time Client Reference

Using the TMCC Deferred-Time Client Display Elements

The following figure shows the different elements of the TMCC Deferred-Time

Client display.
Title bar 4 TMCC Expert Client [_ O] %]
:
Toolbar ——= 5- 4 M2 File name: 4streams.trp I_?l
SvE elp
/ 7/
Slot|TS 1D |M0dulatiun - : Marre | Length | value |Interpretatinn
1 Jell S_TMCC Dats B4 B
: 2 & C=HEhio 7
] —]
n;:z/ < 'P Transmigsion mode & Slotinfo, 40
; @ Trans. Mode 1 4 15 resemved
. | - — @ M Slot1 4 63 more than 47 slot
Online help. —— 7 @ Trans. Mode 2 4 15 resenved
icon 2 @ Mh Slat 2 [ g3 maore than 47 slot
Slots — 19 @ Trans. Mode 3 4 14 reserved
view v @ Nb Siot 3 B 83 morethan 47 slof(
N @ Trans. Mode 4 4 15 resemved
Syntax—13 b G B3 morethan 47 slot(
view |12 @TIID 16 B5835 <
14
16 b
17 :
Raw data 13
view M
21 e W - e e e e e e e e e e e e e e e e e e e e e e e e e e e s e e e e e e e
22 i Type |Message |Date
gi : Infarmation |Synchranization detectad (1987 0222009
Messz_ige 35 Error Loss of Synchro, arigin: Unknown, 02/02/2001 =
view 26 Infarmation |Synchronization detected (188, 02/02/2001
7 14T ] ] |
Status bar . Dane Poszition: 1,316 /394 842 1128 Super frame: 3 Wersion: 2 Fate: 19.359 Mbsz Synchronized

Title Bar  The Title bar displays the name of the application (TMCC Expert Client).

The standard Windows NT window-sizing control boxes for the TMCC
Deferred-Time Client are located on the far right side of the Title bar.
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Toolbar  Table 3-31 lists the function of each toolbar navigation button. The Save button
allows you to save all or part of the transport stream file.
Table 3-31: Functions of the TMCC Deferred-Time Client toolbar buttons
Button | Name In the Slot panel In the Syntax panel
” First Displays the first slot configuration | Displays the first TMCC data
version
4 Previous | Displays the previous slot configu- | Displays the previous TMCC data
ration version
- Pause Stop the analysis, returning the Stops the analysis and displays the
view to the slot configuration from | current version of TMCC data (or
which the file was played the version from which the analysis
started)
[ Next Displays the next version of slot Displays the next TMCC data
configuration version
] Last Displays the last version of slot Displays the last TMCC data
configuration version
vy Goto Displays the Go To dialog box from | Displays the TMCC data version
which you specify a version of the | specified in the Go To dialog box
slot configuration you want to
display
File Name  Next to the toolbar buttons, the TMCC Deferred-Time client lists the file name
of the transport stream file being analyzed. This is the file specified in the
TMCC Configuration Client.
Help Icon  Click the Help icon to access online help for the TMCC Deferred-Time Client
and to identify the software version of the TMCC Deferred-Time Client.
Slots View  The Slots view (see Figure NO TAG) displays the properties of each slot using

three columns. The first column lists the slot numbers (1 through 48). The
second column shows the TSID (transport stream identifier) associated with each

slot.

The third column lists the modulation mode for each slot and the number of
effective slots. Each modulation mode is represented by a different color (see

Table 3-32).

NOTE. When the modulation mode and the number of slots are not consistent, the

color of the Modulation column is red.
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3-114

Syntax View

Table 3-32: Color for each TMCC Deferred-Time Client modulation
mode

Modulation Color
BSPK(1/2) Dark green
QPSK(1/2) Dark purple
QPSK(2/3) Green
QPSK(3/4) Mustard
QPSK(5/6) Brown
QPSK(7/8) Dark blue
TC8PSK(2/3) Blue

The Syntax view (see Figure NO TAG) displays the content of the TMCC data in
a hierarchic list, including the length, value, and description of the hierarchic
item. Table 3-33 shows the hierarchy used for S TMCC and M_TMCC streams.

Each hierarchic item is represented by a colored icon (icons are gray when the
TMCC Syntax Consistency probe is not set). A green LED icon indicates that
the field value is correct, a green folder icon indicates that all parameters
displayed within that folder are correct. A red icon indicates that an error exists
in the field value of the item or, in the case of a folder icon, in one of the
subitems of a group. See Table 3-34 on page 3-116 for error conditions that
cause LED icons to change color.

NOTE. For S_TMCC streams, the Transmission frame ID and the Super frame ID
fields are not updated in real-time in the TMCC Analysis Server. Their values are
displayed as 0/1 in the TMCC Deferred-Time Client.
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Table 3-33: TMCC data syntax

S_TMCC data 64 bits

ID info. 8 bits
Extended data 4 bits
Alarm signal 1 bit
Update indication 1 bit
Transmission frame ID 1 bit
Super frame ID 1 bit

Transmission mode & Slot info. 40 bits
Trans. mode 1 4 bits
Nb slot 1 6 bits
Trans. mode 2 4 bits
Nb slot 2 6 bits
Trans. mode 3 4 bits
Nb slot 3 6 bits
Trans. mode 4 4 bits
Nb slot 4 6 bits

TSID 16 bits

M_TMCC data 384 bits

Update indication 5 bits

Transmission mode / slot info. 40 bits
Trans. mode 1 4 bits
Nb slot 1 6 bits
Trans. mode 2 4 bits
Nb slot 2 6 bits
Trans. mode 3 4 bits
Nb slot 3 6 bits
Trans. mode 4 4 bits
Nb slot 4 6 bits

Relative TS / Slot info. 144 bits
Relative TS number slot 1

through 3 bits each

Relative TS number slot 48

Relative TS / TSID 128 bits
TSID for relative TS number 0

through 16 bits each

TSID for relative TS number 7

Alarm control 5 bits
Emergency alarm 1 bit
Reserved 4 bits

Extended data 62 bits
Extended flag 1 bit
Extended data 61 bits
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To open or close hierarchy items in the Syntax view, click on the open/close icon
to the left of the folder icon as shown below.

Marne

gl S_TMCC Data

@0 D

LA Transtmission mode & Slat infa.

@ Trans. Mode 1
@ MNb Slot 1
@ Trans. Mode 2
@ Mb Slot 2

The folder and LED icons are gray when the TMCC Syntax Consistency probe is
not set. When this probe is set, the folder and LED icons turn red when the
conditions described in Table 3-34 are detected.

Table 3-34: Syntax view LED icons and error conditions

LED icon Error condition causing an LED icon to turn red
Trans. Mode n When the transmission mode parameter is not 15 (reserved) or not one
of the following values (representing transmission modes):
Value | Transmission mode
1 BPSK (1/2)
2 QPSK (1/2)
3 QPSK (2/3)
4 QPSK (3/4)
5 QPSK (5/6)
6 QPSK (7/8)
7 TC8PSK (2/3)
Nb. Slot n For S_TMCC streams (TMCC basic streams), when the total number of

assigned slots is greater than 47.

For M_TMCC streams (TMCC data streams), when the total number of
assigned slots is greater than 48.

When the transmission mode parameter is 15 (reserved) and the slot
parameter is not zero (0)

Extended Data When the Extended Flag parameter is zero (0) and all 61 bits of the
Extended Data field are not one (1).
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Raw Data View  The Raw Data view (see Figure NO TAG on page NO TAG) displays the actual
hexadecimal values of the TMCC data. You can use standard Windows NT
methods for selecting and copying the data to a text file.

Message View  The Message view displays error, warning, and information messages for the
TMCC analysis in progress. The messages include the message type (error,
warning, and information), the message content, and the time of the message.
The maximum number of displayed messages is 1000. Additional messages are
handled on a first in first out basis.

You can right-click in the Message view to open the dialog box shown below
where you can sort and clear messages. You can also use the dialog box to
change the number of lines allowed for each message so that you can view the
complete content of multiple-line messages.

Meszage view configuration I

[_] Ascending sort order

[_1 Clear message(s)

1 7 | lines per message

ok | | cancel

NOTE. Some messages are too long to be displayed in three lines; double-click
the message to display a pop-up message window with the full message text.

Status Bar  The Status bar displays the following information (reading from left to right):
B The status of the analysis (Done, Idle, or Analyzing)
®m  The position and total number of bytes in the bit stream
m  The super frame number and version of slot configuration
B The stream rate

B The synchronization status
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Using the TMCC Deferred-Time Client

This section provides several common procedures for using the TMCC
Deferred-Time Client:

®  Starting the TMCC Deferred-Time Client page 3-118

B Specifying a TMCC Transport Stream File page 3-119

B Displaying Slot Configurations page 3-121
B Displaying Syntax Information page 3-122
B Displaying Messages page 3-124
B Saving Transport Stream Files page 3-125
m  Setting Probes page 3-121
B Saving and Applying Configurations page 3-126

After this section, the probes you can set using the TMCC Configuration Client
are described (see page 3-128).

Starting the TMCC  To start the TMCC Deferred-Time Client, double-click the icon in the Tektronix
Deferred-Time Client = MPEG Test System program group window, or select the application from the
Start | Programs | Tektronix MPEG Test System group.

When you start the TMCC Deferred-Time Client, the TMCC Configuration
Client is also started showing the last configuration.

NOTE. In order for the TMCC Deferred-Time Client to display analysis results,
you must first specify the stream type (S_TMCC or M_TMCC) and rate from the
TMCC Configuration Client (usually the rate is automatically detected when the
TMCC Configuration Client opens the transport stream file).
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Specifying a TMCC  Use these steps to specify the TMCC transport stream file you will analyze:

Transport Stream File , . : . . :
1. Display the TMCC Configuration Client (with the TMCC Deferred-Time

Client is also started), and then select Input from the Navigation frame.

. TMCC Configuration Client

n =/ n g File name: 4streams.trp ?
Mewy  Load  Save Al Help
[ Input :
D Analysis Inpult

File parameters

Filename DM TS300d streams.trp Browse...
Rate 19.400082| Muis

Packet size 188 Bwtes
File size 394,842,112 Bwtes

Begin locator Iiﬂ Bwtes
End locator 394842112 Bwtes

Number of consecutive correct symchronization ytes to test 5 -
hefore indicating that the synchronization has been found
Humber of bad consecutive synchronization ytes to test 3 -

before indicating that the synchronization has been lost

Restore defautt |

Connected

2. Click the Browse button and select a local *.trp file, and then return to the
TMCC Configuration Client.

3. Update the Rate, if necessary (usually the rate is updated automatically). The
rate is calculated from the PCRs in the streams and is given in Mbps.

4. Select the part of the file you want to analyze using the Begin locator and
End locator text boxes. The default for these two values is the beginning and
end of the file.

5. If necessary, select the appropriate number of sync bytes to test for sync and
loss of sync.
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6. Click Analysis in the Navigation frame to display the Analysis panel.

. TMCC Configuration Client

D =/ n !ﬁ File name: 4streams.rp '?
Mewy  Load  Save Al Help
D) input ' Analysis
D Analysis
Stream type
: ) No TMCC

® S_TMCC (mono transport stream)
) M_TMCC {multi transport stream)

Analysis probes

:| | [TMCC update notification
TMCC alarm status notification
Frame size consistency

Add all

'

Add

Superfrarme size consistency
TMCC update consistency .
Mumber of slot consistency

e el iladin g mandn and clod con cict x

Restore defautt |

|
g
=
1 3

Remowe all

Connected

7. Select the appropriate stream type from among the options provided:

B No TMCC to analyze a TMCC streams without looking at the TMCC

data (for instance, you may simply want to see the reported rate in the
TMCC Deferred-Time Client).

m S TMCC to analyze a single transport stream multiplex (a TMCC basic
stream)

® M _TMCKC to analyze a multiple transport stream multiplex (a TMCC
data stream)

8. Click Apply to apply your settings to the TMCC Analysis Server, or set
some probes first using the procedure described in Setting Probes on
page 3-121.
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Setting Probes  Use these steps to set the probes used to analyze the transport stream file
specified in the Input panel of the TMCC Configuration Client:

1. Display the TMCC Configuration Client (with the TMCC Deferred-Time
Client is also started), and then select Analysis from the Navigation frame.

2. Click Add or Add All from the Analysis Probes area.

Add probe [ x|

TMCIC up date notification
TWMCC alarm status notification
Frame size consistency
Super frame size consistency
TWMCC update consistency 0k
Mumhber of slot consistency:

Madulation mode and slot consistency Canhcel
TMCC syntay consistency
Modulation order consistency

3. Select the probes you want to add and click OK.

4. Click the Apply button on the toolbar.

Displaying Slot  Use the TMCC Deferred-Time Client toolbar buttons to display different
Configurations  versions of slot configurations encoded in the transport stream file listed in the
File name area.

Button | Name In the Slot panel
” First Displays the first slot configuration
‘ Previous Displays the previous slot configuration
n Pause Stop the analysis, returning the view to the slot configuration
from which the file was played
’ Next Displays the next version of slot configuration
" Last Displays the last version of slot configuration
ey Go to Displays the Go To dialog box from which you specify a version

of the slot configuration you want to display
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Displaying Syntax ~ Use the TMCC Deferred-Time Client toolbar buttons to display different
Information versions of slot configurations encoded in the transport stream file listed in the
File name area. The Syntax panel displays the syntax of the version indicated in
the status bar.

Button | Name In the Syntax panel

I First Displays the first TMCC data version

4 Previous Displays the previous TMCC data version

n Pause Stops the analysis and displays the current version of TMCC

data (or the version from which the analysis started)

4 Next Displays the next TMCC data version

] Last Displays the last TMCC data version

e Go to t[))(i)’e;(plays the TMCC data version specified in the Go To dialog

To open or close hierarchy items in the Syntax view, click on the open/close icon
to the left of the folder icon as shown below.

Name

gl S_TMCC Data

e

Transmission mode & Slat info.

@ Trans, Mode 1
@ Nb slot1
@ Trans. Mode 2
@ Nb Slot 2
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The folder and LED icons are gray when the TMCC Syntax Consistency probe is
not set. When this probe is set, the folder and LED icons turn red when the
conditions described in following listing are detected.

LED icon

Error condition causing an LED icon to turn red

Trans. Mode n

When the transmission mode parameter is not 15 (reserved) or not one
of the following values (representing transmission modes):

Value | Transmission mode

1 BPSK (1/2)
QPSK (1/2)
QPSK (2/3)
QPSK (3/4)
QPSK (5/6)
QPSK (7/8)
TC8PSK (2/3)

N oo o B~ WD

Nb. Slot n

For S_TMCC streams (TMCC basic streams), when the total number of
assigned slots is greater than 47.

For M_TMCC streams (TMCC data streams), when the total number of
assigned slots is greater than 48.

When the transmission mode parameter is 15 (reserved) and the slot
parameter is not zero (0)

Extended Data

When the Extended Flag parameter is zero (0) and all 61 bits of the
Extended Data field are not one (1).
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Displaying Messages  The Message view displays error, warning, and information messages for the
TMCC analysis in progress. The messages include the message type (error,
warning, and information), the message content, and the time of the message.
The maximum number of displayed messages is 1000. Additional messages are
handled on a first in first out basis.

You can right-click in the Message view to open the dialog box shown below
where you can sort and clear messages. You can also use the dialog box to
change the number of lines allowed for each message so that you can view the
complete content of multiple-line messages.

Meszage view configuration I

[_] Ascending sort order

[_1 Clear message(s)

1 7 | lines per message

ok | | cancel

NOTE. Some messages are too long to be displayed in three lines; double-click
the message to display a pop-up message window with the full message text.
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Saving Transport Stream  Use these steps to save part or all of the transport stream file you are analyzing to
Files alocal file:

1. Click the Save toolbar button in the TMCC Deferred-Time Client.

NOTE. Transport stream files can be large. Ensure that the location you are
saving the file to has enough disk space and that you have write permissions.

2. In the Save dialog box, browse to a location on your local disk where you
will save the file and give the file a name.

Fil |D:IMTSSDDIStreamSIfQC.trp || Browse... |

Al
(®) Superframe From |First |V| To |Current |v|

| ok || canca |

3. Select All or SuperFrame.

4. If you select SuperFrame, you can choose from among the following choices
for both the From and To combination boxes:

m  First
m  Current
m  Last

You can also enter specific super frames in the From and To combination
boxes.

S. Click OK.
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Saving and Applying  The toolbar buttons of the TMCC Configuration Client allow you to perform the
Configurations  following functions:

®m  Save all of the current TMCC analysis configuration settings to a file
B Load a saved TMCC analysis configuration file
B Restore the standard, factory-default TMCC analysis configuration

B Apply any configuration setting changes to the TMCC Analysis Server

NOTE. You must click the Apply toolbar button before your configuration
changes will be applied to the TMCC Analysis Server input.

Table 3-35: Functions of the TMCC Configuration Client Toolbar buttons

Button | Name Function

b New configuration | Loads the default TMCC analysis settings into each of the

o (CTRL+N) configuration panels in the TMCC Configuration Client
(stream type of No TMCC, and no TMCC probes set).

- Load configuration | Loads a previously saved set of analysis settings into each of

Lo (CTRL+L) the configuration panels in the TMCC Configuration Client. A

dialog box is displayed from which you select a previously
saved TMCC configuration file.

- \ Save configuration | Saves the current TMCC analysis settings to a file. A dialog
Save

(CTRL+S) box appears where you can enter a path and file name.

It is recommended that you save the TMCC configurations in
the following directory on the MTS300 system:
c:\MTS300\CFG-TRP.

55 Apply Applies the current TMCC analysis settings to the TMCC
Apply (CTRL+A) Analysis Server indicated in the address bar.

Saving the Current Configuration. To save the current TMCC analysis configura-
tion , perform the following procedure:

1. Click the Save toolbar button to open the Save window.

2. Use the Save window to save the current TMCC analysis settings to a file on
the hard drive of the MTS300 system.

It is recommended that you save TMCC analysis configurations in the
following directory on the MTS300 system: C:\MTS300\CFG-TRP.
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Restoring the Default Configuration. To restore the default TMCC Analysis Server
configuration, click the New toolbar button, and then click the Apply toolbar
button. All TMCC analysis settings will now be restored to the factory-default
state (stream type of No TMCC, and no TMCC probes set).

Loading a Saved Configuration. To restore a TMCC Analysis Server configuration
that has been saved on the hard drive of the MTS300 system, perform the
following procedure:

1. Click the Load toolbar button to open the Load Configuration window.

2. Highlight the name of the configuration file that you want to restore, and
then click Load.

3. Click the Apply toolbar button to apply the configuration changes to the
TMCC Analysis Server.

Deleting a Saved Configuration. Use Windows NT Explorer to locate and delete a
saved TMCC Analysis Server configuration file on the hard drive of the
MTS300 system. The file name will have a .CNF extension.
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TMCC Probe Descriptions

TMCC Update Notification

3-128

Probe

You can use the new TMCC analysis capabilities of the MTS300 system to set
TMCC analysis probes for the file indicated in the Input panel of the TMCC
Configuration Client. Probes are set from the Analysis panel of the TMCC
Configuration Client, analysis results are displayed in the TMCC Deferred-Time
Client. This section describes these probes. See theTMCC Deferred Time Client
and the TMCC Configuration Client sections for information about using those
clients.

The TMCC Configuration Client allows you to set the following TMCC probes
(page numbers indicate the page on which the probe is described):

B TMCC Update Notification Probe page 3-128
B TMCC Alarm Status Notification Probe page 3-129
B Frame Size Consistency Probe page 3-129
B Super Frame Size Consistency Probe page 3-129
B TMCC Update Consistency Probe page 3-129
B Number of Slots Consistency Probe page 3-130
B Modulation Mode and Slot Consistency Probe page 3-130
B TMCC Syntax Consistency Probe page 3-130
B Modulation Order Consistency Probe page 3-131

The TMCC files being analyzed are always checked for the following character-
istics (the results are displayed in the Status bar of the TMCC Deferred-Time
Client):

B Synchronization bytes
B (x47 for single-transport stream multiplexes

B W1 (0x1B95), W2 (0xA340), and W3 (0x5CBF) for multiple-transport
stream multiplexes

m  Overall TMCC stream rate

Set the stream rate in the TMCC Configuration Client.

Error Condition: A message is generated when at least one bit is modified in the
TMCC information. The transmission_frame_id and super_frame_id fields are
not analyzed for this probe.

How/Where and alarm is displayed: This is reported as an information message in
the Messages panel of the TMCC Deferred-Time Client.

MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer



TMCC Deferred-Time Client Reference

TMCC Alarm Status  Error Condition: A message is generated when either the alarm_signal_flag or the
Notification Probe = emergency_alarm_flag fields are set to 1.

How/Where and alarm is displayed: This is reported as an information message in
the Messages panel of the TMCC Deferred-Time Client.

Frame Size Consistency  Error Condition: The following statements must be true, or an error is generated
Probe by the TMCC Analysis Server:

®m  The current computed frame size is the same as the latest frame size.

®m  The computed frame size is equal to the total number of slots indicated in the
transmission_mode and slot_info fields.

How/Where and alarm is displayed: This error is reported as an ISDB multiplex
error in the Master Client and as an error message in the Message panel of the
TMCC Deferred-Time Client.

Super Frame Size  Error Condition: The following statements must be true, or an error is generated
Consistency Probe by the TMCC Analysis Server:

B The super frame size is eight (8).

m  If the transmission_frame_id is one (1), the super_frame_id must also be one
(1). This ensures that the first frame of the super frame is synchronized with
the first frame.

How/Where and alarm is displayed: This error is reported as an ISDB multiplex
error in the Master Client and as an error message in the Message panel of the
TMCC Deferred-Time Client.

TMCC Update  Error Condition: The following statements must be true, or an error is generated
Consistency Probe by the TMCC Analysis Server:

®  When the TMCC information is updated, the following statements are also
true:

®m  The update_indication flag is one (1).
®m  The update_indication counter is correctly incremented.

How/Where and alarm is displayed: This error is reported as an ISDB multiplex
error in the Master Client and as an error message in the Message panel of the
TMCC Deferred-Time Client.
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Number of Slots  Error Condition: The following statements must be true, or an error is generated
Consistency Probe by the TMCC Analysis Server:

®  For TMCC basic streams, the number of slots must be less than 48
B For TMCC data streams, the number of slots must be 48

How/Where and alarm is displayed: This error is reported as an ISDB multiplex
error in the Master Client, as an error message in the Message panel of the
TMCC Deferred-Time Client, and the modulation scheme color becomes red in
the Slots panel of the TMCC Deferred-Time Client.

Modulation Mode and Slot  Error Condition: The following statement must be true, or an error is generated by
Consistency Probe  the TMCC Analysis Server:

B The minimum number of slots is not consistent with the modulation mode.
The number of packets transmitted and the number of symbols used for a
given modulation scheme is given by the following equation:

7 = 8 X B X P,
k Ek
Where:

B [, is the integer number of symbols transmitted with the k-th combina-
tion of the modulation scheme and inner code rate

m Py is the integer number of packets transmitted with the k-th combina-
tion of the modulation scheme and inner code rate

m [ is the spectrum efficiency of the k-th combination of the modulation
scheme and inner code rate

B B is 204, the number of bytes per packet

How/Where and alarm is displayed: This error is reported as an ISDB multiplex
error in the Master Client, as an error message in the Message panel of the
TMCC Deferred-Time Client, and the modulation scheme color becomes red in
the Slots panel of the TMCC Deferred-Time Client.

TMCC Syntax  Error Condition: If the syntax of TMCC fields is incorrect, an error is generated
Consistency Probe by the TMCC Analysis Server.

How/Where and alarm is displayed: This error is reported as an ISDB multiplex
error in the Master Client, as a red icon in the Syntax view of the TMCC
Deferred-Time Client, and as an error message in the Message panel of the
TMCC Deferred-Time Client.
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Modulation Order  Error Condition: If the order of the different modulation schemes used in the
Consistency Probe transport stream is incorrect, an error is generated by the TMCC Analysis Server.
(The highest efficiency modulation scheme used in the transport stream must use
the lower numbered slots, and the lower efficiency modulation schemes used
must use the higher numbered slots.)

How/Where and alarm is displayed: This error is reported as an ISDB multiplex
error in the Master Client, as an error message in the Message panel of the
TMCC Deferred-Time Client, and the modulation scheme color becomes red in
the Slots panel of the TMCC Deferred-Time Client.
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Appendix A: What to Do if an Application Locks Up

In the event an application locks up or freezes, perform the following steps to
close the application.

1. Try closing the application with the Windows NT Security dialog box as
follows:

a.

b.

g

Press Ctrl+Alt+Del to open the Windows NT Security dialog box.

Click the Task Manager button to open the Windows NT Task
Manager.

Highlight the locked-up application.
Click the End Task button.

In some circumstances, a window opens prompting you to wait, end the
task, or cancel your “end task” instruction. Follow the window instruc-
tions; if you click End Task, the application should close immediately.

If the above procedure fails to close the application, press Ctrl+Alt+Del
again to return to the Windows NT Security dialog box.

Click the Shut Down button. This opens the Shutdown Computer dialog
box.

Select the Shutdown and Restart option button; then click OK.

2. If the above procedures do not close the application or restart the computer,
manually power off the computer; then proceed with a normal power on.

CAUTION. To avoid data loss, do not power off the computer without first exiting
! Windows NT. Use the manual reset only if the computer does not respond.

To ensure that all parameters are reset, perform a complete power cycle
following an application lock up.
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Use the procedures in this section to uninstall and reload the test system software
if the installed copy is corrupted. See the MTS300 MPEG Test System Hardware
and Software Installation Technical Reference (Tektronix part number,
071-0667-XX) for information about rebuilding the operating system for the
MTS300 test system.

Reinstalling the MTS300 Software

Use the procedures below to reinstall MTS300 test system applications
accidently deleted or corrupt. Software is supplied on the CD ROM shipped with
your product or upgrade.

NOTE. The following instructions are for reinstalling MPEG Test System
software on a machine running Windows NT Workstation 4.0 only; procedures
for upgrading your software could be different. If you are installing a software
upgrade, follow the instructions provided with the upgrade kit.

Reinstalling the software involves three procedures:
®  Uninstalling the current software
B Installing the software

®m  Entering passwords for licensed applications

NOTE. In some cases, you may need to install the Java run-time environment; for
instance, if your license includes the TMCC Deferred-Time Analyzer. If you are

prompted to install the Java run-time environment before installing the software,

run the executable file in the jre directory of the Application CD.
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B-2

Uninstalling Software =~ Remove the existing software using the unlnstallShield application.

1.

Restart Windows NT and log on as the administrator (Username = adminis-
trator; password = MPEG2). You must log on as the administrator to install
MTS300 applications.

2. Quit any applications that automatically started at login.

3. Double-click the Uninstall MTS3... icon in the Tektronix MPEG Test
System program group window.

4. When the dialog box asks you to confirm the file deletion, click Yes.

5. When uninstall is complete, Click OK to close the Remove Programs From
Your Computer window.

Installing Software 1. If you are not already logged on, log onto your NT workstation as Adminis-
trator.

2. Right-click the My Computer icon on your Windows NT desktop, and then
select Explore from the submenu. In the Exploring window, select the icon
that represents the disk drive onto which you will install the software
(usually drive C:).

3. Check the status bar at the bottom of the Exploring window to verify that the
target disk has at least 140 MB of free space. You cannot install the software
on a disk that has less than 140 MB of free space.

[BY Exploring - C-\
File  Edit ¥iew Toolz Help
|.é\|| Foalders Contents of 'C:A
Desktop & | Mame | Sizel Type | Mt:l
=123 My Computer j [ acrobats File Folder 5 —
. E-E2 3Flappy (&) CIEin File Folder 8
ﬁm (3 carbd File Folder 14
= h[fll:t):]d ok £ CIEc File Folder B
s sdocs on "wowesleyk! [E: b o Fraldar h
@ e on wW-jacques' [F) =] FJM Fil |I: o 1»
Status bar ——» |42 abiect(s] |128ME [Disk free space: 409ME] w
Free space

4. Place the MPEG Test System Version 6.0 Installation Software CD ROM
into the CD ROM drive.

5. Click the Windows NT Start button, and then select Run.

6. Enter d:\Setup.exe in the resulting Run window as depicted in the following

illustration (in this example, d is the drive letter for the CD ROM drive; use
the drive letter that is correct for your computer), and then click OK.
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Run HE

Type the name of a program, Folder, or document, and
‘windows will open it for you,

=

¥ Fumin Separate fdemen Space

Ok I Cancel | Browse. . |

7. In a few seconds, the Tektronix MTS300 Series window appears on the
computer screen.

8. Read the Copyright and Setup text and then click Next to proceed to the
Choose Destination Directory window.

NOTE. It is strongly recommended that you use the default destination folder.

9. The default destination folder is C:\Mts300. Click Next to accept the default
folder.

10. The Setup Type window opens.

®  [f you are installing the software on a machine that has no MPEG Test
System hardware, select MTS300 Software Only.

Setup Type [ x|

Click the type of Setup you prefer, then click Mext.

— Description

< Back I Newt > I Cancel |

®m  [If you are installing software onto an MPEG Test System, select MPEG
Test System and continue with the procedure as described in the
MTS300 MPEG Test System Hardware and Software Installation
Technical Reference that accompanied the test system.
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11. Click Next in the Select Program Folder window to accept the default folder
name (Tektronix MPEG Test System) and continue.

12. Review the Destination Directory, Selection, and Start Menu Folder
selections in the Selection Summary window. If the selections are incorrect,
click Back and change the information as needed. Once the information is
corrrect, click Next to proceed with installation.

The setup program begins installing the software and related sample files.
The activity and progress gauges appear at first to show that installation is
progressing.

chmits 20 0wide odF28ymobl_01 6. mp2

[ 1%

Installation proceeds without your input (and sometimes with no apparent
activity) for approximately two minutes, depending on your computer
platform.

During a normal setup, two empty program group windows are displayed
after the program files have been copied to your disk drive. Shortly after
these windows appear, a message reminds you to verify that the Dongle
(software key) is installed.

13. Ensure that the software key is installed on the parallel printer port as
described in Software Key on page 1-1, and then click OK.

14. The Setup Complete window opens; click Finish to continue.

15. A Notepad window opens to display the Readme file. Read this file for
important information, and then exit Notepad.

16. Another Setup Complete window opens. Accept the Yes, I want to restart my
computer now option, remove the MPEG Test System disc from the
CD ROM drive, and click Finish to complete setup and reboot the system.

NOTE. You need to restart your computer before you enter the license password
in the next procedure.
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17. When prompted, log on as any user.

18. If not already displayed, open the Tektronix MPEG Test System program

group window by double-clicking the folder icon on the desktop.

The program group window resembles the following illustration.

& C:\WINNTAProfileshAll Users\Desktop\Tektronix MPEG Test System

File Edit Wiew Help

[_ [0 ]

IaTektronixMPEG Test Spstem j L=

b |ml@| o [oa |

- ® ITa %

£ av e

EIS EI 2]
Master Client  Hardware ReadmeFile  Private Syntas License Defened-Time  Multiplexer
Diagnostic Interpreter Manager Analyzer
7= BmoOY M & &
Ead i
DWE Table i DVB Channel  Audio Strearn Dolby Digital — Eror Injector  Jitter ddder
E ditor i Coding and... Analyzer Aralyzer
MPEG-2Help Pragram Urimztal Yidea Stream
Shrea... MTS3. Analyzer :I
|18 abject(z] |7.44KE v
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Entering the General  Perform the remaining steps to enter the general password that corresponds to the
License Password  attached software key. Doing so enables the applications that are included with
your MTS300 MPEG Test System product.

’Dv 1. Double-click the License Manager icon in the Tektronix MPEG Test
E System program group window to start the Tektronix Software Protection

) application.
Licernse Manager PP

The Tektronix Software Protection window appears.

"s Tektronix Software Protection

To Enable Licensed Software Applications,
Fleaze Enter pour General Pazsword.
then Click 0K

Cancel |

2. Consult the password document supplied with your software and identify the
general password.

3. Enter the three 6-character hexadecimal numbers of the password in the
corresponding Tektronix Software Protection window entry fields (lowercase
characters are acceptable).

4. Click OK. A License message window appears.

5. If the password is correct, click OK to acknowledge the message. If you
made an error entering the password, click OK and return to step 2.

When you enter the correct password, software installation is complete. You will
need to restart the computer before you can start any of the stream creation
applications.

B-6 MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer



Appendix C: Analyzer Tests

This section describes bitstream tests performed by the Deferred-Time Analyzer
application, version 5.02.02 and above.

NOTE. This appendix does not include tests added to MTS300 software version
2.0 and up.

The tests shown in normal typeface can be found in the compliance document
(ISO/IEC 13818-4 DIS).

The tests shown in italics are not described in the compliance document, or are
described but are erroneous and/or incomplete.

All the fields are indicated, even those for which no tests are performed. The
fields are listed exactly in the same order as given in the Standard (ISO/IEC
13818-1 IS of 13 November 1994).

Compliance at the Transport Stream Level

There are two parts at this level: the Transport Packet Header and the Adaptation
Field.

Table C-1: Compliance for the Transport Packet Header

Parameter Error checking
sync_byte (sh): test that (sb == 0x47)
transport_error_indicator (tei): test that (tei I= 1)
payload_unit_start_indicator (pusi): if (pid == Ox1FFF)
then test that (pusi == ‘0’)
transport_priority (tp): no test
PID (pid): 1. test that pid is in [0x0000, 0x0001, 0x0010 .. Ox1FFF]

2. issue a warning if pid emulates 0x47

3. verify that there is at least one packet with pid == 0x0000 in the stream
transport_scrambling_control (tsc): 1. if (pid == 0x0000 or 0x0001 or Ox1FFF)

then test that (tsc == ‘00’)
2. if (pid == PID_PMT)

then test that (tsc == ‘00’)

NOTE: the PID_PMTs are given by the program_map_PID fields in the PAT
sections.
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Table C-1: Compliance for the Transport Packet Header (Cont.)

Parameter

Error checking

adaptation_field_control (afc):

if (pid == Ox1FFF)
then test that (afc == ‘01))
else test that (afc != ‘00’)

continuity_counter (cc):

if (afc in == x1’)

and ((AF.di == ‘0") or (afc == ‘0x)))

and (pid != Ox1FFF)

and packet is not a duplicate

then test that (cc == previous_cc + 1, modulo 16)

NOTE: previous_cc means value of the continuity _counter of the previous TS
packet with the same PID.

data_byte (db):

1.

if (pusi == 1)

and (pid == PID_PES)

and (tsc == ‘00’) or stream has been unscrambled

then test that db starts with 0x000001 followed by the correct sid

if (pusi == 0’)

and (pid == PID_PES)

and (tsc == ‘00’) or stream has been unscrambled

then test that db does not contain 0x000001 followed by the correct sid

if (pusi == 1)

and (pid == PID_PS]I)

and (tsc == ‘00’) or stream has been unscrambled

then test that db starts with pointer field to the correct table_id

if packet is not a duplicate

and (previous_AFH.sc == 0)

and (tsc == ‘00’) or stream has been unscrambled

then test that db starts with 0x000001 followed by the correct sid

NOTE:

PID_PES are given by the elementary PID fields given in the PMT sections.

PID_PSI are 0x0000 for PAT, 0x0001 for CAT, the PIDs given by the
program_map_PID fields in the PAT sections, PID given by the network PID
field in the PAT sections.

correct table_id are 0x00 for PAT, 0x01 for CAT, 0x02 for PMT and [0x40 ..
OxFE] for NIT.

correct sid means ‘1110 xxxx’ for video and ‘110x xxxx’ for audio.

previous AFH.sc means the value of the splice_countdown field of the
previous TS packet with the same PID (duplicate packets and packets with
no payload excluded).
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Special Tests in the Case  The following test should be used to determine whether a packet is a duplicate

of a Duplicate Packet  packet:

if (afc == ‘x1’)

and (AF.di == ‘0’) or not present
and (pid != Ox1FFF)

and (cc == previous_cc)

then packet is a duplicate

For a duplicate packet, you should verify that the previous packet with the same
PID is not a duplicate packet.

Table C-2: Compliance for the Adaptation Field (AF)

Parameter

Error checking

adaptation_field_length (afl):

1. if (TPH.afc == 10))
then test that (afl == 183)

2. if (TPH.afc ==“11))
then test that afl is in [0 .. 182]

discontinuity_indicator (di): no test
random_access_indicator (rai): no test
elementary_stream_priority_indicator (espi): no test
PCR_flag (pcrf): 1. if (operf == 1))
then test that (pcrf == 1))
2. if(rai=="1)

and (TPH.pid == PID_PCR)
then test that (pcrf == 1))

NOTE: the PID_PCR are the PIDs given by the PCR_PID fields in the PMT
sections.

OPCR_flag (opcrf):

no test

splicing_point_flag (spf):

if packet is not duplicate
and (TPH.afc == ‘11’)
and (previous_spf == 1)
and (previous_sc != 0)
then test that (spf == 1)

transport_private_data_flag (tpdf):

no test

adaptation_field_extension_flag (afef):

if packet is not duplicate
and (TPH.afc == ‘11’)
and (previous_afef == 1)
and (previous_sc != 0)
then test that (afef == 1)

program_clock_reference_base (pcrb): no test
reserved (r1): test that (r1 == “111111")
program_clock_reference_extension (pcre): no test
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Table C-2: Compliance for the Adaptation Field (AF) (Cont.)

Parameter Error checking
original_program_clock_reference_base (opcrb): | no test

reserved (r2): test that (12 == “111111’)
original_program_clock_reference_extension no test

(opcre):

splice_countdown (sc):

if (packet is not duplicate)
and (TPH.afc == ‘11’)
then test that (sc == previous_sc - 1)

NOTE: previous_sc is the value of sc in the previous packet of the same PID
(duplicate packets and packets with no payload excluded).

transport_private_data_length (tpdl):

1. test that (tpdl > 0)
2. test that (tpdl < afl - compute_length())

compute_length is the following function:
int compute_length()

int length = 1

if (perf == “1°) then length += 6

if (opcrf == ‘1) then length +=6
if (spf == ‘1°) then length++

if (afef == 1°) then length += afel

}
private_data_byte (pdb): no test
adaptation_field_extension_length (afel): test that (afel > 0)
ltw_flag (If): no test
piecewise_rate_flag (prf): no test

seamless_splice_flag (ssf):

if packet is not duplicate
and (TPH.afc == ‘11’)
and (previous_ssf == 1)
and (previous_sc != 0)
then test that (ssf == 1)

reserved (r3):

test that (r3 == “11111)

ltw_valid_flag (Ivf): no test
ltw_offset (lo): no test
reserved (r4): test that (r4 == “11111111")
piecewise_rate (pr): no test
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Table C-2: Compliance for the Adaptation Field (AF) (Cont.)

Parameter

Error checking

splice_type (st):

1. if (packet carries audio stream) then test that (st == ‘0000’)
2. if (packet carries video stream) then test that st is not in 0100 .. “1011]]

3. if (not first occurrence of st)
and (previous_sc != 0)
then test that (st == previous_st)

NOTE:
1. for a definition of previous_sc, see note 1 of sc.

2. previous_st means the value of st in the previous packet with the same PID
(duplicate packets or packets without payload excluded).

3. the information about the type of stream (audio or video) can be found in the
stream_type fields of the PMT sections.

DTS_next_au (dtsna):

if (not first occurrence of dtsna)
and (previous_sc != 0)
then test that (dtsna == previous_dtsna)

NOTE:
1. for a definition of previous_sc, see note 1 of sc.

2. previous_dtsna means the value of dtsna in the previous packet with the
same PID (duplicate packets or packets without payload excluded).

marker_bit (mb):

test that (mb == “1°) for all mb in the packet

reserved (r5):

test that (r5 == ‘1111 1111’) for all bytes

stuffing_byte (sb):

test that (sb == ‘1111 1111’) for all bytes
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Compliance at the PES Packet Level

The following tests should be performed only if the transport_scrambling_con-
trol field of the transport packets is equal to ‘00’ or the PES stream has been
unscrambled.

Table C-3: Compliance for the PES packet header

Parameter Error checking
packet_start_code_prefix (pscp): test that (pscp == 0x000001)
stream_id (sid): 1. sid |= a reserved value
2. sid>=0xBC
3. test that each PES packet carried in the TS packets of the same PID value
have the same sid
4. if (packet carries audio)
then test that sid is in [0xCO .. 0xDF]
5. if (packet carries video)
then test that sid is in [0XEQ .. OXEF]
PES_packet_length (pespl): if sid indicates that packet does not carry video
then test that (pespl != 0)
“10”; test that these two bits are really equal to ‘10’
PES_scrambling_control (pessc): no test
PES_priority (pesp): no test
data_alignment_indicator (dai): no test
copyright (©): no test
original_or_copy (ooc): no test
PTS_DTS_flags (ptsdtsf): test that (ptsdtsf != 01’)
ESCR_flag (escrf): no test
ES_rate_flag (esrf): no test
DSM_trick_mode_flag (dsmtmf): no test
additional_copy_info_flag (acif): no test
PES_CRC_flag (pescrcf): no test
PES_extension_flag (pesef): no test
PES_header_data_length (phdl): 1. test that phdl >= sum of optional data fields ( > for stuffing)
2. ftest that phdl <= 32
‘0010’ test that these four bits are really equal to ‘0010’
marker bit (mb): test that (mb == 1) for all mb in the packet
PTS (pts): no test
‘0011”; test that these four bits are really equal to ‘0011’
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Table C-3: Compliance for the PES packet header (Cont.)

Parameter Error checking
‘0001°: test that these four bits are really equal to ‘0001’
DTS (dts): no test

reserved (r1): test that (r1 == “11)
ESCR (escr): no test

ES_rate (esr): test that (esr != 0)
trick_mode_control (tmc): no test

field_id (fid): test that (fid != ‘11’)
intra_slice_refresh (isr): no test
frequency_truncation (ft): no test

rep_cntrl (rc): test that (rc I= 0)
reserved (r2): test that (12 == “111’)
reserved (r3): test that (r3 == “11111)
additional_copy_info (aci): no test
previous_PES_packet_CRC (pppc): no test
PES_private_data_flag (pespdf): no test
pack_header_field_flag (phfl): no test
program_packet_sequence_counter_flag (ppscf): | no test
P-STD_buffer_flag (pstdbf): no test

reserved (r4): test that (r4 == “111)
PES_extension_flag_2 (pesef2): no test
PES_private_data (ppd): shall not emulate the packet_start_code_prefix (0x000001)
pack_field_length (pfl): test that (pfl < pespl)
program_packet_sequence_counter (ppsc): no test
MPEG1_MPEG2_identifier (mpeg1mpeg2i): no test
original_stuff_length (osl): if (mpeg1mpeg2i == 1)

then test that (osl <= 16)
else test that (osl <= 32)

‘01; test that these two bits are really equal to ‘01’
P-STD_buffer_scale (pstdbscale): no test

P-STD_buffer_size (pstdbsize): no test

PES_extension_field_length (pesefi): test that (pesefl < pespl)

reserved (r5): test that (r5 == ‘1111 1111’) for all bytes
stuffing_byte (sb): 1. test that (sb == OxFF) for all bytes

2. test that the number of sb <= 32 in PES packet header
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Table C-3: Compliance for the PES packet header (Cont.)

Parameter Error checking
PES_packet_data_byte (pespdb): no test
padding_byte (pb): test that (pb == OxFF) for all bytes

Compliance at the PSlI level

The PSI level contains the following sections: PAT, PMT, CAT, NIT, and Private
Sections.

Table C-4: Compliance for the PAT sections

Parameter Error check

table_id (tid): test that (tid == 0x00)

section_syntax_indicator (ssi): test that (ssi == 1")

0 (zero): test that (zero == 0)

reserved (resi): test that (res1 == "11")

section_length (sl): 1. test that (9 <= sl <= 1021)
2. if(sl==n)

then test that ((byte[n] == 0x00) or (byte[n] == OXFF) or (byte[n] == 0x47))
and test that (byte[n-4] .. byte[n-1] == CRC32)

NOTE: use a C-type array notation, so byte[n] means the (n+1)th byte found

after sl.
transport_stream_id (tsid): verify that tsid is the same for all sections with the same vn
reserved (res2): test that (res2 == ‘11’)
version_number (vn): no test
current_next_indicator (cni): no test
section_number (sn): no test
last_section_number (Isn): no test
program_number (pn): does not take any single value more than once within all sections of a version
reserved (res3): test that (res3 == 111")
network_PID (npid): 1. test that npid is not in [0x000 .. 0x000F]

2. test that (npid != Ox1FFF)
3. test that npid is not a pid already used for audio or video

4. test that npid is not a pid already used for data

NOTE: a npid can be the same as a pmpid.
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Table C-4: Compliance for the PAT sections (Cont.)

Parameter

Error check

program_map_PID (pmpid):

1. test that pmpid is not in [0x000 .. 0x000F, Ox1FFF]
test that pmpid is not a pid already used for audio, video

test that npid is not a pid already used for data

CRC32 (crc):

e »

test that the CRC value is correct
2. test that the byte following the CRC is 0x00, 0x47 or OxFF

Table C-5: Compliance for the PMT sections

Parameter

Error check

table_id (tid):

test that (tid == 0x02)

section_syntax_indicator (ssi):

test that (ssi == 1")

‘0’ (zero):

test that (zero == 0’)

reserved (resi):

test that (res1 == "11")

section_length (sl):

1. test that (9 <= sl <= 1021)

2. if(sl==n)
then test that ((byte[n] == 0x00) or (byte[n] == OXFF) or (byte[n] == 0x47))
and test that (byte[n-4] .. byte[n-1] == CRC32)

NOTE: use a C-type array notation, so byte[n] means the (n+1)th byte found
after sl.

program_number (pn):

1. pn should be the one defined in PAT
2. testthat (pn!=0)

reserved (res2):

test that (res2 == ‘11’)

version_number (vn):

1. if (cni == 1) then test that all sections have the same vn

2. testthat (v + 1) is the next version and has (cni == 1)

current_next_indicator (cni):

no test

section_number (sn):

test that (sn == 0)

last_section_number (Isn):

test that (sn == 0)

reserved (res3):

test that (res3 == 111")

PCR_PID (pcrpid):

test that pcrpid is not in [0x0002 .. 0x000F]

reserved (resd):

test that (res4 == “1111’)

program_info_length (pil):

1. test that (pil < 1024)
2. test that (pil < (sl - 9))

descriptor:

see descriptor test (beginning on page C-12)

stream_type (st):

no test
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Appendix C: Analyzer Tests

Table C-5: Compliance for the PMT sections (Cont.)

Parameter

Error check

reserved (res5)

test that (resb == ‘111’)

elementary_PID (epid):

test that epid is not in [0x000 .. 0x000F, 0x1FFF]

reserved (res6):

test that (res6 == ‘1111’)

ES_info_length (esil):

test that (esil < 1024)

descriptor:

see descriptor test (beginning on page C-12)

CRC32 (crc):

1.

test that the CRC value is correct

2. test that the byte following the CRC is 0x00, 0x47 or OxFF
Table C-6: Compliance for the CAT section
Parameter Error check
table_id (tid): test that (tid == 0x01)

section_syntax_indicator (ssi):

test that (ssi == 1")

0 (zero):

test that (zero == 0’)

reserved (resi):

test that (res1 == "11")

section_length (sl):

1.
2.

test that (9 <= sl <= 1021)

if (sl == n)
then test that ((byte[n] == 0x00) or (byte[n] == OXFF) or (byte[n] == 0x47))
and test that (byte[n-4] .. byte[n-1] == CRC32)

NOTE: use a C-type array notation, so byte[n] means the (n+1)th byte found

after sl.
reserved (res2): test that (res2 == ‘1111 1111 1111 1111 11))
version_number (vn): no test
current_next_indicator (cni): no test
section_number (sn): no test

last_section_number (Isn):

1.
2.

if (cni == 1) then test that all sections have the same vn

test that (v + 1) is the next version and has (cni == 1)

descriptor:

see descriptor test (beginning on page C-12)

CRC32 (crc):

1.
2.

test that the CRC value is correct
test that the byte following the CRC is 0x00, 0x47 or OxFF
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Appendix C: Analyzer Tests

Table C-7: Compliance for the NIT sections

Parameter Error check
table_id (tid): test that tid not in [0x00 .. 0x3F]
section_length (sl): no test

Table C-8: Compliance for the private sections

Parameter Error check

table_id (tid): test that tid is in [0x00 .. Ox3F]
section_syntax_indicator (ssi): no test

private _indicator (pi): no test

reserved (resi): test that (res1 == "11")
private_section_length (sl): no test
table_id_extension (tide): no test

reserved (res2): test that (res2 == ‘11’)
version_number (vn): no test
current_next_indicator (cni): no test
section_number (sn): no test

last_section_number (Isn):

1. if (cni == 1) then test that all sections have the same vn

2. testthat (v + 1) is the next version and has (cni == 1)

CRC32 (crc)

test that the CRC value is correct
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Appendix C: Analyzer Tests

Compliance for the Descriptors

This section covers the compliance testing for the descriptors. This list of
descriptors tested includes: All (general), Video Stream, Audio Stream,
Hierarchy, Registration, Data Stream Alignment, Target Background Grid, Video
window, CA, ISO 636, System Clock, Multiplex Buffer Utilization, Copyright,
Maximum Bitrate, Private Data, Smoothing Buffer, STD, and IBP.

Table C-9: Compliance for all descriptors

Parameter

Error check

descriptor_tag (dt):

test that dt not in [0, 1, 19 .. 63]

descriptor_length (dI):

1. if descriptor is in CAT section
then test that (sum of (dl + 1) == CAT.sl)

2. if descriptor is in PMT section after the program_info_length field
then test that (sum of (dl + 2) == PAT.pil)

3. if descriptor is in PMT section after the ES_info_length field
then test that (sum of (dl + 2) == PAT.esil)

CRC32 of the section

test that the CRC value is correct

The Video Stream Descriptor has descriptor_tag == 2. It tests that the descriptor
is at program and ES level and refers to video.

Table C-10: Video stream descriptor

Parameter Error check
descriptor_length (dl): test that (dl == mpeg1of *2 + 1)
multiple_frame_rate_flag (mfrf): no test

frame_rate_code (frc):

no frame_rate_code in SH > frc

MPEG_1_only_flag (mpeg1of):

if (mpeg1of == 0)

then

. descriptor_length = 3

. ES = MPEG2

. stream_type = 0x02

. stream_type : 0b1110 xxxx

. constrained_parameter flag = 0

Ol WM —

D
&
(D

. descriptor_length = 1

. ES = MPEGT1

. stream_type = 0x01

. stream_type = 0b1110 xxxx

5. constrained_parameter_flag = constrained_parameter flag in the SH

B WO N —

constrained_parameter_flag (cpf):

no test

still_picture_flag (spf):

no test
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Table C-10: Video stream descriptor (Cont.)

Parameter

Error check

profile_and_level_indication (pali):

pali = profile_and_level_indication in the SHE

chroma_format (cf):

cf = chroma_format in the SHE

frame_rate_extension_flag (fref):

if (fref == 1) then frame_rate_extension_n != 0 and frame_rate_extension_d != 0

reserved (r):

test that (r == ‘11111))

The Audio Stream Descriptor is the descriptor with descriptor_tag == 3. It tests
that the descriptor is at program and ES level and refers to audio.

Table C-11: Audio stream descriptor

Parameter Error check
descriptor_length (dl): test that (dl == 1)
free_format_flag (fff): if (fff == 1)

then bitrate_rate_index in AH = 0b0000
else bitrate_index in AH != 0b0000

ID (id): id == ID in the AH
layer (I): | = Layer in the AH
variable_rate_audio_indicator (vrai): no test

reserved (r):

test that (r == “111))

Hierarchy Descriptor is the descriptor with descriptor_tag == 4. Only MPEG-2
streams may have this descriptor.

Table C-12: Hierarchy descriptor

Parameter

Error check

descriptor_length (dI):

test that (dl == 4)

reserved (r1):

test that (r1 == “1111")

hierarchy type (ht):

1. if (ht==1, 2, 3, or 4) then video and ht = profile_and_level in SHE
2. if (ht == 5) then audio

reserved (r2):

test that (12 == “11)

hierarchy_layer_index (hli): no test
reserved (r3): test that (13 == “11)
hierarchy_embedded_layer_index (heli): no test
reserved (r4): test that (r4 == “11)
hierarchy_channel (hc): no test
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Registration Descriptor is the descriptor with descriptor_tag == 5.

Table C-13: Registration descriptor

Parameter Error check
descriptor_length (dI): test that (dl >= 4)
format_identifier (fid): no test
additional_identification_info (aii): no test

Data Stream Alignment Descriptor is the descriptor with descriptor_tag == 6. It
is only available for video and audio streams.

Table C-14: Data stream alignment descriptor

Parameter Error check

descriptor_length (dl): test that (dl == 1)

alignment_type (af) 1. if (at == 01, 02, 03 or 04) then
a. video

b. data_alignment_indicator in PES header = 1
c. test on the first PES_packet_data_byte

2. if (at == 01) then
a. audio
b. data_alignment_indicator in PES header = 1
c. the first PES_packet_data_byte = first byte of audio syncword

3. if (at==01) then
a. video and audio
b. data_alignment_indicator = 0

Target Background Grid Descriptor is the descriptor with descriptor_tag == 7. It
is only available for video streams.

Table C-15: Target background grid descriptor

Parameter Error check
descriptor_length (dl): test that (dl = 4)
horizontal_size (hs): no test
vertical_size (vs): no test
aspect_ratio_information (ari) no test
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Table C-16: Video window descriptor

Video Window Descriptor is the descriptor with descriptor_tag == 8. It is only
available for a video stream and the Target Background Grid Descriptor must
also be present.

Parameter

Error check

descriptor_length (dl):

test that (dl == 4)

horizontal_offset (ho)

ho <= horizontal_size in the target background grid descriptor

vertical_offset (vo)

vo <= vertical_size in the target background grid descriptor

window_priority (wp):

no test

CA Descriptor is the descriptor with descriptor_tag == 9. It is only available in

PMT or CAT.
Table C-17: CA descriptor
Parameter Error check
descriptor_length (dI): test that (dl >= 4)
CA_system_ID (casid): no test

reserved (r):

test that (reserved == ‘111))

CA_PID (capid):

capid != [0x0002, 0x000F] or 0x1FFF

private_data_byte (pdb):

no test

Table C-18: ISO 639 language descriptor

The ISO 639 Language Descriptor is the descriptor with descriptor_tag == 10.

Parameter Error check
descriptor_length (dl): test that (dl % 4 == 0)
ISO_639_language_code (is0639Ic) no test

audio_type (af)

1. if (at == OxAA) then video

2. if (at == 0xBB) or (at == 0xCC) then audio
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The System Clock Descriptor is the descriptor with descriptor_tag == 11. It is
only available at the program level in a PMT.

Table C-19: System clock descriptor

Parameter Error check
descriptor_length (dl): test that (dl == 2)
external_clock_reference_indicator (ecri): no test

reserved (r1): test that (r1 == ‘1))
clock_accuracy_integer (cai): no test
clock_accuracy_exponent (cae): no test

reserved (r2): test that (r2 == “11111)

The Multiplex Buffer Utilization Descriptor is the descriptor with descrip-
tor_tag == 12.

Table C-20: Multiplex buffer utilization descriptor

Parameter Error check
descriptor_length (dl): test that (dl == 3)
bound_valid_flag (bvf): no test

LTW offset_lower_bound (ltwolb): no test

reserved (r): test that (r == ‘1))
LTW_offset_upper_bound (ltwoub): no test

The Copyright Descriptor is the descriptor with descriptor_tag == 13.

Table C-21: Copyright descriptor

Parameter Error check
descriptor_length (dl): test that (dl >= 4)
copyright_identifier (ci): no test
additional_copyright_info (aci): no test
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The Maximum Bitrate Descriptor is the descriptor with descriptor_tag == 14. It

is only available at the program or ES level.

Table C-22: Maximum bitrate descriptor

Parameter

Error check

descriptor_length (dI):

test that (dl == 3)

reserved (r):

test that (r == “11))

maximum_bitrate (mb):

no test

The Private Data Indicator Descriptor is identified by descriptor_tag == 15.

Table C-23: Private data indicator descriptor

Parameter Error check
descriptor_length (dI): test that (dl == 4)
private_data_indicator (pdi): no test

The Smoothing Buffer Descriptor is the descriptor with descriptor_tag == 16.

Table C-24: Smoothing buffer descriptor

Parameter

Error check

descriptor_length (dl):

test that (dl == 6)

reserved (r1):

test that (r1 == “11)

sh_leak_rate (sblr):

no test

reserved (r2):

test that (12 == “11)

sh_size (sbs):

no test

The STD Descriptor is the descriptor with descriptor_tag == 17.

Table C-25: STD descriptor

Parameter

Error check

descriptor_length (dl):

test that (dl == 1)

reserved (r):

test that (r == “1111111)

leak_valid_flag (Ivf):

no test
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The IBP Descriptor is the descriptor with descriptor_tag == 18.

Table C-26: IBP descriptor

Parameter Error check
descriptor_length (dI): test that (dl == 2)
closed_gop_flag (cgf): no test
identical_gop_flag (igf): no test
max_gop_length (mgl): no test
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Glossary

For information about the MPEG-2 standard, click the MPEG-2 @
help icon in the Tektronix MPEG Test System program group
window. MPEG-2 Help

ACTS (Advanced Communications Technologies and Services)
A set of telecommunication research projects financed by the European
Union.

ARIB (Association of Radio Industries and Business)
ARIB is a body of broadcasters, manufacturers, and communication carriers
who are responsible for preparing standards on radio spectrum use in Japan.

ASI
Asynchronous Serial Interface, the DVB serial data protocol.

ATSC (Advanced Television Systems Committee)
The Advanced Television Systems Committee extended the MPEG standards
to include HDTV.

BAT (Bouquet Association Table)
One of the tables defined by DVB-SI, the BAT provides information

regarding bouquets (collections of services marketed as a single entity).
DVB only.

BIT (Broadcaster Information Table)
ARIB only. The BIT provides broadcaster name and ID and descriptions of
the services encoded in the transport stream for each broadcaster.

CARSB (Carte d’Acquisition / Restitution Binaire)
(French for Binary Acquisition/Restitution Board) The MTS215 Data Store
system, which can capture, store, and output MPEG-2 compliant transport
streams.

CAT (Conditional Access Table)
One of the PSI tables described by the MPEG-2 standard, the CAT provides
the association between one or more CA systems, their EMM (Entitlement
Management Message) streams, and any special parameters associated with
them.

CRC (Cyclic Redundancy Check)
One of the fields described in the MPEG-2 standard, used to verify the
correctness of data in PSI and SI tables.
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Glossary-2

DCT (Download Control Table)
ARIB only. This table provides a list of available downloads encoded in the
transport stream.

DIT (Discontinuity Information Table)
DVB table. This table is used with incomplete transport streams. The DIT is
not broadcast.

DLT (Download Table)
ARIB only. This table is used when downloading software to set top boxes.

DTA
Deferred-time Analyzer.

DTS (Decoding Time Stamp)
One of the fields described in the MPEG-2 standard, may be present in a
PES packet header that indicates the time that an access unit is decoded in
the T-STD.

DVB (Digital Video Broadcast)
A project group of the European Broadcasting Union (EBU).

DVB IRD (Digital Video Broadcasting Integrated Receiver Decoder)
A receiving decoder that can automatically configure itself using the
MPEG-2 Program Specific Information (PSI).

DVB-MG
Digital Video Broadcasting - Measurement Guidelines

DVB-SI (Digital Video Broadcast Service Information)
The DVB-SI adds the information that enables DVB IRDs to automatically
tune to particular services and allows services to be grouped into categories
with relevant schedule information. It has several tables, including: NIT,
SDT, BAT, and EIT. (NIT is also required for MPEG-2.)

ECM (Entitlement Control Message)
Private conditional access information that specifies control words and
possibly other, typically stream-specific, scrambling and/or control
parameters.

EISA (Extended Industry Standard Architecture)
The PC bus used to communicate with the CARB and PIA boards.

EIT (Event Information Table)
One of the tables defined by DVB-SI, the EIT contains data concerning
events (a grouping of elementary broadcast data streams with a defined start
and end time belonging to a common service) and programs (a concatenation
of one or more events under the control of a broadcaster, such as event name,
start time, and duration).
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EMM (Entitlement Management Message)
Private conditional access information that identifies the authorization levels
or the services of specific decoders.

EPG (Electronic Program Guide)
The EPG gives the content of the current program.

ETR (ETSI Technical Report)
One of the types of documents released by ETSI.

ETS (European Telecommunication Standard)
One of the types of documents released by ETSI.

ETSI
European Telecommunications Standards Institute.

Frame
An ISDB-S/ARIB structure comprised of 48 slots. See Slot and Super frame.

GA (Grand Alliance)
This group is establishing the North American HDTV standards.

IRD (Integrated Receiver / Decoder)
A receiving decoder that can automatically configure itself using the
MPEG-2 Program Specific Information (PSI).

ISDB-S (Integrated Service Digital Broadcast Satellite)
Standard adopted by ARIB describing the TMCC information used in
satellite broadcast environments.

ISO (International Standard Organization)
Organization responsible for establishing standards at the world-wide level.

Item
The currently interpreted packet or section.

M_TMCC
An ISDB-S/ARIB compliant multiplex with multiple transport streams. See
T™MCC.

NIT (Network Information Table)
One of the PSI tables described by the MPEG-2 standard and also one of the
tables defined by DVB-SI. The NIT conveys information relating to the
physical organization of the multiplex; that is, transport streams carried via a
given network and the characteristics of the network itself. Transport streams
are identified by the combination of an original network ID and a transport
stream ID in the NIT.

NVOD
Near Video on Demand.
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OPCR (Original Program Clock Reference)
Optional transport packet field defined in the MPEG-2 standard that contains
a coded time stamp used in the reconstruction of a single program transport
stream from another transport stream. The OPCR field shall be coded only in
transport stream packets in which the PCR field is present.

PAT (Program Association Table)
One of the PSI tables described in the MPEG-2 standard, the PAT gives
information about the structure of a transport stream.

PCR (Program Clock Reference)
One of the fields defined in the MPEG-2 standard, a time stamp in the
transport stream from which decoder timing is derived.

PES (Packetized Elementary Stream)
A structure defined in the MPEG-2 standard used to carry elementary stream
data.

PID (Packet IDentifier)
One of the fields described in the MPEG-2 standard, a unique integer value
used to identify elementary streams of a program in a single or multipro-
gram TS.

PMT (Program Map Table)
One of the PSI tables described by the MPEG-2 standard, the PMT identifies
and indicates the locations of the streams that make up each service and the
location of the Program Clock Reference (PCR) fields for a service. This
table is transmitted in sections.

PSI (Program Specific Information)
A set of tables described by the MPEG-2 standard, the PSI contains all the
tables that define the MPEG-2 transport stream. It consists of the PAT, PMT,
CAT, and NIT tables. (NIT is also used for DVB-SI.)

PSIP (Program and System Information Protocol)
A set of tables defined by ATSC standards, provides information on services
and events carried by different multiplexes and networks.

PTS (Presentation Time Stamp)
One of the fields described in the MPEG-2 standard, the PTS may be present
in a PES packet header that indicates the time that a presentation unit is
presented in the T-STD.

RTA
Real-time Analyzer.

SDT (Service Description Table)
The SDT contains data describing the services in the system. Examples
include names of services and the service provider.

MTS300 MPEG-2 DVB/ATSC/ISDB-S/ARIB System Analyzer



Glossary

SDTT (Software Download Trigger Table)
ARIB only. This structure is used to define the service, group, and schedule
for downloadable items encoded in the transport stream.

SI (Service Information)
Set of tables defined by DVB-SI, SI provides information on services and
events carried by different Multiplexes, and even other networks. SI is
structured in the following tables: PAT, NIT, CAT, SDT, EIT, TSDT, TDT,
TOT, BAT.

SIT (Selection Information Table)
DVB-SI table. This table is used with incomplete transport streams. The SIT
is not broadcast.

Slot
An ISDB-S/ARIB structure corresponding to one, 204-byte error coded
packet. See Frame and Super frame.

S_TMCC
An ISDB-S/ARIB compliant multiplex with only one transport stream. See
T™MCC.

ST (Stuffing Table)
One of the tables defined by DVB-SI, the ST provides stuffing sections.

Super frame
An ISDB-S/ARIB structure comprised of eight frames. See Frame and Slot.

TDT (Time & Date Table)
One of the tables defined by DVB-SI, the TDT carries the current time and
date information.

TMCC (Transmission and Multiplexing Configuration and Control)
Information encoded in the first eight bytes of the 16-byte Reed-Solomon
area of 204-byte packet transport streams. TMCC information includes
modulation modes, slot assignments, and alarms.

TOT (Time Offset Table)
One of the tables defined by DVB-SI, the TOT gives information about a
local time offset in a given area.

TS (Transport Stream)
A bit stream that contains 0 or more elementary streams combined in a
manner that conforms to the MPEG-2 standard.

T-STD (Transport Stream System Target Decoder)
Described by the MPEG-2 standard, the T-STD is a hypothetical reference
model of a decoding process used to define the semantics of a TS.
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Index
A

AAC audio elementary stream, icon, 2-14, 3-18
Abort, 2-27, 3-13, A-1
AC3 Identification in DVB Mode, Options menu
selection, 3-68
ACTS, definition, Glossary-1
Address, Tektronix, xiii
Analog TV virtual channels, icon, 3-22
Analysis
automatic, system analyzer, 3-54
consistency check, 3-34
diffusion discontinuity, 3-90
diffusion hole, 3-88
diffusion rate, 3-84
dynamic, 3-47
EMM, 3-8, 3-82
LTW, 3-52
mega-frame, 3-46
menu, system analyzer, 2-9, 3-6
multiplex allocation, 3-30
multiplex rate, 3-29
PCR, 3-38
PID map, 3-31
PSI/SI rate, 3-37
PTS/DTS, 3-41
semantic, 3-45
smoothing buffer, 3-54
syntax, 3-33
T-STD, 3-48
Analyzer Compliance Tests
descriptors, C-12
PES packet, C-6
PSI, C-8
transport stream, C-1
Application
locked, A-1
window, system analyzer, 2-8, 3-3
ARIB, definition, Glossary-1
ASI, definition, Glossary-1
ATSC, definition, Glossary-1
ATSC PSIP selection, system analyzer, options menu,
3-68
Audio elementary stream, icon, 2-14, 3-18
Automatic analysis, system analyzer, 2-40, 3-54
options menu selection, 3-70

B Sync Byte
add only module, 3-98
removal, 3-103
Base selection, system analyzer, options menu, 3-69
BAT, definition, Glossary-1
Bat, icon, 3-20
Binary view, 2-23, 3-28
BIT, definition, Glossary-1
Buffer overflow, dynamic analysis, 2-30, 3-47
Buffering simulation, 3-49
Bytes, number in pattern, DVB channel coding and
decoding, 3-104

C

C (virtual channels), icon, 3-22
CA, 3-77
CARB, definition, Glossary-1
CAT
definition, Glossary-1
icon, 2-13, 3-17
Chain
coding command, 3-98
decoding command, 3-103
Change password, 1-3
Check CRC command, system analyzer, 2-25, 2-28
Coded block size, Reed-Solomon, 3-100
Coding
convolutional interleaving, 3-108
DVB, 3-95
energy dispersal, 3-107
flow, 3-95
menu, DVB channel coding and decoding, 3-98
Reed-Solomon, 3-108
Viterbi, 3-109
Compliance Tests
descriptors, C-12
audio stream, C-13
CA, C-15
copyright, C-16
data stream alignment, C-14
hierarchy, C-13
IBD, C-18
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ISO 639 language, C-15
maximum bitrate, C-17
multiplex buffer utilization, C-16
private data indicator, C-17
registration, C-14
smoothing buffer, C-17
STD, C-17
system clock, C-16
target background grid, C-14
video stream, C-12
video window, C-15
PES, packet headers, C-6
PSI sections
CAT, C-10
NIT, C-11
PAT, C-8
PMT, C-9
private, C-11
transport stream
duplication packet, adaptation field, C-3
packet headers, C-1
Composition motif, 3-105
Computer requirements, 1-1
Conditional access, 3-9
option, 3-77
Configuration
default, 3-71
delete, 3-127
load (restore saved), 3-127

new (restore default Analysis Server configuration),

3-127

read default, 3-70

Reed-Solomon coding, 3-100

save, 3-126

save default, 3-70
Configuration selections, system analyzer, options

menu, 3-70

Consistency check analysis, 3-34
Contacting Tektronix, xiii
Control words, fixed, 3-81
Convolutional interleaving coding, 3-108
CRC

analysis, 2-25

definition, Glossary-1
CVct, icon, 3-21

D

Data, icon, 3-22

Data elementary stream, icon, 2-14, 3-18
DCT, definition, Glossary-1

Decoding, DVB, 3-95
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Decoding menu, DVB channel coding and decoding,
3-102
Default configuration, 3-71
default configuration, restoring in the TMCC client,
3-127
Deferred-time analysis, 2-1
Delnterleaver, DVB channel coding and decoding,
decoding command, 3-103
Diffusion discontinuity analysis, 3-90
Diffusion hole analysis, 3-88
Diffusion rate, 3-84
Digicipher II video elementary stream, icon, 2-14,
3-18
Digital TV virtual channels, icon, 3-22
Directories selection, system analyzer, options menu,
3-69
DIT, definition, Glossary-2
DLT, definition, Glossary-2
Dolby digital audio elementary stream, icon, 2-14,
3-18
Dongle. See Software key
DSM CC (digital storage media command/control),
icon, 2-14, 3-18
DTA, definition, Glossary-2
DTS, definition, Glossary-2
Duration gauge, DVB channel coding and decoding,
3-96
DVB
compliant files, 3-103
creating, 3-98
definition, Glossary-2
system analyzer, options menu, 3-68
DVB Coding and Decoding
convolution interleaving, 3-108
introduction, 3-95
menus
coding, 3-98
decoding, 3-102
file, 3-97
generation, 3-104
help, 3-106
Reed-Solomon, 3-108
DVB IRD, definition, Glossary-2
DVBI1-MG, definition, Glossary-2
DVB-SI, definition, Glossary-2
Dynamic analysis, 3-47

E

E (event), icon, 3-20, 3-22
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ECM
definition, Glossary-2
fixed, 3-81
icon, 2-14, 3-18
Edit menu, system analyzer, 2-9, 3-4
EISA, definition, Glossary-2
EIT
definition, Glossary-2
icon, 3-20, 3-21
Elementary stream, files, 2-3
FTP site, 2-4
EMM
definition, Glossary-2
icon, 2-14, 3-18
EMM analysis, 3-8, 3-82
End
command button, system analyzer, 3-13
locked application, A-1
task, A-1
Energy Dispersal
coding, 3-98, 3-107
coding command, 3-99
decoding command, 3-104
EPG, definition, Glossary-2
Error, command button, system analyzer, 3-13
error conditions in the syntax view, TMCC client,
3-116, 3-123
Escape key, 2-27, 3-13
ETR, definition, Glossary-3
ETS, definition, Glossary-3
ETSI, definition, Glossary-3
Ett, icon, 3-21
Exit
application, 1-8
system analyzer, 2-44

F

Fields, system analyzer, interpreted view, 3-24
File
menu, system analyzer, 2-9
message window, 3-75
opening, 3-14
File Menu
DVB channel coding and decoding, 3-97
system analyzer, 3-3
file name indicator, TMCC Deferred Time client,
3-113
Filter, System Analyzer
apply, 3-63
define, 3-57
edit, 3-63

open, 3-62
save, 3-61
First-time operation, vii
Font selection, system analyzer, options menu, 3-69
frame, definition, Glossary-3
FTP site, elementary stream files, 2-4

G

GA, definition, Glossary-3

General license password, 1-6, B-6

General password, 1-6

Generation menu, DVB channel coding and decoding,
3-104

GI-D Identification, Options menu selection, 3-68

Go To, command button, system analyzer, 3-13

green icons, TMCC client syntax view, 3-116, 3-123

H

Hardware
installation, vii
requirements, 1-1
Help
menu, system analyzer, 2-9
obtaining MPEG-2 information, 2-7
Help icon, 3-113
Help menu
DVB channel coding and decoding, 3-106
system analyzer, 3-11
Hexadecimal view, 2-18, 3-25, 3-27
Hierarchic view, 2-1, 2-12, 3-15
Hierarchy view, command button, 3-12

Icons
Analyzer hierarchic view, 3-17, 3-19, 3-21
Analyzer shortcut menus, 3-15
defined, 3-17, 3-19, 3-21, 3-73
Installation, hardware, vii
Interleaver
coding command, DVB channel coding and
decoding, 3-101
file type required, 3-101
Interpretation selection, system analyzer, options menu,
3-70
Interpreted view, 2-2, 2-16, 3-23
analyzer, 3-16
Interrupt, 3-13
IRD, definition, Glossary-3
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ISDB-S, definition, Glossary-3

ISO, definition, Glossary-3

Item, definition, Glossary-3

Item number, system analyzer, interpreted view, 3-23

K

Key, software, 1-6

L

License, password, 1-6

License manager, entering your password, 1-6, B-6
Locked application, A-1

Logging on, 1-3

Lower toolbar, 2-10

LTW analysis, 3-52

M_TMCC, definition, Glossary-3
Manual reset, A-1
Mega-frame analysis, 3-46
Menu bar
DVB channel coding and decoding, 3-96
system analyzer, 3-3
Message window, 2-42, 3-72
save, 3-72
Messages, system analyzer, status bar, 2-10
messages, displaying in the TMCC client, 3-124
Mgt, icon, 3-21
MIP, 3-46
icon, 2-14, 3-18
MPEG-2
help, 2-7
selection, system analyzer, options menu, 3-68
Multiplex allocation, 2-21, 3-30
Multiplex analyses, 3-29
Multiplex rate, 3-24, 3-29

Next, command button, system analyzer, 3-13
Next Error, command button, system analyzer, 2-17,
2-32
NIT
definition, Glossary-3
icon, 2-13, 3-18, 3-19
Number, command button, system analyzer, 3-13
NVOD, definition, Glossary-3
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o)

OPCR, definition, Glossary-3

Open command, system analyzer, 2-11

Open command button, system analyzer, 3-12

Option CA, 3-9, 3-77

Options menu, system analyzer, 2-9, 3-68

Output messages in file, system analyzer, options menu
selection, 3-69

P

Password, 1-3, B-6
and user name, Windows NT auto log on, 1-2
changing, emergency repair disk, 1-3
for installing software, 1-6
install, 1-6
reinstall, 1-6
PAT
definition, Glossary-4
icon, 2-13, 3-17
PAT icon, embedded commands, 2-24
Pattern
composition motif, 3-105
generation command, DVB channel coding and
decoding, 3-104
repetition, 3-105
PC2, 3-9, 3-78
PC2 Dialog, menu, 2-9
PCR, 2-28, 3-38
analysis, 2-28
definition, Glossary-4
icon, 2-13, 3-17
values, 2-29
PES
definition, Glossary-4
icon, 2-13, 3-18
embedded commands, 2-32
Phone number, Tektronix, xiii
PID
8191, 2-21
definition, Glossary-4
icon, embedded commands, 2-22
map, 2-19, 3-31
PMT
definition, Glossary-4
icon, 2-13, 3-18
PMT icon, embedded commands, 2-26
Position, interpreted view, 3-24
Power switch, 1-2
PRBS, 3-99, 3-107
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Previous, command button, system analyzer, 3-13
Print message window, 3-75
Product support, contact information, xiii
Profile, saved Analysis Server configuration, 3-126
Protection, software key, 1-1
PSI, definition, Glossary-4
PSI/SI rate analysis, 3-37
PSIP
analysis functions, 3-1
coherence, 3-35
consistency check, 3-34
definition, Glossary-4
display hierarchic view, 3-5
display interpreted view, 3-5
filter, 3-56
hierarchic view, 3-20
rate analysis, 3-37
save table, 3-66
specify standard, 3-10, 3-12
view tables, 2-1
PTS, definition, Glossary-4
PTS/DTS analysis, 2-34, 3-41

Q

Quit, system analyzer, 2-44

R

Radio service, icon, 3-20
Radio virtual channels, icon, 3-22
red icons, TMCC client syntax view, 3-116, 3-123
Reed-Solomon
coding, 3-108
command, 3-100
configuration, 3-100
size of block, 3-100
decoding command, 3-104
Repair, software, B-1
Requirements, computer, 1-1
Reset, A-1
restore default analysis settings, 3-127
restoring defaults, TMCC client, 3-127
Rrt, icon, 3-22
RS(204, 188), 3-108
RTA, definition, Glossary-4

S

S (service information), icon, 3-20
S_TMCQC, definition, Glossary-5

Satellite broadcasting, 3-95
Save
command button, system analyzer, 3-12
elementary streams, 3-2, 3-67
error messages in file, 3-69
filter, 3-61
interpreted view, 3-27
message window, 3-72
PES packets, 3-66
table sections, 3-66
transport packets, 3-65
saving configurations, in the TMCC client, 3-126
saving files, in the TMCC client, 3-125
SDT, definition, Glossary-4
Sdt, icon, 3-19
SDTT, definition, Glossary-4
Security, A-1
Selection menu, system analyzer, 2-9, 3-5
Semantic analysis, 3-45
Service support, contact information, xiii
setting probes, 3-121
Setup, hardware, vii
Shortcut menus, system analyzer, 2-15
Shutdown, 1-9, A-1
SI, definition, Glossary-4
SIT, definition, Glossary-5
Size of block, Reed-Solomon coding, 3-100
slot, definition, Glossary-5
slot configurations, displaying, 3-121
Smartcard reader, 3-77
Smoothing buffer analysis, 3-54
Software
key, 1-6
protection key, connecting to parallel port, 1-1
reinstall, B-1
repair, B-1
Software description, deferred-time analysis, 2-1
Software key, B-4
Software version, xii
Specifications, vii
ST, definition, Glossary-5
Standard, specify, 3-12
Start
command button, system analyzer, 3-13
system analyzer, application, 2-8
Starting, software installation, B-2
Status Bar
DVB channel coding and decoding, 3-96
system analyzer, 2-10, 3-13
Stt, icon, 3-22
Stuffing PID, 2-21
super frame, definition, Glossary-5
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Sync byte, 3-99
sync bytes, TMCC probe, 3-128

synchronization, TMCC Deferred Time Client, 3-111,

3-118
Syntactic analysis, 3-33

syntax analyses, displaying in the TMCC client, 3-122

Syntax analysis, 2-26

System Analyzer
(deferred-time analyzer), 3-1
help menu, 3-11

T

Task manager, A-1
TDT, definition, Glossary-5
Technical support, contact information, xiii
Tektronix, contacting, xiii
Teletext service, icon, 3-20
Tests, analyzer compliance, C-1
Time, interpreted view, 3-24
Timing analysis, 3-38
TMCC, definition, Glossary-5
TMCC Configuration Client
analysis panel, 3-120
input panel, 3-119
TMCC Deferred TIme Client, setting probes, 3-121
TMCC Deferred Time Client
display elements, 3-112
displaying messages, 3-124
displaying slot configurations, 3-121
displaying syntax, 3-122
LED icons, 3-116, 3-123
saving configurations, 3-126
saving files, 3-125
slots view, 3-113
specifying input, 3-119
starting, 3-118
synchronizing to a signal, 3-111, 3-118
syntax displayed, 3-115
syntax view, 3-114
toolbar icons, 3-113
TMCC Expert Client, starting, 3-111
TMCC Probes
alarm status notification, 3-129
descriptions, 3-128
frame size consistency, 3-129
modulation mode and slot consistency, 3-130
modulation order consistency, 3-131
number of slots consistency, 3-130
super frame size consistency, 3-129
overall stream rate, 3-128
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sync bytes, 3-128
syntax, 3-130
update consistency, 3-129
update notification, 3-128
Toolbar
system analyzer
lower, 2-10, 3-13
upper, 2-9, 3-12
TMCC client, 3-113
TOT, definition, Glossary-5
Transport packet, 2-22
DVB channel coding and decoding, generation
command, 3-105
icon, 3-17
Transport stream
icon, 3-17
open, 2-11
TS
definition, Glossary-5
icon, 2-15, 3-17
Ts, icon, 3-20, 3-22
T-STD
analysis, 2-30, 3-48
definition, Glossary-5
TV service, icon, 3-20
TVct, icon, 3-21

U

Unscramble, 3-78, 3-79
Unscrambling, 2-9
selection, system analyzer, options menu, 3-68
Upper toolbar, 2-9
URL, Tektronix, xiii

user name and password, MTS300 test system auto log

on, 1-2

vV

Version, software, xii
Viaccess, 3-80, 3-82
Video elementary stream, icon, 2-14, 3-18
View command button, system analyzer, 3-12
Visual TSTD and LTW, system analyzer
mode, 3-47
options menu selection, 3-68
Viterbi
coding, 3-109
command, 3-101
file type expected, 3-102
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decoding, 3-101

w

Web site address, Tektronix, xiii
Window
application

system analyzer, 2-8
menu, system analyzer, 2-9
message, 3-72

Windows NT
initialization, 1-2, 1-3, 1-6
security dialog box, A-1

DVB channel coding and decoding, 3-96
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